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ME0398-6E

Please Read Before Use

Thank you for purchasing our product.

This instruction manual explains the handling methods, structure and maintenance of this product, 
providing the information you need in order to use the product safely.

Before using the product, be sure to read this manual and fully understand the contents explained herein 
to ensure safe use of the product.

Please downloaded the user’s manual from our website.
You can download it free of charge. User registration is required for the first time downloading.
URL : www.iai-robot.co.jp/data_dl/CAD_MANUAL/

When using the product, print out of the necessary portions of the relevant manual, or please display it 
on your computer, tablet terminal, etc. so that you can check it immediately.

After reading the instruction manual, keep it in a convenient place so that whoever is handling the 
product can refer to it quickly when necessary.

[Important]
• This instruction manual is an original document dedicated for this product.
• This product cannot be used in ways not shown in this instruction manual. IAI shall not be 

liable for any result whatsoever arising from the use of the product in any other way than what 
is noted in the manual.

• The information contained in this instruction manual is subject to change without notice for the 
purpose of product improvement.

• If any issues arise regarding the information contained in this instruction manual, contact our 
customer center or the nearest sales office.

• Use or reproduction of this instruction manual in full or in part without permission is prohibited.
• The company names, names of products and trademarks of each company shown in the text 

are registered trademarks.
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Support Models

Model Name
Various data file extensions Support

Started 
VersionProgram

(Individually)
Program
(Batch)

Position
(Individually)

Position
(Batch) Parameter Symbol Coordinate Global

data
Backup

Data
RSEL .rspg .rspa .rspt .rspta .rspm .rssm .rscd .rsgd .rsbk V14.00.00.00

* RSEL is capable to divide the construction axes into two groups at the maximum.
Positions can be edited in unit of axes groups.
The positions of individual axes groups should be stored with an extension .rspt.
The positions of all axes groups consolidated position should be stored with an extension .rspta.
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Software License Agreement

Before opening the software package, please read this Software License Agreement (hereinafter referred to 
as “Agreement”).
This Agreement is applied to the PC interface software for this product (hereinafter referred to as “this 
Software”, and also includes updated versions.).
Regardless of the reason, opening the this Software package will be regarded as your acknowledgement of 
consenting to this Agreement. You may not use this software if you do not agree to the terms of this 
Agreement.

IAI Corporation (hereinafter referred to as “IAI”) shall grant to the user (hereinafter referred to as “the User”), 
and the User shall accept, a non-transferable, non-exclusive right to use the Licensed Software supplied with 
this Agreement, based on the following terms and conditions. 

Witnesseth

1. Term of the Agreement
This Agreement shall take effect the moment the User opens the Licensed Software and remain effective 
until the User submits a termination request to IAI in writing or the Agreement is otherwise terminated 
pursuant to the provision of Section 3. 

2. Licensing
If the User owns an electronic medium, such as DVD-R, which is sold by IAI and which this Software is
recorded to, or if user registration has been held to this Software, it should be allowed that the User uses this 
Software on multiple computers.
The user should not be allowed to have himself or a third party performs modification, reverse engineering, 
disassembly, decompile, translation or adaptation entirely or partially in this Software.
If the User violates anything in the agreement and causes any loss to IAI, the User is to compensate the loss 
caused to IAI.

3. Termination of the Agreement
In the event of breach by the User of any of the terms and conditions hereunder, or upon discovery of a 
material cause that makes continuation of this Agreement impossible, IAI may immediately terminate this 
Agreement without serving any prior notice to the User.
In this case, the User should delete or dispose everything of this Software (including software copies) and 
dedicated connection cables within ten days after the day when the Agreement is terminated.

4. Range of Guarantee
IAI does not guarantee that this Software works in normal condition in every operational environment.
IAI may change all the specifications related to this Software without serving any prior notice. Also, IAI 
should not take any responsibility to any loss or damage caused as a result of use of this Software.
The User or a third party agrees not to claim compensation for damage from IAI for any loss suffered by the 
User or a third party as a result of installing and using the Licensed Software.
Based on this Agreement, the upper limit of the responsibility that IAI may take should be the amount of 
money that the User has actually paid to purchase this Software.
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Caution in Handling

[1] This software is copyrighted by IAI Corporation (IAI). 
[2] The software and the manual can only be used under the terms and conditions of the license 

agreement. 
[3] IAI cannot assume responsibility for any damage or loss resulting from the use of this software or the 

manual. 
[4] Please note that the version or edition number printed on the face of this manual does not correspond to 

the software version number. 
[5] The content of this manual is subject to change without notice. 
[6] The software runs with the Windows operation systems listed in the table below. Accordingly, it is a 

prerequisite to have a basic Windows operating environment to use this software. 
(Note, however, that Windows is not included with the software.)  

Port used Type Operable Windows
RS-232C IA-101-X-MW-JS Windows 10, Windows 11

USB IA-101-N(Note 1) Windows 10, Windows 11
Note 1 There is no cable enclosed. Please prepare yourself an USB cable to connect to the USB 

connector on RSEL Controllers.

Microsoft, Windows 8.1, Windows 10, Windows 11 are registered trademarks of Microsoft Corporation.

Copyright© 2001 Jun. IAI Corporation. All rights reserved.
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Safety Guide

“Safety Guide” has been written to use the machine safely and so prevent personal injury or property 
damage beforehand. Make sure to read it before the operation of this product.

Safety Precautions for Our Products
The common safety precautions for the use of any of our robots in each operation.

No. Operation
Description Description

1 Model 
Selection

● This product has not been planned and designed for the application where 
high level of safety is required, so the guarantee of the protection of human 
life is impossible. 
Accordingly, do not use it in any of the following applications.
1) Medical equipment used to maintain, control or otherwise affect human 

life or physical health.
2) Mechanisms and machinery designed for the purpose of moving or 

transporting people (For vehicle, railway facility or air navigation facility)
3) Important safety parts of machinery (Safety device, etc.)

● Do not use the product outside the specifications. 
Failure to do so may considerably shorten the life of the product.

● Do not use it in any of the following environments.
1) Location where there is any inflammable gas, inflammable object or 

explosive
2) Place with potential exposure to radiation
3) Location with the ambient temperature or relative humidity exceeding the 

specification range
4) Location where radiant heat is added from direct sunlight or other large 

heat source
5) Location where condensation occurs due to abrupt temperature changes 
6) Location where there is any corrosive gas (sulfuric acid or hydrochloric 

acid)
7) Location exposed to significant amount of dust, salt or iron powder
8) Location subject to direct vibration or impact

● For an actuator used in vertical orientation, select a model which is 
equipped with a brake. If selecting a model with no brake, the moving part 
may drop when the power is turned OFF and may cause an accident such 
as an injury or damage on the work piece. 
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No. Operation
Description Description

2 Transportation ● When carrying a heavy object, do the work with two or more persons or 
utilize equipment such as crane.

● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers.

● When in transportation, consider well about the positions to hold, weight 
and weight balance and pay special attention to the carried object so it 
would not get hit or dropped.

● Transport it using an appropriate transportation measure.
The actuators available for transportation with a crane have eyebolts 
attached or there are tapped holes to attach bolts. Follow the instructions in 
the instruction manual for each model.

● Do not step or sit on the package.
● Do not put any heavy thing that can deform the package, on it.
● When using a crane capable of 1t or more of weight, have an operator who 

has qualifications for crane operation and sling work.
● When using a crane or equivalent equipments, make sure not to hang a 

load that weighs more than the equipment’s capability limit.
● Use a hook that is suitable for the load. Consider the safety factor of the 

hook in such factors as shear strength.
● Do not get on the load that is hung on a crane.
● Do not leave a load hung up with a crane.
● Do not stand under the load that is hung up with a crane.

3 Storage and
Preservation

● The storage and preservation environment conforms to the installation 
environment. However, especially give consideration to the prevention of 
condensation.

● Store the products with a consideration not to fall them over or drop due to 
an act of God such as earthquake.

4 Installation and 
Start

(1) Installation of Robot Main Body and Controller, etc.
● Make sure to securely hold and fix the product (including the work part). A 

fall, drop or abnormal motion of the product may cause a damage or injury.
Also, be equipped for a fall-over or drop due to an act of God such as 
earthquake.

● Do not get on or put anything on the product. 
Failure to do so may cause an accidental fall, injury or damage to the 
product due to a drop of anything, malfunction of the product, performance 
degradation, or shortening of its life.

● When using the product in any of the places specified below, provide a 
sufficient shield.
1) Location where electric noise is generated
2) Location where high electrical or magnetic field is present
3) Location with the mains or power lines passing nearby
4) Location where the product may come in contact with water, oil or 

chemical droplets
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No. Operation
Description Description

4 Installation and 
Start

(2) Cable Wiring
● Use our company’s genuine cables for connecting between the actuator and 

controller, and for the teaching tool.
● Do not scratch on the cable. Do not bend it forcibly. Do not pull it. Do not coil 

it around. Do not insert it. Do not put any heavy thing on it. 
Failure to do so may cause a fire, electric shock or malfunction due to 
leakage or continuity error.

● Perform the wiring for the product, after turning OFF the power to the unit, 
so that there is no wiring error.

● When the direct current power (+24V) is connected, take the great care of 
the directions of positive and negative poles. If the connection direction is 
not correct, it might cause a fire, product breakdown or malfunction.

● Connect the cable connector securely so that there is no disconnection or 
looseness. Failure to do so may cause a fire, electric shock or malfunction 
of the product.

● Never cut and/or reconnect the cables supplied with the product for the 
purpose of extending or shortening the cable length. Failure to do so may 
cause the product to malfunction or cause fire.

(3) Grounding
● The grounding operation should be performed to prevent an electric shock 

or electrostatic charge, enhance the noise-resistance ability and control the 
unnecessary electromagnetic radiation.

● For the ground terminal (PE) on the AC power cable of the controller and 
the grounding plate in the control panel, make sure for grounding work. For 
security grounding, it is necessary to select an appropriate wire thickness 
suitable for the load. 
Perform wiring that satisfies the specifications (electrical equipment 
standards and criteria).
For detail, follow the description in [an instruction manual of each controller 
or controller built-in actuator]. 

● Conduct functional grounding on the FG terminal for a controller supplying 
24V DC or a controller built-in type actuator. In order to minimize influence 
to mechanical operation given by electromagnetic interference (noise) to an 
electrical device or insulation failure, conduct grounding on a terminal or a 
conductor that is electrically stable. The reference impedance should be 
Type D (Former Class 3, ground resistance 100Ω or less).
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No. Operation
Description Description

4 Installation and 
Start
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conductor that is electrically stable. The reference impedance should be 
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No. Operation
Description Description

4 Installation and 
Start

(4) Safety Measures
● When the work is carried out with 2 or more persons, make it clear who is to 

be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers.

● When the product is under operation or in the ready mode, take the safety 
measures (such as the installation of safety and protection fence) so that 
nobody can enter the area within the robot’s movable range. 
When the robot under operation is touched, it may result in death or serious 
injury.

● Make sure to install the emergency stop circuit so that the unit can be 
stopped immediately in an emergency during the unit operation.

● Take the safety measure not to start up the unit only with the power turning 
ON. Failure to do so may start up the machine suddenly and cause an injury 
or damage to the product.

● Take the safety measure not to start up the machine only with the 
emergency stop cancellation or recovery after the power failure. Failure to 
do so may result in an electric shock or injury due to unexpected power 
input.

● When the installation or adjustment operation is to be performed, give clear 
warnings such as “Under Operation; Do not turn ON the power!” etc. 
Sudden power input may cause an electric shock or injury.

● Take the measure so that the work part is not dropped in power failure or 
emergency stop.

● Wear protection gloves, goggle or safety shoes, as necessary, to secure 
safety.

● Do not insert a finger or object in the openings in the product. Failure to do 
so may cause an injury, electric shock, damage to the product or fire.

● When releasing the brake on a vertically oriented actuator, exercise 
precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity.

5 Teaching ● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers.

● Perform the teaching operation from outside the safety protection fence, if 
possible. In the case that the operation is to be performed unavoidably 
inside the safety protection fence, prepare the “Stipulations for the 
Operation” and make sure that all the workers acknowledge and understand 
them well.

● When the operation is to be performed inside the safety protection fence, 
the worker should have an emergency stop switch at hand with him so that 
the unit can be stopped any time in an emergency.

● When the operation is to be performed inside the safety protection fence, in 
addition to the workers, arrange a watchman so that the machine can be 
stopped any time in an emergency. Also, keep watch on the operation so 
that any third person can not operate the switches carelessly.

● Place a sign “Under Operation” at the position easy to see.
● When releasing the brake on a vertically oriented actuator, exercise 

precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity.

* Safety protection Fence : In the case that there is no safety protection fence, 
the movable range should be indicated.
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No. Operation
Description Description

6 Trial Operation ● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers.

● After the teaching or programming operation, perform the check operation 
one step by one step and then shift to the automatic operation.

● When the check operation is to be performed inside the safety protection 
fence, perform the check operation using the previously specified work 
procedure like the teaching operation.

● Make sure to perform the programmed operation check at the safety speed. 
Failure to do so may result in an accident due to unexpected motion caused 
by a program error, etc.

● Do not touch the terminal block or any of the various setting switches in the 
power ON mode. 
Failure to do so may result in an electric shock or malfunction.

7 Automatic
Operation

● Check before starting the automatic operation or rebooting after operation 
stop that there is nobody in the safety protection fence.

● Before starting automatic operation, make sure that all peripheral equipment 
is in an automatic-operation-ready state and there is no alarm indication.

● Make sure to operate automatic operation start from outside of the safety 
protection fence.

● In the case that there is any abnormal heating, smoke, offensive smell, or 
abnormal noise in the product, immediately stop the machine and turn OFF 
the power switch. Failure to do so may result in a fire or damage to the 
product.

● When a power failure occurs, turn OFF the power switch. Failure to do so 
may cause an injury or damage to the product, due to a sudden motion of 
the product in the recovery operation from the power failure.
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Description Description
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No. Operation
Description Description

8 Maintenance 
and Inspection

● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers.

● Perform the work out of the safety protection fence, if possible. In the case 
that the operation is to be performed unavoidably inside the safety 
protection fence, prepare the “Stipulations for the Operation” and make sure 
that all the workers acknowledge and understand them well.

● When the work is to be performed inside the safety protection fence, 
basically turn OFF the power switch.

● When the operation is to be performed inside the safety protection fence, 
the worker should have an emergency stop switch at hand with him so that
the unit can be stopped any time in an emergency.

● When the operation is to be performed inside the safety protection fence, in 
addition to the workers, arrange a watchman so that the machine can be 
stopped any time in an emergency. Also, keep watch on the operation so 
that any third person can not operate the switches carelessly.

● Place a sign “Under Operation” at the position easy to see.
● For the grease for the guide or ball screw, use appropriate grease according 

to the instruction manual for each model.
● Do not perform the dielectric strength test. Failure to do so may result in a 

damage to the product.
● When releasing the brake on a vertically oriented actuator, exercise 

precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity.

● The slider or rod may get misaligned OFF the stop position if the servo is 
turned OFF. Be careful not to get injured or damaged due to an 
unnecessary operation.

● Pay attention not to lose the removed cover or screws, and make sure to 
put the product back to the original condition after maintenance and 
inspection works.
Use in incomplete condition may cause damage to the product or an injury.

* Safety protection Fence : In the case that there is no safety protection fence, 
the movable range should be indicated.

9 Modification 
and Dismantle

● Do not modify, disassemble, assemble or use of maintenance parts not
  specified based at your own discretion.

10 Disposal ● When the product becomes no longer usable or necessary, dispose of it 
properly as an industrial waste.

● When removing the actuator for disposal, pay attention to drop of 
components when detaching screws.

● Do not put the product in a fire when disposing of it.
The product may burst or generate toxic gases.

11 Other ● Do not come close to the product or the harnesses if you are a person who 
requires a support of medical devices such as a pacemaker. Doing so may 
affect the performance of your medical device.

● See Overseas Specifications Compliance Manual to check whether 
complies if necessary.

● For the handling of actuators and controllers, follow the dedicated 
instruction manual of each unit to ensure the safety.
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Alert Indication

The safety precautions are divided into “Danger”, “Warning”, “Caution” and “Notice” according to the 
warning level, as follows, and described in the instruction manual for each model.

Level Degree of Danger and Damage Symbol 

Danger This indicates an imminently hazardous situation which, if the 
product is not handled correctly, will result in death or serious injury. Danger

Warning This indicates a potentially hazardous situation which, if the product 
is not handled correctly, could result in death or serious injury. Warning

Caution
This indicates a potentially hazardous situation which, if the product 
is not handled correctly, may result in minor injury or property 
damage.

Caution

Notice This indicates lower possibility for the injury, but should be kept to 
use this product properly. Notice
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1. Before You Begin 
1.1 Components  

Please check to make sure that the following items are included in your software package. 
[1] Operation manual One
[2] DVD-ROM containing the software One
[3] Permission of use contract (manual) for the software One
[4] Connection cables One set

Enclosed connection cables vary depending on the PC interface software type.
The types and connection cables are shown in the table below.

Type External Connection Cable

IA-101-X-MW-JS RS-232C cable (CB-ST-E1MW050-EB)
Conversion cable (CB-SEL-SJS002)

1 cable
1 cable

C
on

ne
ct

io
n

C
on

fig
ur

at
io

n

Compatible controller 
RSEL 

RS-232C cable Conversion cable
CB-ST-E1MW050-EB CB-SEL-SJS002

Type External Connection Cable

IA-101-X-USBMW-JS

RS-232C cable (CB-ST-E1MW050-EB)
Conversion cable (CB-SEL-SJS002)
USB conversion adapter (IA-CV-USB)
USB cable (CB-SEL-USB030)

1 cable
1 cable
1 cable
1 cable

C
on

ne
ct

io
n

C
on

fig
ur

at
io

n

Compatible controller
RSEL 

Type External Connection Cable

IA-101-XA-USBMW-JS

RS-232C cable (CB-ST- A2MW050-EB)
Conversion cable (CB-SEL-SJS002)
USB conversion adapter (IA-CV-USB)
USB cable (CB-SEL-USB030)

1 cable
1 cable
1 cable
1 cable

C
on

ne
ct

io
n

C
on

fig
ur

at
io

n

Compatible controller
RSEL 

RS-232C cable
CB-ST-E1MW050-EB

Conversion adapter
CB-SEL-SJS002

USB conversion adapter 
IA-CV-USB

USB cable
CB-SEL-USB030

RS-232C cable
CB-ST-A2MW050-EB

Conversion cable
CB-SEL-SJS002

USB cable
CB-SEL-USB030

USB conversion adapter 
IA-CV-USB
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Type External Connection Cable
IA-101-N No USB cable enclosed (Note 1)

C
on

ne
ct

io
n

C
on

fig
ur

at
io

n

Compatible controller
Dummy plug RSEL 
DP-4S

(Enclosed in RSEL)

USB cable (Note 2)

(To be prepared by user) 

Note 1 There is no USB cable enclosed. Please prepare yourself a general-purposed USB cable.
Note 2 A general-purposed UBS cable (the connector on the controller side should be mini-B) can be used.  

A recommended USB cable is U2C-MF50BK (manufactured by ELECOM).
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C
on

ne
ct

io
n

C
on

fig
ur

at
io

n

Compatible controller
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A recommended USB cable is U2C-MF50BK (manufactured by ELECOM).
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1.2 System Requirements
The following operating environment is required to run this software.

Supported OS Type Operable OS
IA-101-X-MW-JS, 
IA-101-N(Note 1),
IA-101-X-USBMW-JS(Note 1), 
IA-101-XA-USBMW-JS(Note 1)

Windows 10, or Windows 11 

Computer PC compatible with supported OS (Windows)
Keyboard Keyboard compatible with a PC compatible with supported OS (Windows)
Memory Capacity of memory necessary to run a supported OS (Windows)
Display XGA and above
Pointing device Mouse or a compatible driver
Storage medium 
drive

DVD-ROM drive

Hard disk Hard disk with at least 200 MB of available space
(The software is installed on the hard disk.)

Serial port RS-232C
(EIA-S74 compliant)

Required for PC software of the following model number: 
Model number: IA-101-X-MW-JS

USB port Required for PC software of the following model number:
Model number: IA-101-N(Note 1)

Other It is necessary to install the following.
.NET Framework 4.8.1 or later

Note 1 There is no cable enclosed. Please prepare yourself an USB cable to connect to the USB 
connector on RSEL Controllers.
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1.3 Installing the Software 

This software is run from the hard disk. This section explains how to install the software.

1.3.1 How to Install the PC Software

(1) Launching the tool for installation
1) Insert the software DVD-ROM into the computer's optical drive.
2) The tool for installation screen (Fig. 1.1) will be displayed.

Fig. 1.1 Tool for Installation Screen
(The screen displayed may vary depending on the version, DVD data, etc.)

* What to do if the tool for installation screen (Fig. 1.1) is not displayed
If the data installation selection screen (Fig. 1.1) is not displayed even when the DVD-ROM is inserted, 
display the screen according to the process below.

a. Using Explorer, etc., display a list of the folders in the DVD-ROM.
Figure 1.2 is displayed.

Fig. 1.2 List of Folders, etc., in the DVD-ROM

b. Double-click to display the tool for installation screen (Fig. 1.1).
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(2) Installation of the computer-dedicated teaching software for XSEL (RSEL)

1) Select "English" on the tool for installation screen (Fig. 1.3) and click OK. 

  

Fig. 1.3 Tool for Installation Screen

(2) When the tool for installation screen (Fig. 1.4) is displayed, select "PC Interface Software for XSEL."

Fig. 1.4 Installation Screen

3) Click Install. 

Fig. 1.5 Installation Screen

Select

Click

Select

Click
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4) The standby screen (Fig. 1.6) is displayed. Wait for the installation to launch.

Fig. 1.6 Standby Screen

5) Installation preparation (Fig. 1.7) begins. 

Fig. 1.7 Preparing to Install

6) The PC Interface Software for XSEL - InstallShield wizard screen (Fig. 1.8) will be displayed.
Click Next. 

Fig. 1.8 PC Interface Software for XSEL - InstallShield Wizard Screen
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7) The user information registration screen (Fig. 1.9) will be displayed. Enter user information and click 
Next. 

Fig. 1.9 User Information Registration Screen

8) Designate the destination for installation of the PC Interface Software for XSEL (Fig. 1.10). Normally, 
the screen as displayed is fine.
After designation, click Next. 

Fig. 1.10 Installation Destination Folder Designation Screen

9) Click Anyone who uses this computer (all users). 

Fig. 1.11 Ready to Install Program Screen
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Installation begins. During installation, the screen in Fig. 1.12 will be displayed.

Fig. 1.12 Installing Program Screen

10) When installation is complete, the screen in Fig. 1.13 will be displayed.
Uncheck "Launch the program" and click Finish. 

  

Fig. 1.13 Installation Complete

11) When program installation is complete, the start menu program (P) → IAI → X_SEL → PC Interface 
Software for X-SEL item will be displayed. Select this item to launch the software.

12) Eject the DVD-ROM. 

13) After launching the program, click Help in the menu to check whether the version is the same as the 
DVD-ROM version.
If the version has not been updated, uninstall the program and install from the DVD-ROM again.
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1.3.2 How to Install Driver Software for USB Connection of RSEL 

It is necessary to install the driver software when using USB by connecting to USB connector.
Make sure to prepare the stop switch in your reach when having an actuator operated by USB connection so 
that you can stop the actuator in an emergency case.

[1] Connect the personal computer to the controller using the USB cable. After connection being established, 
turn on the power to the controller if it is not on.

[2] Installation process of the driver software automatically starts.

[Remarks] 
Once the installation of the USB driver is complete, COM port gets automatically added.  
The way to change the COM port, refer to [1.3.3 How to Change COM Port of IAI USB” in XSEL PC 
Software Instruction Manual] 
(The name of the COM port is differ from the one on USB converter adapter)

Fig. 1.14 Device Manager Screen

The names of COM port is 
“USB Serial Device”. 
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1.3.3 How to change the USB COM port
The COM port set in the installation of USB conversion adapter driver software can be changed by the 
following procedures.

[1] Click Windows Start, Setting, and Control Panel to open the Control Panel screen.
Double click System to open the Property screen.
Click and open Hardware above the System icon.
Click and open Device Manager inside the Hardware folder.
Double click and extend Port (COM and LPT) inside the Device Manager folder.

[2] Double click IAI USB to UART Bridge Controller (COM?). 
(Note) COM? is the COM port number before the port is changed.

Fig. 1.15 Device Manager Screen

[3] Property screen of IAI USB to UART Bridge Controller (COM?) will be displayed.
Click Options (A) on the Property screen.

Fig. 1.16 Property Screen

IAI USB to UART Bridge
Controller (COM?)
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COM port number (P):

[4] COM? Port Option screen will be displayed.
Change the COM port number in the COM Port Number (P) box to the number to be set.
Click OK.

Fig. 1.17 COM? Port Option Screen

[5] COM? Port Option screen will be disappeared.
COM port number will be changed by clicking OK on the Property screen (Fig. 1.16) 

[6] To confirm that the COM port number is changed, close the Device Manager screen and display it 
again.
After confirming the change, close all screens including the Device Manager screen.
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1.4 Connection to Controller

Fig. 1.18 RSEL Controller

Ethernet (Cable to be prepared by user)

Teaching tool

USB cable
(Cable to be prepared by user)

Teaching tool
TB-02
TB-03

Fieldbus cable
(Cable to be prepared by 

user)

Enable 
switch

(Cable to be 
prepared by user)

Functional Grounding
(Cable to be prepared by user)

Motor power supply, control power supply cable
(Cable to be prepared by user)

Emergency 
stop switch
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1.5 Starting the Software (Online Connection)

[1] Turn off the power to the controller and PC, and connect the controller to the PC using the standard RS-
232C cable or USB cable that comes with the software. Set the mode switch on the controller to the 
MANU side.

• When this software is started, the “safety velocity” mode is enabled (enable the safety velocity 
limit). 
In this mode, the maximum velocity is limited to 250 mm/sec or below in programs started from 
the PC software. To operate programs according to their programmed velocity commands, the 
safety velocity mode must be disabled.
Refer to [3.3 Explanation of the Toolbar] for how to enable/disable the safety velocity mode.

[2] Turn on the power to the controller and PC, and start Windows.

[3] Once you start up “XSEL PC Software” from the start menu of Windows, the controller select window
(figure shown below) will show up.
Select a controller that you would like to connect to the PC or to edit data, a window conform to the 
selected controller should come up.

If you put a check mark on “Don’t show this window again.”, you will have an automatic connection to 
the controller with the communication setting you had last time (COM port number, baud rate, etc.) when 
you start it up next time.

Fig. 1.19 Controller Select Window
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In case to show this window again, remove the check mark on “Skip the controller select window and 
connect automatically to the controller with the current communication setting at the startup of XSEL PC 
software.” In the environmental setting window in the XSEL PC software. Click OK. 

* This environmental setting should be added to both for RSEL and XSEL2-T/TX and for other models 
except for RSEL and XSEL2-T/TX.

Fig. 1.20 Environmental Setting Window
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Fig. 1.20 Environmental Setting Window
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[4] The Connection Confirmation window (Fig. 1.21) will open.
In the list boxes of Port Name and Baud Rate (bps), select the communication port (*1) to which the 
RSEL controller is connected and an applicable baud rate (*2),and then click OK. 

(*1) Only the communication ports that are 
available when the application is started can 
be selected. 

(*2) 115200 bps Max.

Fig. 1.21 Connection Confirmation Screen

[5] After connection gets established, multiple program simultaneous startup permission/prohibition setting 
window (Fig. 1.22) opens. Set whether you prohibit or permit the simultaneous starting of multiple 
programs during the manual mode, and click OK. 
[Two or more programs start prohibition (MANU)] 

It prohibits the simultaneous starting of multiple programs during the manual mode.
[Two or more programs start permission (MANU)] 

It permits the simultaneous starting of multiple programs during the manual mode.

Fig. 1.22 Multiple Program Simultaneous Startup Permission/Prohibition Setting Window

If Don’t Show this window from next time on is checked, connection will be established with the settings at 
the last connection time without displaying the screen in Fig. 1.22. 
To remove this check, select the checkbox In Connect, Check Setting of Two or more programs start on the 
Environment Setup (Online) screen (Fig. 12.2) or Environment Setup (Offline) screen (Fig. 12.1). The screen 
in Fig. 1.22 will be displayed at the next startup time to remove the check.
For the Environment Setup (Online) screen and Environment Setup (Offline) screen, refer to [12. Tool]. 
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If you set Two or more programs start prohibition (MANU) when multiple programs have already started, the 
warning message will be displayed. To prohibit the simultaneous starting of multiple programs, click Yes to 
stop all the programs.

Fig. 1.23 Warning Message

[6] A confirmation window for the safety circuit will be displayed.
Refer to [1.6 Operation System Command Restriction] 

[7] Once the controller connection is confirmed, the application will start in the offline mode. If the controller 
cannot be recognized or CANCEL is clicked in this window, the application will start in the offline mode. 
(Even after the application has started in the offline mode, you can use the “Reconnect” function 
explained later to switch the application to the online mode.) 

If Don’t Show this window from next time on is selected, the software will automatically select the port 
name and baud rate that were in use the last time the application was closed and check the controller 
connection based on these settings.

The open status of the TP port (teaching connector) should be as shown below depending on whether or 
not the servo is in use.

<MANU mode/Servo not in use>
Before the OPEN command After the OPEN command

TP port connection Connected to the PC 
software

Forcibly switched to SEL program 
connection. 

The program continues to run.
Error code 414 “SIO unopened error” will occur following the OPEN command.

<MANU mode/Servo in use>
Before the OPEN command After the OPEN command

TP port connection Connected to the PC 
software

Connection to the PC software. 
The program end.

Error code 414 “SIO unopened error” will occur following the OPEN command.

The channel number assigned to the TP port should be Channel 0 (“OPEN 0”).

The “Important” information provided in the above box applies to a condition where the controller is in the 
MANU mode and I/O parameter No. 90 is not set to “2” (IAI protocol). 

Important note
on transferring



1. Before You Begin

26 ME0398-6E 

If you set Two or more programs start prohibition (MANU) when multiple programs have already started, the 
warning message will be displayed. To prohibit the simultaneous starting of multiple programs, click Yes to 
stop all the programs.

Fig. 1.23 Warning Message

[6] A confirmation window for the safety circuit will be displayed.
Refer to [1.6 Operation System Command Restriction] 

[7] Once the controller connection is confirmed, the application will start in the offline mode. If the controller 
cannot be recognized or CANCEL is clicked in this window, the application will start in the offline mode. 
(Even after the application has started in the offline mode, you can use the “Reconnect” function 
explained later to switch the application to the online mode.) 

If Don’t Show this window from next time on is selected, the software will automatically select the port 
name and baud rate that were in use the last time the application was closed and check the controller 
connection based on these settings.

The open status of the TP port (teaching connector) should be as shown below depending on whether or 
not the servo is in use.

<MANU mode/Servo not in use>
Before the OPEN command After the OPEN command

TP port connection Connected to the PC 
software

Forcibly switched to SEL program 
connection. 

The program continues to run.
Error code 414 “SIO unopened error” will occur following the OPEN command.

<MANU mode/Servo in use>
Before the OPEN command After the OPEN command

TP port connection Connected to the PC 
software

Connection to the PC software. 
The program end.

Error code 414 “SIO unopened error” will occur following the OPEN command.

The channel number assigned to the TP port should be Channel 0 (“OPEN 0”).

The “Important” information provided in the above box applies to a condition where the controller is in the 
MANU mode and I/O parameter No. 90 is not set to “2” (IAI protocol). 

Important note
on transferring

ME0398-6E 27

1.6 Operation System Command Restriction

A system was added to check to the user if there is a stop switch to stop the actuator immediately at hand, 
and if there is no stop switch, the actuator operation gets controlled from the XSEL PC software when 
connected with a controller. (V13.00.00.00 or later) 

After display of multiple program simultaneous startup permission and prohibition setting windows, the 
confirmation window for safety circuit will be displayed.

Fig. 1.24 Confirmation Window for Safety Circuit

Select if there is a stop switch to stop the actuator immediately at hand prepared.
Only when Yes is selected in the safety circuit confirmation window (there is a stop switch), such operations 
as actuator operation by the XSEL PC software and SEL program execution (operational system commands) 
become available.
When “No” is selected in the safety circuit confirmation window (there is no stop switch), such operations as 
actuator operation by the XSEL PC software and SEL program execution (operational system commands) 
become unavailable.
(Note) When the operation system commands are to be executed, 31A “Execution Condition Unsuccessful 

Error” or 32F “Execution prohibited error without safety circuit” will be displayed.

The selected content will be shown in the main screen.

Fig. 1.25 Main window (Tool bar)

Display of status permitted / prohibited 
operational system commands
(The enable/disable of the safety 
circuit)
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* Put a check mark on “Don’t show this window from next time on.” in the safety circuit confirmation window 
and the confirmation window for safety circuit will not show up again when the controller is connected.
(Operation will be made with the setting of the previous connection)
If it is required to show the safety circuit confirmation window again, put a check mark on “In connect, 
confirm safety circuit.” in Environment Setup window.

Fig. 1.26 Environment setting Screen
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* When Yes was selected in the previous safety circuit confirmation window and a check mark was put on 
“Don’t show this window from next time on.”, a warning message shown in the figure below will be 
displayed when a controller is connected.

Fig. 1.27 Warning Message (When Operational System Commands Permitted)

Click this button and 
Environment Setup 
window opens.
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1.7 Optional Unit Parameter Initial Setting

When connected to the RSEL controller with an optional unit mounted and its parameters unset, an optional 
unit parameter initial setting confirmation message will be displayed.

Select Yes to set optional unit initial parameters.

Table Optional Unit Parameter Initial Setting

Type No. Name Parameter initial setting

I/O 186 Number of optional units connected Number of optional units connected 
to the RSEL controller

Optional board 1 Unit type PIO units: 0
EC connection units: 1

Optional board 2 Control method 0

Optional board 3 Leading input port number from host 
device

0

Optional board 4 Leading output port number to host device 0
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When the optional unit parameter initial setting is complete, a message confirming "Write to flash ROM?" will 
be displayed.

Click and enter a checkmark in the items (parameters, etc.) to write to flash ROM.
Click Yes → Memory data writes to flash ROM.
Click No → Memory data does not write to flash ROM.
  Memory data will be discarded due to reset (power reboot/software reset) and data will be 

read from flash ROM.

After flash ROM writing, a message confirming "Restart controller?" will be displayed.
Yes Enable changed parameters.
No Do not enable changed parameters.
The changed parameters will be enabled after controller restart (software reset) or power reboot.
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2. How to Save Data
In the controller, there are storage domains in the non-volatile RAM (FRAM) and storage domains in the 
flash memory depending on the type of data to be stored.
Also note that transferring data from the PC software or teaching pendant to the controller will only write the 
data in the controller’s memory, as illustrated below, and the data will be cleared once the controller power is 
turned off or the controller is reset.
To save important data, always write it in the flash memory.
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2.1 RSEL

Since programs, parameters and symbols are loaded from the flash memory upon restart, these data in the 
temporary memories will return to the conditions before editing unless written to the flash memory.
The controller always operates according to the data in main CPU memory (excluding parameters).

(Note) 10% from the top of the position data should be saved in the non-volatile RAM and the remaining in 
the flash memory.
Comment in each position data can be used in 10000 positions at maximum regardless of the 
position number and should be saved in the flash memory.

Retain data even when power OFF
Retain data while power ON

Delete data at reset
Editing data in PC and

 teaching pendant

PC software
TP

RSEL unit RAM memory

Program
parameter

(Other than driver
unit parameter)

Symbol
Position

 (Approx. 90% Remaining)
Position Comment
 (10000 comments)

Driver unit parameter

RSEL unit
Flash memory

RSEL unit
Non-volatile RAM

Coordinate
system data

Driver unit
Non-volatile RAM

Position
 (Approx. 10% from Top)

SEL global data
(Flags, variables

and strings)
Error list

Transfer at reset

Transfer
Transfer

Transfer

Flash writing

Transfer at reset

Transfer

Transfer
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2.2 Notes

Note on transferring data and writing it to the flash memory:
Never turn off the main power while data is still being transferred or written to the flash 
memory.
The data may be lost and the controller operation may be disabled.

Note on saving position data:
The domains to save the position data are the non-volatile RAM for the 10% from top and the flash 
memory for the remaining.
The position data comments are to be saved in the flash memory.
Therefore, if the power is turned off or the software is reset without flash ROM writing, 90% of the 
position data and the position data comments get deleted and the data that was written to the flash 
ROM previously should be read in.
Write it to the flash ROM if you wish to retain the data.
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3. Menu Window
3.1 Explanation of the Menu

3.1.1 Online Screen
(1) RSEL controller

When this software has been started, the main window in Fig. 3.1 will open showing the menu items 
with icons on the tool bar in the case of the RSEL controller. The tree view appearing on the left side of 
the window can be displayed by clicking View (V) from the menu bar and then selecting Tree View (T). 
(Initial window: Main menu)

Fig. 3.1 Online Screen (RSEL Controller)

MenuIcons

Tree View



3.
 M

en
u 

W
in

do
w

38 ME0398-6E 

3.2 Explanation of the Commands

(1) File (F) 
[1] New (N) Create new SEL data. 

• Program (S)  Open the edit window for creating a new program.

• Position (O)  Open the edit window for creating new position data.
* In case of creating new position data, the target select window will appear.

• Put a check mark to “For 6-axis Cartesian Robot” when creating position data for the 6-
axis cartesian robot and click OK. 
The position data edit window for the 6-axis cartesian robot will appear.

• Leave the check box blank at “For 6-axis Cartesian Robot” when creating position data 
not for the 6-axis cartesian robot and click OK. 
The position data edit window not for the 6-axis cartesian robot will appear.

Fig. 3.2 Target Select Window

• Symbol (Y)  Open the edit window for creating new symbol data.

• Coordinate System (D)  
Open the edit window for the new coordinate system definition data. 

[2] Open (O)     Load data currently saved in a file.

[3] Close (C)  Close the currently active window.

[4] Close all windows (L)  Close all the windows.

[5] Save (S)  Save the data in the active edit window by overwriting the corresponding 
file.

[6] Save As (A)  Save the data in the active edit window to a different file under a desired 
name.
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[7] Print Setting (P)  Set the print font and printer.

Fig. 3.3 Print Setting Screen

(Note) If you restart the controller, settings will return to the default values shown below.
• Upper margin: 0 [mm] 
• Left margin: 10 [mm]
• Font: MS Gothic
• Style: Standard
• Size: 10

[8] Most Recently Opened Files (D)  
Selecting this menu item will display a list of files most recently loaded to 
the software, where you can select and load desired files. 

[9] Exit (X) Close the application.

Specify the top margin 
area for printing in [mm]

Specify the left margin 
area for printing in [mm].

Clicking this item will 
display the printer setup 
screen to set the printer.

Clicking this item will display 
the font setting screen to set 
a font for printing. It is 
interlocked with the font 
setting screen displayed by 
clicking View (V) from the 
menu and then selecting 
Font (F). The values set by 
either way will be reflected 
for both.

If this check box is 
selected, the folder name 
will not be printed when 
the file data is printed.

If this check box is 
selected, the folder name 
will not be printed when 
the file data is printed.



3.
 M

en
u 

W
in

do
w

40 ME0398-6E 

(2)  Edit (E)  
This menu lets you perform operations used in editing data.
[1] Undo (U)  Up to the most recent 10 operations can be canceled. However, they 

cannot be canceled when you perform any of the following operations: 
• Transfer of data on the editing screen such as the program edit 

window to the controller 
• Saving of data on the editing screen such as the program edit window 

in a file 
• Closing of the editing screen such as the program edit window 

The following are the operations for which this function is enabled:

Input Line 
insertion

Line 
Deletion Cut Paste

Program Edit Window     
Position Edit Window  - -  
Symbol Edit Window  - -  
Parameter Edit Window  - - - -
Coordinate System Data Edit 
Window  - - - - 

When this operation is performed, and the warning window below will be 
displayed.
Clicking Yes will cancel the operation executed immediately before. 

Fig. 3.4 Warning

[2] Cut (T) Cut the data corresponding to the cursor line in the edit window and save 
the data to the clipboard. 

[3] Copy (C) Copy to the clipboard the data corresponding to the cursor line in the edit 
window.

[4] Paste (P) Paste the data on the clipboard to the cursor line in the edit window. 
[5] Find (F) Find a specified character string. 
[6] Find Next (S)  Find the character string specified in [5] again, starting from the cursor 

line position.

(3) View (V) 
This menu lets you set options relating to screen views. (Refer to [3.4 Tree View]).
[1] Tree View (T)  Show/hide the tree view that appears on the left side of the main window. 
[2] Font (F)  Set the font of text shown in the windows.
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[2] Cut (T) Cut the data corresponding to the cursor line in the edit window and save 
the data to the clipboard. 

[3] Copy (C) Copy to the clipboard the data corresponding to the cursor line in the edit 
window.

[4] Paste (P) Paste the data on the clipboard to the cursor line in the edit window. 
[5] Find (F) Find a specified character string. 
[6] Find Next (S)  Find the character string specified in [5] again, starting from the cursor 

line position.

(3) View (V) 
This menu lets you set options relating to screen views. (Refer to [3.4 Tree View]).
[1] Tree View (T)  Show/hide the tree view that appears on the left side of the main window. 
[2] Font (F)  Set the font of text shown in the windows.
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(4) Program (S) 
This menu lets you perform operations relating to programs. (Available only in the online mode.) 
(Refer to [4. Program Edit Window]). 

[1] Edit (E) Load a selected program from the controller for editing.
Cycle time can be measured.

  Refer to [4.5 Cycle Time Measurement]
[2] Copy/Move (C) Copy/move (cut & paste) a program
[3] Clear (L) Clear a program. 
[4] Save to File (S) Save a selected program or all programs to a file under a desired name. 
[5] End All Operations (T) End all programs and operations that are currently running/being 

performed.
[6] SEL Programming Support Tool (A)

Start up SEL Programming Support Tool.

(5) Position (O) 
This menu lets you operate position data. (Available only in the online mode.) 
(Refer to [6. Position Data Edit Window]). 

[1] Edit (E) Load position data from the controller for editing.
[2] Copy/Move (C) Copy/move (cut & paste) position data.
[3] Clear (L) Clear position data.

* It is not available to select clear items when RSEL connected. 

Fig. 3.5 Clear Position Data Screen

[4] Save (S) Save position data. 
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(6)  Parameter (P) 
This menu lets you operate parameters. (Available only in the online mode.) 
(Refer to [8. Parameter Edit Window]). 

[1] Edit (E)   Load position parameters from the controller for editing.
[2] Easy Parameter Setup (S) Parameter edit is to be conducted in the setting screen of 

each feature for those features listed below.
• RS-232C
• Fieldbus (CC-Link, DeviceNet, PROFIBUS-DP, EtherCAT,  

PROFINET IO, CC-Link IE Field) 
• Ethernet
• Vision System

[3] I/O Output Setting (I) The I/O output setting is a feature to perform this monitor 
setting easily. Also, it is available to establish the settings for 
the input feature select and the output feature select.

[4] Driver unit parameters (D) Displayed when there is an enabled axis.
・ Save to file (S) Saves driver unit parameters for each axis to a file.
・ Transfer to controller (L) Transfers the selected parameter files to driver units.

(7) Symbol (Y) 
This menu lets you operate symbol data. (Available only in the online mode.) 
(Refer to [9. Symbol Edit Window]). 

[1] Edit (E) Load symbol data from the controller for editing.
[2] Clear All (C) Clear all symbol data.

(8) Coordinate System (D) 
This item should be shown when there is a 6-axis cartesian robot in the axis setting.

Edit the coordinate system definition data. (This is available only in the online mode.) 
(Refer to [10. Coordinate System Definition Data edit Window]). 

[1] Edit (E) Read the coordinate system definition data from the controller and edit 
the data.

[2] Clear (L) Clear the coordinate system definition data.
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(9) Monitor (M)  
This menu lets you monitor various statuses, global variables, port statuses, and so on. (Available only 
in the online mode.) (Refer to [11. Monitor]). 
[1] Task Status (T) Open the task status monitor window. 

[2] System Status (S) Open the system status monitor window. 

[3] Axis Status (A) Open the axis status monitor window. 

[4] Input Port (I) Open the input port monitor window. 

[5] Output Port (O) Open the output port monitor window.

[6] Virtual Inpu/Output Port (N) Open the virtual input and output port monitor window.

[7] Global Flag (F) Open the global flag monitor window.

[8] Global Integer (L) Open the global integer monitor window.

[9] Global Real (R) Open the global real variable monitor window.

[10] Global String (G) Open the global string monitor window.

[11] Local Data (B) Local data (local integers, variables, local real variables, local string real 
numbers and local flags) for each program number can be shown.

[12] Detailed Error Information (E) Open the detailed error information monitor window. 
If you click Monitor (M) from the main menu and then selecting Detailed 
Error Information (E), the Error number Select screen will be displayed. 
After setting the number of displayed errors, click OK. 
The detailed error information screen will be displayed.

Fig. 3.6 Error Number Select Screen

[13] Maintenance Information (X) Open the maintenance information monitoring window.
[14] Servo Added Data Monitor (V) Overload level [%] and motor command current [% rated ratio] on 

connected axes should be displayed at once for each axes group.
[15] Power Supply Unit Information (P) Information regarding the power supply unit (PSA-24) should be 

displayed.
[16] Monitoring Data (M) Open the monitoring data window.



3.
 M

en
u 

W
in

do
w

44 ME0398-6E 

(10) Controller (C)  
This menu lets you perform operations relating to the controller, such as executing a software reset or 
resetting controller errors.
[1] Reconnect (C) Reestablish communication with the controller. If the software is currently 

in the offline mode but is able to establish communication with the 
controller, selecting this menu item will switch the software to the online 
mode. 

[2] Change Baud Rate (B) Change the baud rate used for communication between the controller 
and PC.

[3] Offline Operation (Communication port close) (O)  

[4] Axis Setting (G)  The construction of the driver unit that is connected should be displayed.
  Assignment of axes can be changed individually.

[5] SEL Global Data Backup  
Save to File (S) Can save global flags, global integer variables, global real variables, and 

global strings. 
Transfer to Controller (L) Can transfer global flags, global integer variables, global real variables, 

and global strings to the controller. 

[6] All Data Backup (X)  
▪ Save to File (S) Save all program, position, symbol, parameter, coordinate system 

definition data (only if available to edit) and global data in the controller.

The following confirmation screen will be displayed if an ELECYLINDER axis is still connected after 
saving backup files. Select Yes to save all ELECYLINDER axes in a file named "Backup File 
Name+_Axis+Axis number."

Fig. 3.7 Message to confirm saving all ELECYLINDER axes

The following screen will be displayed next. Select Yes to save the error list to a separate file.

Fig. 3.8 Error List Save Confirmation Message
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(10) Controller (C)  
This menu lets you perform operations relating to the controller, such as executing a software reset or 
resetting controller errors.
[1] Reconnect (C) Reestablish communication with the controller. If the software is currently 

in the offline mode but is able to establish communication with the 
controller, selecting this menu item will switch the software to the online 
mode. 

[2] Change Baud Rate (B) Change the baud rate used for communication between the controller 
and PC.

[3] Offline Operation (Communication port close) (O)  

[4] Axis Setting (G)  The construction of the driver unit that is connected should be displayed.
  Assignment of axes can be changed individually.

[5] SEL Global Data Backup  
Save to File (S) Can save global flags, global integer variables, global real variables, and 

global strings. 
Transfer to Controller (L) Can transfer global flags, global integer variables, global real variables, 

and global strings to the controller. 

[6] All Data Backup (X)  
▪ Save to File (S) Save all program, position, symbol, parameter, coordinate system 

definition data (only if available to edit) and global data in the controller.

The following confirmation screen will be displayed if an ELECYLINDER axis is still connected after 
saving backup files. Select Yes to save all ELECYLINDER axes in a file named "Backup File 
Name+_Axis+Axis number."
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(10) Controller (C) [6] All Data Backup (X)  ▪ Save to File (S) (continued)
  

▪ Open File (O) In the Transfer/Divide Selection Screen, transfer to controller, dividing 
files for all data, and referring data can be performed.

Fig. 3.9 Backup Window
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(10) Controller (C) [6] All Data Backup (X)  ▪ Open File (O) (continued)

Click on the “Transfer to Controller” button, and the selected data should be transferred to the controller.
Click on the “Divide File” button, and the selected data should be individually saved in files.

Drag & drop All Data Backup File to the window for the XSEL PC software and the backup window should 
open.

[Caution]
Data transfer to controller is not available in the following cases.

Table: Condition Backup Data Transfer Unavailable
Data type Unavailable transfer condition

Parameter

• The construction of the driver unit does not match between the file 
data and the controller.
(Number of driver units, driver unit type, number of driver axes, etc.)

• Data version of the driver unit does not match with each other.

Position

• The axes setting does not match between the file data and the 
controller.
(Number of activated axes groups and if there is or not a 6-axis 
cartesian robot) 
The position cannot be transferred also when the maximum valid axis 
number on the controller is larger than the maximum valid axis number 
in the file data.

* When the data is transferred with parameters at the same time, 
transfer to the controller is available even with the condition above.

Coordinate System Definition
• There is no 6-axis cartesian robot in the axis setting in a controller
* When the data is transferred with parameters at the same time, 

transfer to the controller is available even with the condition above.

The following section explains about “Transfer to Controller”, “Divide File” and “View/Edit”. 
▪ Transfer to Controller  On the Data Transfer/Division Selection Screen, click Transfer to

Controller. The File Setup Screen will appear.  
Select Backup All Saved Data (all data including programs, positions, 
etc.) and transfer to the controller. (If you are not selecting, click  to 
select the data to be transferred. The selected data will be marked with 
.) 
(Note) The parameter can not be sent if the selected parameter in the 

controller is the same as the axis pattern.

▪ Divide Files The backup data (all data including program and position) can be divided 
into program, position, parameter, symbol, coordinate system and global 
data. 
Click Divide Files on the Transfer/Divide data selection screen.
The program, position, parameter symbol and global data are displayed in 
order on the File Save Screen. Save them with a file name.

▪ View / Edit The Edit screen for the selected data should be displayed.

* It is available to save each data individually in a file in the displayed Edit 
screen. However, it is not available to overwrite a backup file.

* The global data is available only for viewing.
* The EC axis backup data cannot be displayed.
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(10) Controller (C) [6] All Data Backup (X)  ▪ Open File (O) (continued)

Click on the “Transfer to Controller” button, and the selected data should be transferred to the controller.
Click on the “Divide File” button, and the selected data should be individually saved in files.

Drag & drop All Data Backup File to the window for the XSEL PC software and the backup window should 
open.

[Caution]
Data transfer to controller is not available in the following cases.

Table: Condition Backup Data Transfer Unavailable
Data type Unavailable transfer condition

Parameter

• The construction of the driver unit does not match between the file 
data and the controller.
(Number of driver units, driver unit type, number of driver axes, etc.)

• Data version of the driver unit does not match with each other.

Position

• The axes setting does not match between the file data and the 
controller.
(Number of activated axes groups and if there is or not a 6-axis 
cartesian robot) 
The position cannot be transferred also when the maximum valid axis 
number on the controller is larger than the maximum valid axis number 
in the file data.

* When the data is transferred with parameters at the same time, 
transfer to the controller is available even with the condition above.

Coordinate System Definition
• There is no 6-axis cartesian robot in the axis setting in a controller
* When the data is transferred with parameters at the same time, 

transfer to the controller is available even with the condition above.

The following section explains about “Transfer to Controller”, “Divide File” and “View/Edit”. 
▪ Transfer to Controller  On the Data Transfer/Division Selection Screen, click Transfer to

Controller. The File Setup Screen will appear.  
Select Backup All Saved Data (all data including programs, positions, 
etc.) and transfer to the controller. (If you are not selecting, click  to 
select the data to be transferred. The selected data will be marked with 
.) 
(Note) The parameter can not be sent if the selected parameter in the 

controller is the same as the axis pattern.

▪ Divide Files The backup data (all data including program and position) can be divided 
into program, position, parameter, symbol, coordinate system and global 
data. 
Click Divide Files on the Transfer/Divide data selection screen.
The program, position, parameter symbol and global data are displayed in 
order on the File Save Screen. Save them with a file name.

▪ View / Edit The Edit screen for the selected data should be displayed.

* It is available to save each data individually in a file in the displayed Edit 
screen. However, it is not available to overwrite a backup file.

* The global data is available only for viewing.
* The EC axis backup data cannot be displayed.
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(10) Controller (C) (continued)
[7] Write to Flash ROM (W) Clear the data areas in the flash ROM and then write the data saved in 

the controller’s RAM to the flash ROM. 

* There is a limit in the number of writing to the flash ROM (write limit: about 100,000 times). If you 
do not want to write all the data, select “Select the data range” and write to the flash ROM.

Fig. 3.10 Confirmation

[8] Initialize Memory (I)  
▪ Position (O) Clear all position data. 

(Note) If 60A “Position Data Error” occurs, use this command to initialize 
the position data. 

(Note) 20B “Position Data Error” will occur if the software is reset or 
power is turned OFF after this operation without writing the 
position data to the flash ROM first when connection is 
established.

▪ Coordinate System Definition Data (C)
Clear all coordinate system definition data.
It should be displayed when there is a 6-axis cartesian robot. 

(Note) If 623 “Coordinate System Error” occurs, use this command to 
initialize the coordinate system definition data. 

▪ Global Variable and Flag (V)  
Clear all global variables and flags to zero.

▪ Parameter (Shipment Values) (S) 
Can return parameters to the ones at the time of shipment. This item is 
not displayed normally. It is a function which will become available by 
inputting a password. Refer to [8.5 How to Initialize Parameter (at the 
time of shipment)]. 
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(10) Controller (C) (continued)
[9] Abs. Encoder Reset (A) Reset the absolute data. 
[10] Software Reset (R) Execute software reset of the controller. 
[11] Reset Error (E) Reset errors present in the controller. 
[12] Drive-source Recovery Request (P)  

Issue a drive-source recovery request to the controller. 
[13] Operation-pause Reset Request (L)  

Issue an operation-pause reset request to the controller. 
[14] Setting Time Set the time.
[15] About Version (V) Show the various version information regarding the controller. 

Select "Controller (C)" → "About Version (V)" in the menu. Version information is displayed for the 
controller, driver units, actuators, and option units.

Controller-related version information Driver-related version information

Actuator-related version information Option unit PIO-related version information

Option unit (EC)-related version information

Fig. 3.11 Version Information

When the driver unit and actuators support the actuator identification feature, it is available to edit the 
user memo.
(Rewrite the user memo by pressing Update.) 

Option unit (EC)



3. M
enu W

indow

48 ME0398-6E 

(10) Controller (C) (continued)
[9] Abs. Encoder Reset (A) Reset the absolute data. 
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When the driver unit and actuators support the actuator identification feature, it is available to edit the 
user memo.
(Rewrite the user memo by pressing Update.) 
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(11) Tool (T) 
This menu lets you specify settings relating to this application.
[1] Environment Setup (S) Set items that define how the application is run.

(12) Utilities (U)
[1] SEL Programming Support Tool (A) Start up SEL Programming Support Tool.

(13) EC (E)
[1] Teaching Tool (T) Start up the EC teaching tool.

(14) Window (W) 
This menu lets you change how the windows are displayed.
[1] Cascade (C) Cascade all open windows diagonally from top to bottom.
[2] Tile Vertically (V) Arrange all open windows vertically without overlapping.
[3] Tile Horizontally (H) Arrange all open windows horizontally without overlapping.
[4] Minimize All (M) Minimize all open windows (reduce them to icons). 
[5] Make to Window (N) Make all minimized windows (window icons) to windows.
[6] Arrange Icons (A) Arrange minimized windows (window icons). 

(15) Help (H) 
[1] Tool Version Information Show the version information of this software.
[2] Search for Error Countermeasures Shows the error countermeasure search window.
Select "Help (H)" → "Search for Error Countermeasures" in the menu. Following Search for Error 
Countermeasures window is displayed

Select RSEL from Combo Box at the left bottom of the 
window.

In the Text box at the bottom right of the window, input 
an error code in three digits.

Click ���  on the window right side of Text Box and the 
error countermeasure window for the input error code 
should be displayed.

Click Troubleshooting at the bottom center of the 
window, and a countermeasure for the error should be 
displayed. Follow the instruction in the window to 
remove the cause of the error. 
(Refer to [16. Error Countermeasures])

Click �������  at the top right, and the screen returns to the 
Search for Error Countermeasures window.



3.
 M

en
u 

W
in

do
w

50 ME0398-6E 

3.3 Explanation of the Toolbar

This section explains the toolbar (Fig.3.12) shown at the top of the main window (below the menu bar). 

Fig. 3.12 Toolbar

Open File Same as clicking File (F) and then selecting Open (O). 

Save Same as clicking File (F) and then selecting Save (S). 

Edit Program Same as clicking Program (S) and then selecting Edit (E). 

Edit Position Same as clicking Position (O) and then selecting Edit (E). 

Edit Parameter Same as clicking Parameter (P) and then selecting Edit (E) 

Edit Symbol Same as clicking Symbol (Y) and then selecting Edit (E) 

Edit Coordinate 
System Definition 
Data

Same as clicking Coordinate System (D) and then selecting Edit (E). 
It should be displayed when there is a 6-axis cartesian robot. 

Monitor Input Port Same as clicking Monitor (M) and then selecting Input Port (I). 

Monitor Output Port Same as clicking Monitor (M) and then selecting Output Port (O). 

Virtual Input/Output  
Port Monitor

Same as clicking Monitor (M) and then selecting Virtual Input/Output Port (N) 

Monitor Global Flag Same as clicking Monitor (M) and then selecting Global Flag (F). 

Monitor Global Integer 
Variable

Same as clicking Monitor (M) and then selecting Global Integer (L). 

Monitor Global Real 
Variable

Same as clicking Monitor (M) and then selecting Global Real (R). 

Monitor Global String 
Variable

Same as clicking Monitor (M) and then selecting Global String (G). 

End All Operations Same as clicking Program (S) and then selecting End All Programs (T). 
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Enable/disable the safety velocity limit when in the MANU 
(manual) mode.
[Safety Vel Specified (MANU)] --- Enable the safety velocity 
limit (the maximum speed will be limited to 250 mm/sec or 
below regardless of program or parameter settings).
[Safety Vel Not Specified (MANU)] --- Disable the safety 
velocity limit.

Permit/prohibit the simultaneous starting of multiple programs 
in the MANU (manual) mode.
[Prhbt mult prgs strt (MANU)]
Prohibit the simultaneous starting of multiple programs in the 
MANU mode.
[Prmt mult prgs strt (MANU)]
Permit the simultaneous starting of multiple programs in the 
MANU mode.

Permit/prohibit sending I/O commands to ELECYLINDER 
axes.
[EC I/O Command Prohibited(MANU)]
Prohibit sending I/O commands to ELECYLINDER axes.
Select this when performing tasks such as using the EC 
teaching tool to perform teaching.
[EC I/O Command Permitted(MANU)]
Permit sending I/O commands to ELECYLINDER axes.
Select this when controlling ELECYLINDER axes from the I/O 
port.



3.
 M

en
u 

W
in

do
w

52 ME0398-6E

3.4 Tree View 

You can display various data edit windows in the online mode by double-clicking the corresponding items 
displayed in the tree view (Fig. 3.13) that appears on the left side of the main window.
You can show or hide the tree view by clicking View (V) from the menu bar and then selecting Tree View (T).

Fig. 3.13 Tree View (Controller model, Program)

In RSEL, the number of remaining steps should not be displayed in the tree view. (It should be displayed in 
the main window.)

Fig. 3.14 The number of remaining steps

Fig. 3.15 Tree View (Position)

Fig. 3.16 Tree View (Parameter)

Currently registered programs
Number of registered steps in (  )
Program name in [  ] (if a symbol is registered)

Unregistered programs

Controller model

When Axes Group No. 2 is activated, the axes group 
numbers should be shown.
Double-click on an axes group number and the position 
edit window for the selected axes group number should 
open.
When Axes Group No. 2 is inactivated, double-click on 
“Position” and the position edit window should open.

Shown in brackets [ ] is the driver 
type of the driver unit

Double-click on an axes group number in the axes 
group, axis and actuator parameters, and the 
parameter edit for the selected axes group number 
and the parameter type should open.
Double-click on the driver unit number in in the driver 
unit parameter, and the parameter edit (driver unit) 
for the selected driver unit number should open.
Double-click on a parameter type other than those 
above, a parameter edit for the selected parameter 
type should open.
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Double-click on a parameter type other than those 
above, a parameter edit for the selected parameter 
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Fig. 3.17 Tree View (Symbol)

Fig. 3.18 Tree View (Coordinate system)

Fig. 3.19 Tree View (Monitor)

Symbol edit items
Double-click a desired symbol category to open 
the corresponding edit window.

Monitors supported by the RSEL should be 
displayed.
Double-click on a monitor type, and the monitor 
window for the selected monitor type should open.
Also, the local variable monitoring type for each 
program number should be displayed below “Local 
Variable”. (Only for program numbers valid step data 
is registered)
Double-click on the local variable monitoring type, 
and the local variable monitoring window for the 
selected program number should open.

Coordinate edit items
Double-click a desired coordinate system 
category to open the corresponding edit window.
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Fig. 3.20 Tree View (Controller)

Other Operations
Drag an item other than the controller to the main window and drop it, and the window for the selected item 
should be displayed in the main menu. (The same process as when an item is double-clicked)

The controller menu supported by the RSEL 
should be displayed.
(There are some items hidden in the menu.)
Double-click it and the same process as the 
selected controller menu should be executed.
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Fig. 3.20 Tree View (Controller)

Other Operations
Drag an item other than the controller to the main window and drop it, and the window for the selected item 
should be displayed in the main menu. (The same process as when an item is double-clicked)

The controller menu supported by the RSEL 
should be displayed.
(There are some items hidden in the menu.)
Double-click it and the same process as the 
selected controller menu should be executed.
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3.5 Controller Monitor  

Together with display of the tree view, the controller monitoring window should be displayed and the 
condition of a controller should be shown.

MANU Mode + All Axes Servo-On Mode + Emergency Stop MANU Mode + Error Occurred
Fig. 3.21 Controller Monitor

Status ： The controller status state is displayed.
Refer to Table 3.5 for contents of display.

System Mode ： The current operation mode is displayed.
Yellow lamp should turn on in MANU Mode while green in AUTO Mode.

Emergency stop ： Status of Emergency stop is displayed. 
Red lamp should turn on in emergency stop.

Servo (all axes) ： Green lamp should turn on when the servo in all the axes connected to a controller 
is on.
Note: EC axes should not be included to servo-on status.

Program running ： Status of program execution is displayed. 
Green lamp should turn on while a program is being executed.

Enable SW ： Status of Enable SW is displayed.
Green lamp should turn on when the enable switch is on.

Drive source cut off ： Status of Drive source cut off is displayed.
Red lamp should turn on during the drive cutoff.

Gray lamp should turn on and all letters turn into gray when offline.
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Table 3.5 Tatus display list
Display Priority** Detail

Prd 2 In Data Flush ROM Write
ErG 3 In Emergency Stop (Update Mode excluded)

enb 4 When Enable Switch is off (Deadman Switch, Safety Gate)
(Update Mode excluded)

EE** 5

Cold Start Level ErrorEd** 5
E6** 5
E5** 5
EC** 5

Operation Cancelation Level ErrorEb** 5
E4** 5

-rS 6 Operation Paused (standby for resuming) (Update Mode excluded)
-ILC 7 Servo All Axes Interlock (Update Mode excluded)
EA** 8

Message Level ErrorE9** 8
E2** 8
Ardy 9 Ready Status (AUTO mode)
rdy 9 Ready Status (MANU mode)

* Smaller number has higher priority
In simultaneous occurrence, one in high priority should be displayed.
When the status display is Priority 2 to 8, the content of error should be shown in the text box at the 
bottom of the status.
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4. Program Edit Window 
4.1 Explanation of the Items Displayed in the Program Edit Window 

(1) Click Program (S) from the menu bar, and then select Edit (E). 
(2) When the program number selection window opens, select the program you want to edit, and then click 

Load. 

Program name assigned in the symbol edit window

Fig. 4.1 Program Number Selection

* When Axes Group No. 2 is valid, “Axes Group Number Initial Value” should be displayed.
Axes Group Number Initial Values: Axis group number applicable for control at program start

Fig. 4.2 Program Number Select Window

The axes group number initial value should be changed in the following process.
(1) Select “Program (S)” -> “Edit (E)” in the menu. (Window shown above should appear)
(2) Click Change Initial Value on the program number you would like to make a change to the axes 

group number initial value, and the window shown in the figure below should open.

Fig. 4.3 Axes Group Initial Value Setting



4.
 P

ro
gr

am
 E

di
t W

in
do

w

58 ME0398-6E 

(3) Select an axes group number and click OK. 
(4) Confirmation for flash ROM writing should appear. Select “Program” and click Yes. 

Fig. 4.4 Confirmation for Flash ROM Writing

(Note) Without writing the program to the flash ROM, the axes group number initial value should go back 
to that before change after the power gets OFF or controller gets reset.

(3) The program edit window will open. This window has the following controls and fields. 
No. Step number. 

B  Use this field to set a breakpoint. (Supported only in the online edit mode.)  
Click the “B” field in the line you want to set a breakpoint for. Once a breakpoint is 
set, “B” will be shown in the field. 
A breakpoint will be cancelled by executing software reset.

T Indicate the start point and end point for cycle time measurement.

E Enter a desired extended condition. 

N Specify reversing “N” of the input condition. 

Cnd * Enter a desired input condition. 

Cmnd Enter a desired SEL command. 
Double-clicking this field or pressing the F1 key will open the SEL Command 
Explanation window (Fig. 4.9). 
This window provides an explanation of each SEL command. You can select a 
desired command in this window and input it to the step data. 

Operand 1 *  Enter desired operand 1. 

Operand 2 *  Enter desired operand 2. 

Pst *  Enter a desired output (operand 3). 

Comment Enter a command, if necessary 
(32 half-width characters and 16 full-width characters max. for RSEL). 
You can also double-click this field to modify a part of the comment currently 
entered. 

* Press F11 to find a specific symbol in the input condition/operand fields.
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(3) Select an axes group number and click OK. 
(4) Confirmation for flash ROM writing should appear. Select “Program” and click Yes. 
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Comment Enter a command, if necessary 
(32 half-width characters and 16 full-width characters max. for RSEL). 
You can also double-click this field to modify a part of the comment currently 
entered. 

* Press F11 to find a specific symbol in the input condition/operand fields.
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* Column T should be shown. Indicate the start point and end point for cycle time measurement.
Refer to [4.5 Cycle Time Measurement]

Fig. 4.5 Program Edit

*1 It is available to set in Operand 1 and Operand 2 with binary and hexadecimal systems.

Fig.4.6 Setting with Binary and Hexadecimal Systems

[How to set up]
When using the binary numbers, apply “&B” at the top of the value.
When using the hexadecimal numbers, apply “&H” at the top of the value.
Eight digits can be input at maximum for binary and hexadecimal numbers.
* In the operand to input the axis pattern (the operand input values in binary system), do not apply “&B” at 

the top to input with the binary numbers.
* Binary numbers are treated as an integer with no signal.
(e.g. &B11111111 = 255)

* Hexadecimal numbers treated as an integer with a symbol.
(e.g. &HFFFFFFFF = -1)

[Restrictions]
・Binary and hexadecimal systems cannot be used for the operand indirect indication in the program.
・There will be no change to the input range of each operant even if binary or hexadecimal system is used.

*2 Press Enter key in the condition that the cursor is placed on the comment in the final line, and 100 lines of 
blank step data will be added.
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If even one line is changed, all step numbers will be displayed in red. Right-clicking a desired input item 
in each line will display a pop-up menu (Fig. 4.7). The items in the pop-up menu are explained below.

Cut (T)  Same as clicking Edit (E) from the menu bar and then selecting Cut 
(T). 

Copy (C)  Same as clicking Edit (E) from the menu bar and then selecting Copy 
(C). 

Paste (P)  Copy the entire cursor line. Same as clicking Edit (E) from the menu 
bar and then selecting Paste (P). The step data saved on the 
clipboard will be inserted into the cursor line.

Insert Line (I) Insert line at the cursor line.You can also insert multiple lines.
Delete Selected Lines (D) Delete the lines in the selected range. 
Set Comment (S)  Set the entire cursor line as a comment (invalid step). If a valid step 

has been set as a comment by mistake, you can select Release 
Comment explained below to return the line to a valid step. 
Executing Release Comment on a line containing character strings 
will clear all character strings in the line. 

Release Comment (R)  Return the selected comment line to a step.

Fig. 4.7 Pop-up Menu
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In the program edit window, selecting Edit (E) from the menu and then Undo (U) can cancel up to the most 
recent 10 operations. 
Alternatively, pressing the Ctrl key and Z key simultaneously can cancel the operations. 
However, the cancel function will become disabled when any of the following operations is performed: 
 Transfer of data on the edit screen to the controller 
 Saving data on the edit screen to a file 
 Closing of the edit screen 

When this operation is performed, the warning screen in Fig. 4.8 will be displayed. 
Clicking Yes will cancel the operation executed immediately before.

Fig. 4.8 Warning

Double-clicking the Cmnd field or pressing the F1 key will open the SEL Command Explanation window. Use 
this window as a reference when editing data.

Fig. 4.9 SEL Command Explanation

Pressing the F2 key can change data in the cell partially. 
(Example: MOVP → MOVL) 

The SEL programming manual 
can be displayed from the SEL 
command explanation window.
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Right-clicking on the SEL Command Explanation window will open a pop-up menu containing the following 
items.

Input  Input the command in the cursor line to the step data (into the cursor line in the 
program edit window). 
It should made the same behavior when double-click on the selected line in the 
SEL command explanation window.

Font  You can set a desired font for displaying the SEL command explanations.
Sort  You can sort the command list alphabetically or by command category.
Help The SEL programing manual of the selected command should show up.

Pressing [F1] in the selected line in the SEL command explanation window should 
behave in the same way.

Fig. 4.10 Pop-up Menu

 (4) This window has the various buttons shown below.

(a) (b) (c) (d) (e) (f) (g) (h)  (i) (j) (k) (l)                                (m) 

Fig. 4.11 Buttons
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(a) Save to File
Click this button to save the program in a file 
with a name. 
Caution: In “Program File Format 1” of the X-SEL-

P/Q, PX/QX (with gateway function), 
controllers that are compatible with 
increased memory, steps No. 6001 and 
thereafter and programs No. 65 and 
thereafter cannot be saved. In case of 
the SSEL controllers compatible with 
increased memory (with gateway 
function), you can not select the Program
File Format 1 (normal format) for Step 
No.2001 or later and Program No.65 or 
later. Select the Program File Format 2 
(extended format) to save.

(b) Transfer to Controller  
Clicking this button will prompt the software to 
check the program data for syntax errors and 
transfer the program data to the controller if no 
errors have been found. 

(c) Check Program  
Clicking this button will display information 
regarding syntax errors found in the program 
you have created, as well as operands used in 
the program. 

(d) Print  
Clicking this button will print the program. 

(e) Run  
Clicking this button will run the program. If the 
program has not yet been saved after editing, 
you must transfer the program to the controller 
beforehand. 
Caution: Since the controller’s processing speed is 

faster than the PC’s communication 
speed, the cursor position in the program 
edit window may not always correspond 
to the actual movement of the actuator.

(f) Run 1 Step  
The program will run one step every time this 
button is clicked. 

(g) Pause  
Clicking this button will pause the program 
currently running. 

(h) End  
Clicking this button will end the program 
currently running. 

(i) Show Local Flag
Clicking this button will show the local flag 
window for the program currently running. 

(j) Show Local Integer Variable  
Clicking this button will show the local integer 
variable window for the program currently 
running. 

(k) Show Local Real Variable  
Clicking this button will show the local real 
variable window for the program currently 
running. 

(l) Show Local String Variable  
Clicking this button will show the local string 
variable window for the program currently 
running.

(m) Program Error Information  
It shows program errors. 
Click on the [Detail] button and the details of 
the program errors should be displayed.

Fig. 4.12 Program Error Detail Information
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 (5) Checking the program
The software will check the program you have created, for SEL syntax errors. 
[1] Click Check Program button in the program edit window. 
[2] If any error is found, the error list will be displayed. 

Check Program button

Fig. 4.13 Error List

The error list has the Step No., Column and Message fields. Double-clicking an error line will move the 
cursor to the location of the corresponding error. 
[3] Information regarding the operands (Cnd, Operand 1, Operand 2 and Pst) in the program you are 

editing is displayed.

[a]     [b]         [c]         [d]     [e]      [f]       [g]     [h]

Fig. 4.14 Operand Information
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[a] Syntax Error 
Message (error content)  

[b] Variable No. Use Condition
Variable No. 
Category (Integer, real number)  
Scope (Global, local)  
* If the applicable variable number is specified indirectly, the Category and Scope fields will show 
“Unknown.”  

[c] Input/Output/Flag No. 
Port/Flag No. 
Category (Input Port No., Output Port No., Input/Output Port No. or Flag No.)  
Scope (Global or Local)  
* If the applicable port/flag number is specified indirectly, the Category and Scope fields will show 
“Unknown.”  

[d] Program No. Use Condition 
Program No. 

[e] Tag No. Use Condition 
Tag No. (Tag number in use)  
Declaration/Jump

[f] Subroutine No. Use Condition 
Subroutine No. 
Declaration/Call 

[g] Position No. Use Condition 
Position No. 

[h] Axis No. Use Condition 
Axis No. 

* If a symbol is used in any of the numbers in [b] through [h], the corresponding definition value will be 
displayed in the margin. 

The above information is displayed in an itemized list at the bottom of the program edit window. You can 
double-click a desired item to move the cursor to the corresponding program.
You can also right-click the list to display a pop-up menu and hide the list or sort the records.
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4.2 Saving a Program, Transferring and Closing the Edit Window
4.2.1 Saving a Program Online, Transferring and Closing the Edit Window
(1) Saving to a file the program data you are editing 

Click Save to File in the program edit window. 
This is the same as clicking File (F) and then selecting Save As (A). 
After clicking Save to File, Save File Select screen will be displayed.

In case of the X-SEL-P/Q, PX/QX controllers compatible with increased memory (with gateway 
function), you can not select the Program File Format 1 (normal format) for Step No.6001 or later and 
Program No.65 or later.
In case of the SSEL controllers, you can not select the Program File Format 1 (normal format) for Step 
No.2001 or later and Program No.65 or later.
Select the Program File Format 2 (extended format) to save.
(PC interface software version 7.2.0.0 or later) 

Fig. 4.15 Save File Select Screen

A window to input a file comment should appear at file saving.
Input a file comment and click OK. 
If you click Cancel, the file can be saved but the file comment will not be saved.

Fig. 4.16 File Comment Save Window

* The file comment you had can be confirmed by clicking the file property button (    ) in each edit 
window.

    

Caution: If you click "Always save with 
Format 2", files will be always 
saved with Format 2. And this 
screen won’t be displayed after 
that. It can be displayed again by 
setting in the Environment Setup 
screen (12. Tool).
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(2) Transferring to the controller the program data you are editing.
You can save the program data you are editing to the controller’s memory.
Click Transfer to Controller in the program edit window.
This button is selectable only in the online edit mode.

Caution: If the program contains any error, the error will be displayed and the program will not 
be transferred to the controller.

(3) Writing to the flash ROM 
Once the program has been transferred to the controller, the following confirmation dialog box with the 
message, “Write Flash ROM?” will be displayed.

Fig. 4.17 Confirmation

Click and select a desired item (Program, etc.) to write to the flash ROM. 
Click Yes → The memory data will be written to the flash ROM. 
Click No → The memory data will not be written to the flash ROM. If No (N) is selected, the controller 

will clear all data in its memory after a reset (i.e., after the controller power is 
reconnected or a software reset is executed), and then load the data from the flash 
ROM. (The controller will operate in accordance with the transferred data until a reset is 
executed.)  

* The number of writing to the flash ROM is limited. (can write approx. 100,000 times) 
If you don’t want to write all the data to the flash ROM, select “Write selected data region.” 

(4) Closing the program edit window
Attempting to close the program edit window will display the following confirmation dialog box with the 
message, “Save edited data in the Controller?” 

Fig. 4.18 Confirmation

Yes The edited data will be transferred to the controller → (3), “Writing to the flash ROM”  
No The software will close the program edit window without saving the edited data.
Cancel The software will cancel the operation and return to the program edit window.
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4.2.2 Transferring a Program Created Offline
A program created offline can be transferred to a controller by following the steps below.

(1) Select File → Open from the menu.
In the screen of “Open File”, select a program created offline and open it.

(2) If a controller is connected, Controller Transfer button    gets activated once the program is opened.
Press Controller Transfer button     , the program gets transferred to the controller.

Fig. 4.19 Program Edit Screen

(3) A confirmation screen asking if it is okay to transfer the data to the controller will appear.
Press Yes. 

Fig.4.20 Confirmation Screen
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(4) Next, a screen to select the program number for destination will be shown.
Click on a program number line for destination to select a destination.
Press Write.

Fig.4.21 Program No. Select

(5) A confirmation screen stating “Write Flash ROM” will appear.
Press Yes.

Fig.4.22 Confirmation Screen

(6) The program will be transferred to the controller.
Also, flash ROM writing will be conducted, and the display below flashes during writing.
The display will disappear once writing is complete.

Fig.4.23 Writing Flash ROM Screen
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4.3 Saving All Programs to a File

(1) Saving all programs to a file 
You can save programs from No. 1 to 512 in the controller as a single file.

[1] Click Program from the menu bar, and then select Save to File.
[2] In the program number selection window, click Save All. Then specify a desired file name and 

folder.

Fig.4.24 Program Save

(2)  Opening the all programs file 

[1] Click File from the menu bar, and then select Open. 
[2] In the file open window, select the file you want to open and then click Open. 
[3] The program No. selection window will be displayed. Select a desired program No. to read and click 

Read. 
If you want to transfer all programs to the controller, select Load All Program. If you want to select 
programs in the all programs file and transfer them individually, select desired program numbers 
and then click Load a Program to transfer the corresponding programs to the controller.

Fig. 4.25 Program Transfer (Online) 

Print All: Print all programs (excluding the program with 0 steps). 
Print: Print only the program selected from the list at the left of the button.
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(3) Important note on transferring an all programs file to the controller 

[1] Transferring all program files to a controller at once will clear all existing programs No. 1 to 512. 
If necessary, back up all current programs before the transfer.

[2] If the all programs file includes any program that contains symbols and the symbols are not defined 
in the controller’s memory, an error will occur when the applicable program is transferred to the 
controller. If an error occurs, none of the programs will be transferred to the controller. Therefore, if 
the applicable symbol data is saved to a file, transfer the symbol definition file first. If there is no 
symbol definition file, define the applicable symbols in the symbol edit window and then transfer the 
definitions to the controller, before transferring the all programs file again. 

[3] If the all programs file contains any error, the error window will be displayed and none of the 
programs will be transferred to the controller. In this case, double-click the error shown in the error 
window to open the program file that contains the applicable error. Correct the error, and then save 
the file by overwriting. If multiple errors exist, correct all errors. When all errors have been 
corrected, transfer the programs to the controller again. The procedure in [3] provides an important 
recovery method for program files containing errors.

(4) Saving the all programs file 

[1] If the program files read from the all programs file are saved as the all programs file, click Save. 

[2] If the program files are saved individually, click Save as. 
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4.4 Running the Program

You can run the program in the program edit window. To run the program you are editing, transfer it to the 
controller first. 

Caution: Once transferred to the controller, the program can be run without being written to the 
flash ROM first. If the program is not written to the flash ROM, however, it will be lost 
once the controller power is reconnected or a software reset is executed.

[e] Run: Clicking this button will run the program.
[f] Run 1 Step: The program will run one step every time this button is clicked.
[g] Pause: Clicking this button will pause the program currently running.

Clicking it again will resume the program.
Clicking Run or Run 1 Step will resume the program.

[h] End: Clicking this button will end the program currently running. 
Breakpoint: You can pause the program in a desired step. “B” will appear/disappear every time the 

field is clicked.
Note) A breakpoint will be cleared once the controller power is reconnected or a 

software reset is executed.

Fig. 4.26 Program Run

[e] [f] [g] [h]
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[e] [f] [g] [h]
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4.5 Cycle Time Measurement

By setting up the measurement start point and end point in the program, the cycle time during program 
operation can be measured. (V13.02.00.00 and later)

4.5.1 How to Measure Cycle Time

Select Program (S) → Edit (E) and Program Number Select window appears.
Select a program to operate and click Read. 
Program Edit window appears.
Column T (marked in red box), which is for the setup of measurement start point and end point for cycle time 
measurement, should be shown in Program Edit window.

Fig. 4.27 Program Edit window

There are three types of setting in the setup in Column T.
• S : Cycle Time Measurement Start Point
• E : Cycle Time Measurement End Point
• SE : Measurement Point for Cycle Time Measurement for One Step Only

Column T
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[1] Setting of Cycle Time Measurement Area Section
(Note) The section of area to be set up should be just one section. Two or more sections cannot be 

established. 
(Note) When establishing the input / extension status setting, set S and E in the command (Cmnd 

column) description step.
If the setting is established in the steps of only input / extension stays, it will not be subject to 
measurement.

(1) Measurement Start Point and End Point Setup
[1] Right-click on Column T (blank cell) of the start step of the area section that you would like to 

measure.
S: Measurement start point will be displayed.

Fig. 4.28 Measurement start point Setup

[2] Secondly, right-click on Column T (blank cell) of the end step of the area section that you would like 
to measure.
E: Measurement end point will be displayed.

Fig. 4.29 Measurement end point Setup
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(2) Measurement One Step Setup
[1] Right-click on Column T (blank cell) of the step that you would like to measure.

S: Measurement start point will be displayed.

Fig. 4.30 Measurement start point Setup

[2] Secondly, right-click on the point that S is being displayed.
SE: The measurement point will be displayed.

Fig. 4.31 The measurement point Setup

Follow the steps below when it is required to set up again or cancel the items that you have already set up.
• When S and E are displayed right-click on the cell of S, and S will be erased.

If E is displayed, it means that the measurement area section setting is not activated.
Right-click on a blank cell, and S will be shown and the measurement area section setting gets 
activated.

• Right-click on the cell of E, and E will be erased.
If S is displayed, it means that the measurement area section setting is not activated.
Right-click on a blank cell, and E will be shown and the measurement area section setting gets activated.

• Right-click on the cell of SE, and E will be erased.
Click it again, and E will be erased.
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[2] Displaying Cycle Time Measurement Result
Once a program gets operated, cycle time will be measured and the result will be displayed at the 
position marked in red.

Once the program starts executed and the step with “S” being shown gets executed, measurement
will start and display shows -----.---s.
Once the step with “E” being shown is completed, the measurement will finish and the cycle time 
measurement result will be displayed.
The time to be shown should be from 0.000sec to 86399.999sec (one day).

Once the first measurement is completed and the step with “S” being shown has been executed, 
measurement will start again and -----.---s will be displayed.
If a change is made to the cycle time measurement area section after measurement is finished, the 
display will turn to blank.

Fig. 4. 32 Measurement Result Display

• Blank : Status of Cycle Time Measurement Not Executed
• -----.--- Displayed : Status of Cycle Time Measurement Under Execution
• Time Displayed : Status of Cycle Time Measurement Completed

[Note]
• Measurement keeps executed unless the execution of the step with E displayed in Column T is 

completed.
• In case setting is established in an area section that is looped in short period of time, it could seem as if -

----.---s is kept displayed because measurement will start straight after the previous measurement is 
finished.

• In case of a program being stopped by breakpoint / pause, the stop duration should be included to the 
cycle time.

• In case the steps with S and E displayed are set to the input / extension status, cycle time will be 
measured when input / extension status has been succeeded.

• In case the step with S displayed is set to the breakpoint, measurement will start once the program is 
executed.

• The maximum time to be display should be 86399.999sec (one day). Also, when the cycle time exceeds 
4294967.295sec, the cycle time measurement result will not be displayed correctly.

Measurement Result Display Area
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[2] Displaying Cycle Time Measurement Result
Once a program gets operated, cycle time will be measured and the result will be displayed at the 
position marked in red.

Once the program starts executed and the step with “S” being shown gets executed, measurement
will start and display shows -----.---s.
Once the step with “E” being shown is completed, the measurement will finish and the cycle time 
measurement result will be displayed.
The time to be shown should be from 0.000sec to 86399.999sec (one day).

Once the first measurement is completed and the step with “S” being shown has been executed, 
measurement will start again and -----.---s will be displayed.
If a change is made to the cycle time measurement area section after measurement is finished, the 
display will turn to blank.

Fig. 4. 32 Measurement Result Display

• Blank : Status of Cycle Time Measurement Not Executed
• -----.--- Displayed : Status of Cycle Time Measurement Under Execution
• Time Displayed : Status of Cycle Time Measurement Completed

[Note]
• Measurement keeps executed unless the execution of the step with E displayed in Column T is 

completed.
• In case setting is established in an area section that is looped in short period of time, it could seem as if -

----.---s is kept displayed because measurement will start straight after the previous measurement is 
finished.

• In case of a program being stopped by breakpoint / pause, the stop duration should be included to the 
cycle time.

• In case the steps with S and E displayed are set to the input / extension status, cycle time will be 
measured when input / extension status has been succeeded.

• In case the step with S displayed is set to the breakpoint, measurement will start once the program is 
executed.

• The maximum time to be display should be 86399.999sec (one day). Also, when the cycle time exceeds 
4294967.295sec, the cycle time measurement result will not be displayed correctly.

Measurement Result Display Area

ME0398-6E 77

Program number to copy/move from

Program number to copy/move to

5. Copying/Moving/Clearing a Program
5.1 Program Copy/Move Window

The steps to copy or move a program to other program number are explained below. 
(1)  Click Program (S) from the menu bar, and then select Copy/Move (C). 
(2) The program copy/move window will open.

Fig. 5.1 Program Copy/Move
Double-click the source program you want to copy or move.
Click the destination program you want to copy or move the source program to.

To copy the program, click Copy. To move the program, click Move. 
Both operations are done in the memory. 
Clicking Cancel will cancel the selected operation. 

* It is available to copy, move and delete the local symbols in the applicable programs when conducting 
copy, move or delete of programs.
The following message should be displayed when conducting copy, move or delete of programs.
Click Yes and copy, move or delete of the local symbols in the applicable programs should be 
executed.

Fig. 5.2 Confirmation Message (copy)             Fig. 5.2 Confirmation Message (move)

Fig. 5.2 Confirmation Message (clear)
(Note) When copy or move of the local symbols are conducted, all the local symbols saved in the 

program number of destination should all be cleared.
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(3) Writing to the flash ROM
When the copy or move is completed, the following confirmation dialog box with the message, 
“Write Flash ROM?” will be displayed.

Fig. 5.3 Confirmation

Click and select a desired item (Program, etc.) to write to the flash ROM. 
 Click Yes → The memory data will be written to the flash ROM. 
 Click No → The memory data will not be written to the flash ROM.

Once the controller is reset (the controller power is reconnected or a software reset 
is executed), the original program arrangement before the copy or move will be 
restored. 

* The number of writing to the flash ROM is limited. (approx. 100,000 times) 
If you do not want to write all the data to the flash ROM, select “Write the selection data area.” 
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(3) Writing to the flash ROM
When the copy or move is completed, the following confirmation dialog box with the message, 
“Write Flash ROM?” will be displayed.

Fig. 5.3 Confirmation

Click and select a desired item (Program, etc.) to write to the flash ROM. 
 Click Yes → The memory data will be written to the flash ROM. 
 Click No → The memory data will not be written to the flash ROM.

Once the controller is reset (the controller power is reconnected or a software reset 
is executed), the original program arrangement before the copy or move will be 
restored. 

* The number of writing to the flash ROM is limited. (approx. 100,000 times) 
If you do not want to write all the data to the flash ROM, select “Write the selection data area.” 
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5.2 Program Clear Window

The steps to clear a program are explained below. 
(1) Click Program (S) from the menu bar, and then select Clear (L). 
(2) The program clear window will open.

Fig. 5.4 Program Clear

Click the program you want to clear. 
You can select multiple programs by dragging the mouse or pressing the Ctrl key and ↑↓ key 
simultaneously. 
Next, click Clear. 
(This operation is done in the memory.)  
Clicking Cancel will cancel the operation. 
When clearing all programs in the controller, click All Clear. 

(3) Writing to the flash ROM 
When the clear is completed, the following confirmation dialog box with the message, “Write Flash 
ROM?” will be displayed.
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Fig. 5.5 Confirmation

Click and select a desired item (Program, etc.) to write to the flash ROM. 
 Click Yes → The memory data will be written to the flash ROM. 
 Click No → The memory data will not be written to the flash ROM.

Once the controller is reset (the controller power is reconnected or a software reset 
is executed), the cleared program will be restored. 
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Fig. 5.5 Confirmation

Click and select a desired item (Program, etc.) to write to the flash ROM. 
 Click Yes → The memory data will be written to the flash ROM. 
 Click No → The memory data will not be written to the flash ROM.

Once the controller is reset (the controller power is reconnected or a software reset 
is executed), the cleared program will be restored. 

ME0398-6E 81

6. Position Data Edit Window
6.1 Explanation of the Items Displayed in the Position Data Edit Window

(1) Click Position (O) from the menu bar, and then select Edit (E). 
(2) The position data window (Edit Position Data) will open.

This window has the following controls and fields.
The position edit window should differ for a controller for the 6-axis cartesian robot and a controller 
not for the 6-axis cartesian robot. 

The position edit range select window should appear.
Set the number of the position data to be displayed in the position edit window in the section of 2.
The section of 1 should be displayed when the axes group numbers are divided into two groups.
The position data is to be edited in the unit of axes group.
Select Axes Group No. 1 and No. 2 targeted for edit. (Multiple select available)
Click Edit. 

Fig. 6.1 Position Edit Range Select

(1) Position data  (2) Common buttons  (3) Axis-specific buttons        (4) Setting functions

Fig. 6.2 Position Data Edit (When not 6-axis cartesian robot) 

(Note) Position of synchronized slave is not available for edit.

Displayed only when
Axes Group No. 2 
activated
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(6) Axis-specific button/setting functions/movement setting display axis switching

(1) Position data

Fig. 6.3 Position data (When not 6-axis cartesian robot) 

(1) Position data  (2) Common buttons (3) Axis-specific buttons (4) Setting functions (5) Move Setting

Fig. 6.4 Position Data Edit (For 6-axis cartesian robot) 
(1) Position data

Fig. 6.5 Position data (For 6-axis cartesian robot) 

(6) Position Output Operation Data

(6) Position Output Operation Data
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(6) Axis-specific button/setting functions/movement setting display axis switching

(1) Position data

Fig. 6.3 Position data (When not 6-axis cartesian robot) 

(1) Position data  (2) Common buttons (3) Axis-specific buttons (4) Setting functions (5) Move Setting

Fig. 6.4 Position Data Edit (For 6-axis cartesian robot) 
(1) Position data

Fig. 6.5 Position data (For 6-axis cartesian robot) 

(6) Position Output Operation Data

(6) Position Output Operation Data
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No. (Name)  
The position number and corresponding symbol are displayed. 
You can press the F11 key to open the symbol edit window where you can edit the symbol 
assigned to the applicable position number. Pressing the F11 key on the symbol edit window will
return the input focus to the applicable position data in the edit window. 
* You can press the F11 key to return the input focus from the symbol edit window to the position 

data edit window only when the position data edit window is currently open. 
* To show or hide symbols, do so in the Environment Setup window accessible from Tool.

(For the switching method, refer to [12. Tool]) 

Type
It should be displayed for 6-axis cartesian robot. 
Set the coordinate systems for positions (from Axis 1 to Axis 6).
Rect: Rectangular coordinate system, Joint: Each axis coordinate system
Joint is to be selected when selection is skipped.

Axis 1 to 8 
Specify each desired position for Axis 1 to Axis 8. 
For 6-axis cartesian robot, set the coordinate systems below in the order from Axis 1.

[Rectangular coordinate] 
X-axis [mm], Y-axis [mm], Z-axis [mm], Rx-axis [deg], Ry-axis [deg], Rz-axis [deg]

[Each Axis Coordinate] 
C1-axis [mm], C2-axis [mm], C3-axis[mm], R-axis [deg], B-axis [deg], T-axis [deg]
Indicate the positions of the added axes in Axis 7 and 8.

Wrist
It should be displayed for 6-axis cartesian robot. 
Set the posture of the wrist.
Flip: Facing Upward, NonFlip: Facing Downward
It is available for setting only when the type is Rect (rectangular coordinate system).
Movement made with the current wrist posture if selection is skipped.

Vel
Specify a desired speed. 
Available range is from 1 to 9999.

Acc
Specify a desired acceleration. 
Available range is from 0.01 to 9.99. 

Dcl
Specify a desired deceleration. 
Available range is from 0.01 to 9.99.

Comment
Enter comment, if necessary (using up to 32 single-byte characters/16 double-byte characters). 
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In the position edit window, clicking Edit (E) from the menu bar and then selecting Undo (U) can cancel 
the most recent 10 operations.
Alternatively, pressing the Ctrl key and Z key simultaneously can cancel the operations. 
However, the cancel function will become disabled when any of the following operations is performed: 
 Transfer of data on the edit screen to the controller 
 Saving data on the edit screen to a file 
 Closing of the edit screen 

When this operation is performed, the warning screen in Fig. 6.6 will be displayed. 
Clicking Yes will cancel the operation executed immediately before.

Fig. 6.6 Warning

(2) Common buttons

Fig. 6.7 Common Buttons

Save to File
Clicking this button will open a dialog box where you can save the position data to a file under a 
desired name.

Transfer to Controller
Clicking this button will transfer the position data to the controller. 

Refresh Position Data
After a program that rewrites position data has been run, click this button to refresh the position 
data display. 

Print
Clicking this button will print the position data. 
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In the position edit window, clicking Edit (E) from the menu bar and then selecting Undo (U) can cancel 
the most recent 10 operations.
Alternatively, pressing the Ctrl key and Z key simultaneously can cancel the operations. 
However, the cancel function will become disabled when any of the following operations is performed: 
 Transfer of data on the edit screen to the controller 
 Saving data on the edit screen to a file 
 Closing of the edit screen 

When this operation is performed, the warning screen in Fig. 6.6 will be displayed. 
Clicking Yes will cancel the operation executed immediately before.

Fig. 6.6 Warning

(2) Common buttons

Fig. 6.7 Common Buttons

Save to File
Clicking this button will open a dialog box where you can save the position data to a file under a 
desired name.

Transfer to Controller
Clicking this button will transfer the position data to the controller. 

Refresh Position Data
After a program that rewrites position data has been run, click this button to refresh the position 
data display. 

Print
Clicking this button will print the position data. 
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Capture Current Position
Clicking this button will capture the current position into the position number corresponding to the 
cursor position for all axes indicated by. (The captured position is not yet transferred to the 
controller.)  

Fig. 6.8 Current Position Load Setting Screen
(Left: When Rect selected, Right: When Joint selected)

Jog –   
The axes specified as the ones to be operated by the common buttons and whose servo is ON will 
jog backward while this button is pressed. However, axis specification has limitations.

Jog +   
Axes specified as the ones to be operated by the common buttons and whose servo is ON will jog 
forward while this button is pressed. However, axis specification has limitations.
 6-axis cartesian robot

Orthogonal 6-axis robots cannot jog multiple axes at the same time. You can jog one axis at a 
time.

 Added axes
Orthogonal axes can be selected simultaneously for simultaneous jog movement. 

Move
Clicking this button will move all axes indicated by     to the position of the position number 
corresponding to the cursor position.

* If there is changed position data, transfer the data to the controller first. 

Move Continuously
Clicking this button will move all axes indicated by to the position of the position number 
corresponding to the cursor position. Thereafter, each axis will continue to move to the position set 
by the data in next position number. 

*  If any of the applicable position data has been changed, transfer the latest position data to the 
controller first.
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Stop All Axes  
Clicking this button will stop all axes currently moving.

If a checkmark is placed in the checkbox of this button, the axis-
specific button/setting screen (Fig. 6.2) will be displayed. If the 
checkmark is not placed, the position data will only be displayed.

Fig. 6.9 Screen of Position Data Only
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Stop All Axes  
Clicking this button will stop all axes currently moving.

If a checkmark is placed in the checkbox of this button, the axis-
specific button/setting screen (Fig. 6.2) will be displayed. If the 
checkmark is not placed, the position data will only be displayed.

Fig. 6.9 Screen of Position Data Only
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(3) Axis-specific buttons (Orthogonal axis)

Fig. 6.10 Axis-specific Button (Added axes Axis 7 and Axis 8 for 6-axis cartesian robot)

Fig. 6.11 Axis-specific Button (Axis 1 to Axis 6 for 6-axis cartesian robot)

Clicking this button will turn the servo of the selected axis OFF if it is currently ON, or turn the 
axis servo ON if it is currently OFF.
(The button is text shown in light blue when the servo is ON.)

Clicking this button will perform homing if the servo of the selected axis is ON. 
(The button text will be shown in light blue after homing.)
(Note) Axes from Axis 1 to Axis 6 of the 6-axis cartesian robot should not be displayed.

Clicking this button will move the selected axis to the position specified by the data in the 
position number corresponding to the cursor position, if the axis servo is ON. 
(The button text remains yellow while the axis is moving.)

The selected axis will jog forward while this button is clicked, if the axis servo is ON. 
If a value (0.001 to 1) is enter red in the Inc. field in the setting function group, the axis will 
perform inching. In this case, one click will move the axis by one inching distance. 

The selected axis will jog backward while this button is clicked, if the axis servo is ON. 
If a value (0.001 to 1) is entered in the Inc. field in the setting function group, the axis will 
perform inching. In this case, one click will move the axis by one inching distance.

Clicking this button will capture the current position of the selected axis into the position 
number corresponding to the cursor position. 
(The captured position is not yet transferred to the controller.)

(Note) In the case of the 6-axis cartesian robot, there is no “TP” button.
To load the current position, click the current position load button (    ) among the 
common buttons in [2] and [3].

Axis number

The axis you want to move
using the common buttons

Current position of the selected axis

Select the axis to be operated 
with the common buttons.

Error code

Current position of the selected axis

Axis number

click the current position load button (    ) among the 
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(4) Setting functions 

Set the velocity (Vel), acceleration (Acc), deceleration (Dcl) and inching distance 
(Inc.) to be used when the actuator is operated using the various buttons. If a value 
is entered in any of the Vel, Acc and Dcl fields in the position data area, the value 
in the applicable position data field will be given priority for movement to the 
corresponding position number.
The maximum settings for Vel (Velocity), Acc (Acceleration) and Dcl (Deceleration) 
are as stated below:
 Velocity : 250 mm/sec

Fig. 6.12 * The maximum setting values for acceleration and deceleration should be 9.99G.
Settings of Velocity,
Acceleration,
Deceleration and
Inching Distance
(When not 6-axis 
cartesian robot)

Fig. 6.13 Setting functions (For 6-axis cartesian robot)

Fig. 6.14 Jog Buttons

These jog buttons can also be used to jog those axes that have not yet completed homing. However, 
coordinate values have no meaning for these axes, so pay due attention to avoid contact with the stroke 
end. If a value (0.001 to 1) is entered in the Inc. field in the setting function group, the jog buttons will 
function as inching buttons.
The operation should be as shown below for those except for the 6-axis cartesian robot.
Continue to click an inching button will change the operation to jogging. Specifically, the axis will start 
jogging approx. 1.6 second after the inching button is clicked. If the button is held continuously, the 
jogging velocity will change approx. every second thereafter in the order of 1 → 10 → 30 → 50 → 100 
[mm/sec].

Caution: Operating any selectable jog button for an operating axis will jog the axis, and the 
axis will stop once the button is released. (If the next operation command is input, the 
axis will perform the specified operation.)
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(4) Setting functions 

Set the velocity (Vel), acceleration (Acc), deceleration (Dcl) and inching distance 
(Inc.) to be used when the actuator is operated using the various buttons. If a value 
is entered in any of the Vel, Acc and Dcl fields in the position data area, the value 
in the applicable position data field will be given priority for movement to the 
corresponding position number.
The maximum settings for Vel (Velocity), Acc (Acceleration) and Dcl (Deceleration) 
are as stated below:
 Velocity : 250 mm/sec

Fig. 6.12 * The maximum setting values for acceleration and deceleration should be 9.99G.
Settings of Velocity,
Acceleration,
Deceleration and
Inching Distance
(When not 6-axis 
cartesian robot)

Fig. 6.13 Setting functions (For 6-axis cartesian robot)

Fig. 6.14 Jog Buttons

These jog buttons can also be used to jog those axes that have not yet completed homing. However, 
coordinate values have no meaning for these axes, so pay due attention to avoid contact with the stroke 
end. If a value (0.001 to 1) is entered in the Inc. field in the setting function group, the jog buttons will 
function as inching buttons.
The operation should be as shown below for those except for the 6-axis cartesian robot.
Continue to click an inching button will change the operation to jogging. Specifically, the axis will start 
jogging approx. 1.6 second after the inching button is clicked. If the button is held continuously, the 
jogging velocity will change approx. every second thereafter in the order of 1 → 10 → 30 → 50 → 100 
[mm/sec].

Caution: Operating any selectable jog button for an operating axis will jog the axis, and the 
axis will stop once the button is released. (If the next operation command is input, the 
axis will perform the specified operation.)
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(5) Movement Selection 
Establish the setting for [Current Wrist Posture], [JOG Coordinate System], [Work Coordinate System 
Select Number] and [Tool Coordinate System Select Number] in each button.

Fig. 6.15 Selection of Current Wrist Posture and Each Coordinate System

Current Wrist Posture
The current wrist posture (Flip / NonFlip) should be displayed.

Fig. 6.16 Selection of Current Wrist Posture

Jog movement coordinate sys. 
The coordinate system can be changed by clicking ▼. 
Orthogonal(work) coordinate system (Can be offset using Work Coordinate System Selection No.) 
Orthogonal(tool) coordinate system
Each axis coordinate system

Fig. 6.17 Selection of Jog Movement Coordinate System

Work coord sys slct No.
A desired work coordinate system selection No. can be selected by clicking Change. 

Fig. 6.18 Selection of Work Coordinate System

Tool coord sys slct No.
A desired tool coordinate system selection No. can be selected by clicking Change. 

Fig. 6.19 Selection of Tool Coordinate System

The current wrist posture (Flip / NonFlip) should be displayed.
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(6) Axis-specific button/setting function/movement selection display axis switching 

Fig. 6.20 Axis-specific Button/Setting Function/Movement Selection Display Axis Switching. 

Switch the axes displayed in the axis-specific button, setting function and movement selection areas. 

Axis1-8: Display the axis-specific buttons, setting functions and movement selections of all effective 
axes.
(This item is displayed only when Axis 7 or later is an activated axis in the 6-axis cartesian 
robot.) 

Axis1-6: It should display the axis-specific buttons, setting functions and movement selections only for 
the 6-axis cartesian robot (Axis 1 to 6).
(This item is displayed only when the 6-axis cartesian robot (Axis 1 to 6) is an activated axis.) 

Axis7-8: It should display the axis-specific buttons, setting functions and movement selections only for 
added axes (Axis 7 to 8) of the 6-axis cartesian robot. 
(This item is displayed only when Axis 7 or later is an activated axis in the 6-axis cartesian 
robot.) 

(7) Position output operation data

Fig. 6.21 Position Output Operation Data
OutFn

Set the output function code.
There are two ways to establish setting. Without setting, the output operation will be invalid.
(1) Bring the cursor to the setting position and click to show the output function code list.

Select in the list from ON, OFF, etc.
(2) Input a number from 1 to 6 that is applicable as an output function from the table below.

As shown below, the display will be on if 1 is selected for example.
Output Function Code Numerical Setting Display

Turns ON after movement 1 ON
Turns OFF after movement 2 OFF
Turns ON after passed specified distance 3 OND
Turns OFF after passed specified distance 4 OFFD
Turns ON after passed specified ratio 5 ONR
Turns OFF after passed specified ratio 6 OFFR

[Output Function Code]
• Turns ON/OFF after movement: 

It turns ON/OFF the specified output ports and flags after moved to the applicable position.
• Turns ON/OFF after passed specified distance: 

It turns ON/OFF the output ports and flags at the position where proceeded from the 
movement start position for the distance specified in Function Parameter 1 during 
movement to the applicable position.

• Turns ON/OFF after passed specified ratio: 
It turns ON/OFF the output ports and flags at the position where proceeded from the 
movement start position for the ratio specified in Function Parameter 1 to the whole 
movement mount during movement to the applicable position.
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(6) Axis-specific button/setting function/movement selection display axis switching 

Fig. 6.20 Axis-specific Button/Setting Function/Movement Selection Display Axis Switching. 

Switch the axes displayed in the axis-specific button, setting function and movement selection areas. 

Axis1-8: Display the axis-specific buttons, setting functions and movement selections of all effective 
axes.
(This item is displayed only when Axis 7 or later is an activated axis in the 6-axis cartesian 
robot.) 

Axis1-6: It should display the axis-specific buttons, setting functions and movement selections only for 
the 6-axis cartesian robot (Axis 1 to 6).
(This item is displayed only when the 6-axis cartesian robot (Axis 1 to 6) is an activated axis.) 

Axis7-8: It should display the axis-specific buttons, setting functions and movement selections only for 
added axes (Axis 7 to 8) of the 6-axis cartesian robot. 
(This item is displayed only when Axis 7 or later is an activated axis in the 6-axis cartesian 
robot.) 

(7) Position output operation data

Fig. 6.21 Position Output Operation Data
OutFn

Set the output function code.
There are two ways to establish setting. Without setting, the output operation will be invalid.
(1) Bring the cursor to the setting position and click to show the output function code list.

Select in the list from ON, OFF, etc.
(2) Input a number from 1 to 6 that is applicable as an output function from the table below.

As shown below, the display will be on if 1 is selected for example.
Output Function Code Numerical Setting Display

Turns ON after movement 1 ON
Turns OFF after movement 2 OFF
Turns ON after passed specified distance 3 OND
Turns OFF after passed specified distance 4 OFFD
Turns ON after passed specified ratio 5 ONR
Turns OFF after passed specified ratio 6 OFFR

[Output Function Code]
• Turns ON/OFF after movement: 

It turns ON/OFF the specified output ports and flags after moved to the applicable position.
• Turns ON/OFF after passed specified distance: 

It turns ON/OFF the output ports and flags at the position where proceeded from the 
movement start position for the distance specified in Function Parameter 1 during 
movement to the applicable position.

• Turns ON/OFF after passed specified ratio: 
It turns ON/OFF the output ports and flags at the position where proceeded from the 
movement start position for the ratio specified in Function Parameter 1 to the whole 
movement mount during movement to the applicable position.
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OutNo.
Set the output ports and flags applicable for operation.

OutPara1
Set the parameters defined for each output function.

OutPara2
One-shot pulse will be output if output pulse timer time is set.

Settings for Each Output Function
Output Function Code Name Function Parameter 1 Function Parameter 2

Turns ON after movement Output Delay Timer Time
(0.000 to 999.999 second) 

Output Pulse Timer Time
(0.000 to 999.999 second) Turns OFF after movement

Turns ON after passed specified 
distance Output Operation Specified 

Distance
(0.000 to 9999.999mm) 

Output Pulse Timer Time
(0.000 to 999.999 second) Turns OFF after passed specified 

distance
Turns ON after passed specified 
ratio Output Operation Specified 

Ratio
(0.000 to 100.000%) 

Output Pulse Timer Time
(0.000 to 999.999 second) Turns OFF after passed specified 

ratio
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2) User specified output port position

1) User specified output port display

 Display of Output Port
Output port can be displayed on position edit window.
To show the display, it is necessary to establish the following parameter settings.

I/O Parameter Name Setting Details 

No.74 Number of Use of PC/TP User 
Output Ports (such as hand)

Set the number of output ports to be displayed 
on the position edit window.

No.75 PC/TP User Output Port Start 
Number (such as hand)

Set the output port start number.
With this number as the start number, ports are 
displayed in a row for the number set in No. 74.
(Note) The display will not be shown if a number 

out of the output ports is set. An error will 
also not be shown.

(Note) Virtual output port number can be set in No. 75 to show on the display.

Fig. 6.22 User Specified Output Port Display

1) User Indicated Output Port Display
It shows the user indicated output port. It displays on the position edit window the same condition as 1 
(ON) and 0 (OFF) displayed on the monitor output port window.
It is on when the light is ON, and OFF when the light is off.

When a check mark is put to the following in the configuration of the tool, not only the output ports such as 
300, but also the symbols defined in the symbol edit window will be displayed.
● Display symbol names to variable monitor, I/O port monitor, flag monitor and position edit window

Refer to [9. Symbol Edit and 13. Tools] 

2) User Specified Output Port Position
You can choose where around the position data you would like to display the user indicated output port.
Selection can be made from ‘Top’, ‘Bottom’, ‘Left’ and ‘Right’.
Also, by selecting “None”, display can be disappeared.
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(ON) and 0 (OFF) displayed on the monitor output port window.
It is on when the light is ON, and OFF when the light is off.

When a check mark is put to the following in the configuration of the tool, not only the output ports such as 
300, but also the symbols defined in the symbol edit window will be displayed.
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Refer to [9. Symbol Edit and 13. Tools] 

2) User Specified Output Port Position
You can choose where around the position data you would like to display the user indicated output port.
Selection can be made from ‘Top’, ‘Bottom’, ‘Left’ and ‘Right’.
Also, by selecting “None”, display can be disappeared.
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6.2 Saving Position Data, Transferring and Closing the Edit Window

6.2.1 Saving a Program Online, Transferring and Closing the Edit Window
(1) Saving to a file the position data you are editing

Click Save to File in the position edit window.
This is the same as clicking File and then selecting Save As. 
After clicking Save to File, File Save Select screen will be displayed.

When Axes Group No. 2 is activated, the position data in Axes Group No. 1 and 2 can be saved in one 
file.
When Axes Group No. 2 is activated, select “Position (O)” → “Save to File (S)” in the menu and the 
window shown below should appear.

Fig. 6.23 Position data save

“Save position data for all axes groups”
The position data in Axes Group No. 1 and 2 should be saved in one file at once.

“Save position data for specified axis group”
An individual position data file of the axes group number selected in 1 should be saved.
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If you open the consolidated saved file, the window shown below should come out.

Fig. 6.24 Batch selection

Transfer to Controller
The position data of the axes group number selected in 1 should be transferred to the controller. The 
transfer position range is to be set in Window 1.

Read 
The axes group number selected in 1 can be read in and the position edit window (offline edit) can be 
displayed.

Print
The axes group number selected in 1 can be printed out.

* Multiple axes group numbers can be selected.
Click Select All and all the axes groups displayed in the window can be selected.
Click Release All and the select of all the axes groups displayed in the window can be released.

Click Transfer to Controller in the position edit window (offline edit), and the window shown below should
come up.

Fig. 6.25 Position data transfer

Set the axes group number to transfer the data to in 1 and set the position number range to transfer in 2, 
and click Transfer to Controller. 
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and click Transfer to Controller. 
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(2) Transferring to the controller the position data you are editing
Click Transfer to Controller in the position edit window.
The position data you are editing will be saved to the controller’s memory.
This button is selectable only in the online edit mode.

 Error/warning display before data transfer 

When transferring position data to the controller, the position data to be transferred is checked for 
problems and if any of the data cannot be transferred (due to excessive speed, acceleration, 
deceleration, etc.), applicable errors/warnings are displayed in a list. 

Fig. 6.26 Position Data Error List 

If an error is found in the position data to be transferred, the position data will not be transferred. 
If the position data to be transferred only generates a warning, the warning screen appears. 

Fig. 6.27 Warning Screen

Click Yes to transfer the position data. 
Click No to cancel the transfer of position data. 

(Note) The maximum number of errors/warnings displayed in the position error list is set on the 
Environment Setup screen. Refer to [13. Tool Environment Setup Screen].  

Select the "Show errors only"
check box to show only errors.

Click Hide in the pop-up 
menu to hide the error list.
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(3) Writing to the flash ROM 
Once the position has been transferred to the controller, the following confirmation dialog box with the 
message, “Write Flash ROM?” will be displayed.

Fig. 6.28 Confirmation

Click and select a desired item (Position, etc.) to write to the flash ROM.
Click Yes→ The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 

Comment data for Position No. 10001 and later also can be transferred.
However, the number of the position comments available to save is 10000 for the total of all the axes 
groups.
The number of position comments available to transfer can be confirmed in the main window.

Fig. 6.29 Display for Number of Remaining Position Comments

(4) Closing the position data edit window
Attempting to close the position data edit window will open the following confirmation dialog box with the 
message, “Save edited data in the Controller?” 

Fig. 6.30 Confirmation

Yes  The edited data will be transferred to the controller → (3), “Writing to the flash ROM”  
No    The software will close the point edit window without saving the edited data.
Cancel The software will cancel the operation and return to the position edit window.



6. Position D
ata Edit W

indow

96 ME0398-6E 

(3) Writing to the flash ROM 
Once the position has been transferred to the controller, the following confirmation dialog box with the 
message, “Write Flash ROM?” will be displayed.

Fig. 6.28 Confirmation

Click and select a desired item (Position, etc.) to write to the flash ROM.
Click Yes→ The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 

Comment data for Position No. 10001 and later also can be transferred.
However, the number of the position comments available to save is 10000 for the total of all the axes 
groups.
The number of position comments available to transfer can be confirmed in the main window.

Fig. 6.29 Display for Number of Remaining Position Comments

(4) Closing the position data edit window
Attempting to close the position data edit window will open the following confirmation dialog box with the 
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Yes  The edited data will be transferred to the controller → (3), “Writing to the flash ROM”  
No    The software will close the point edit window without saving the edited data.
Cancel The software will cancel the operation and return to the position edit window.
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6.2.2 Transferring a Position Created Offline
A position created offline can be transferred to a controller by following the steps below.

(1) Select File → Open from the menu.
In the screen of “Open File”, select a position created offline and open it.

(2) If a controller is connected, Controller Transfer button    gets activated once the position is opened.
Press Controller Transfer button     , the position gets transferred to the controller.

Fig. 6.31 Position Edit Screen

(3) A confirmation screen asking if it is okay to transfer the data to the controller will appear.
Press Yes. 

Fig.6.32 Confirmation Screen



6.
 P

os
iti

on
 D

at
a 

Ed
it 

W
in

do
w

98 ME0398-6E 

(4) Next, a screen to select the position number for destination will be shown.
Select the axes group number and also numbers to indicate transfer from what number to what number 
of the positions to be performed.
Press OK.

Fig.6.33 Position No. Select

(5) A confirmation screen stating “Write Flash ROM” will appear.
Press Yes.

Fig.6.34 Confirmation Screen

(6) The position will be transferred to the controller.
Also, flash ROM writing will be conducted, and the display below flashes during writing.
The display will disappear once writing is complete.

Fig.6.35 Writing Flash ROM Screen
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7. Copying/Moving/Clearing Position Data
7.1 Copying/Moving Position Data

(1)  Click Position (O) from the menu bar, and then select Copy/Move (C). 

(2) The position data copy/move window (Copy/Move Position Data) will open. 

Copying position data: In Source to Copy/Move, specify the Top No. and Last No. of the position 
range you want to copy or move. 
Then, click Copy. 

The positions specified in Source to Copy/Move will be copied to the 
positions specified in Destination to Copy/Move. 

Moving position data: Click Move. 
The positions specified in Source to Copy/Move will move to the 
positions specified in Destination to Copy/Move.

Fig. 7.1 Position Data Copy/Move
* Clicking Cancel will cancel the selected operation.

(3) Writing to the flash ROM
When the copy or move is completed, the following confirmation dialog box with the message, “Write 
Flash ROM?” will be displayed.

Fig. 7.2 Confirmation

Click and select a desired item (Position, etc.) to write to the flash ROM.
Click Yes → The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 
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7.2 Clearing Position Data

(1)  Click Position (O) from the menu bar, and then select Clear (L). 
(2)  The position data clear window (Clear Position Data) will open.

Fig. 7.3 Clear Position Data

In Clear Scope, specify the Top No. and Last No. of the position range you want to clear.
Then, click Clear. 
Clicking Cancel will cancel the operation.

(3) Writing to the flash ROM
When the clear is completed, the following confirmation dialog box with the message, “Write Flash 
ROM?” will be displayed.

Fig. 7.4 Confirmation

Click and select a desired item (Position, etc.) to write to the flash ROM.
Click Yes → The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 
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Click and select a desired item (Position, etc.) to write to the flash ROM.
Click Yes → The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 
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8. Parameter Edit Window
8.1 Explanation of the Parameter Edit Window

(1)  Click Parameter (P) from the menu bar, and then select Edit (E). 
(2)  The parameter edit window (Edit Parameter) will open.

You can select a desired parameter and change the value.
Values that are grayed out are read-only and cannot be changed.

Save to File
Clicking this button will open a dialog box where you can save the parameter data to a file under a 
desired name. 

Transfer to Controller
Clicking this button will transfer the parameter data to the controller. 

Print
Clicking this button will print the parameter data.

Click this button and you can conduct Easy Parameter Setup. 

Fig. 8.1 Parameter Edit

* The above window shows Axis group parameters. You can display other parameters by clicking each 
category tab.

In the parameter edit window, clicking Edit (E) from the menu bar and then selecting Undo (U) can 
cancel up to the most recent 10 input operations. 
Alternatively, pressing the Ctrl key and Z key simultaneously can cancel the operations. 
However, the cancel function will become disabled when any of the following operations is performed: 
 Transfer of data on the edit screen to the controller 
 Saving data on the edit screen to a file 
 Closing of the edit screen

When this operation is performed, the warning screen in Fig. 8.2 will be displayed. 
Clicking Yes will cancel the operation executed immediately before.

Fig. 8.2 Warning
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8.2 Saving Parameter Data and Closing the Edit Window

(1) Saving to a file the parameter data you are editing 
Click Save to File in the parameter edit window.
This is the same as clicking File (F) and then selecting Save As (A). 

(2) Transferring to the controller the parameter data you are editing
You can save the parameter data you are editing to the controller’s memory. 
Click Transfer to Controller in the parameter edit window. 

(3) Writing to the flash ROM 
Once the parameter has been transferred to the controller, the following confirmation dialog box with the 
message, “Write Flash ROM?” will be displayed.

Fig. 8.3 Confirmation

Click and select a desired item (Parameter, etc.) to write to the flash ROM.
Click Yes → The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 

If No is selected, the controller will clear all data in its memory after a reset (i.e., after the 
controller power is reconnected or a software reset is executed), and then load the data 
from the flash ROM.
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Click and select a desired item (Parameter, etc.) to write to the flash ROM.
Click Yes → The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 

If No is selected, the controller will clear all data in its memory after a reset (i.e., after the 
controller power is reconnected or a software reset is executed), and then load the data 
from the flash ROM.
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(4) Restarting the controller (software reset) 
After the data has been written to the flash ROM, the following confirmation dialog box with the
message, “Restart the controller” will be displayed. 

Yes The new parameters will become effective.
No  The new parameters will not become effective.

The parameters will become effective after the controller is restarted (software reset) or the 
controller power is reconnected.

Fig. 8.4 Confirmation

(5) Closing the parameter edit window 
Attempting to close the parameter edit window will display the following confirmation dialog box with the 
message, “Save edited data in the Controller?” 

Fig. 8.5 Confirmation

Yes    The edited data will be transferred to the controller → (3), “Writing to the flash ROM” 
No     The software will close the parameter edit window without saving the edited data.
Cancel  The software will not close and go back to the parameter edit window.

• The user of the PC software is recommended to back up the parameters when the controller is 
delivered and also when the system into which the controller has been assembled is started. 
* There are many customizable parameters. It is recommended that you back up the parameters 

frequently just like you do the programs.
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8.3 Transferring a Parameter File

Pay attention to parameter categories when transferring parameter data files to the controller. The 
controller is shipped with its axis-related parameters set, for each axis, to values appropriate for the type 
of the actuator connected. 
The axis-specific related parameters are axis / actuator / driver unit.
Exercise caution when using an existing file containing customized parameters. 

Caution: If parameter data is lost during parameter writing to the flash ROM due to main power 
OFF or any other factor, all parameters will be rewritten to initial values.

8.3.1 Selecting Categories of Parameters to Be Transferred
(1) Select “Open” from the “File menu” or click corresponding in the toolbar. In the file selection dialog box, 

select the parameter file (extension: .xpm) you want to transfer to the controller. Load the file into the PC 
software and open the parameter edit window. 

(2) Click Transfer to Controller in the parameter edit window. 

(3) The Select Parameter Category window (Fig. 8.6) will be displayed.

Fig. 8.6 Select Parameter Category Window

[1] Basic Parameter Category 
Click the checkbox corresponding to each category of parameters you want to transfer, and click OK. 
(the clicked checkbox will be selected). Only the parameters of the selected category or categories 
will be transferred to the controller. 

[2] Write the parameters to the controller according to steps 8.2 (3) to (5).
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8.4 Easy Parameter Setup

(1) Click Easy Parameter Setup in Edit Parameter window. 
Or, select Parameter → Easy Parameter Setup from the menu.

Fig. 8.7 Edit Parameter Window

Fig. 8.8 Menu Command

(2) The top menu of Easy Parameter Setup appears.
Click on a button for a feature of which you would like to set up or change the parameter.

Fig. 8.9 Easy Parameter Setup Top Menu

(Note) Fieldbus may be replaced with a network name that is equipped to a controller.
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(3) For example, if you click RS-232C, the setup window for RS-232C will appear.
Set up or change the parameters.

Fig. 8.10 Example for Setup Window (RS-232C)

(4) After setting up or changing the parameters, click Transmit to Controller  and the setup change data 
gets transmitted to the controller and the setup window closes.
Once the setup window is finished, close the top menu of Easy Parameter Setup window, and the 
confirmation for flash ROM writing of parameters will be displayed. Once the flash ROM writing is 
complete, the controller will get rebooted.

(Note) Transmit to Controller is displayed when Easy Parameter Setup is clicked during online edit 
(controller edit) of parameters, or “Parameter” → “Easy Parameter Setting” is selected in the menu.

(Note) If editing the parameters saved in the PC offline and clicking Easy Parameter Setup, Transmit to
Controller in the setup window changes to Reflect to Edit Parameter Window. 
Click Reflect to Edit Parameter Window, and the settings and changes conducted in Easy 
Parameter Setup will be reflected (changed) to the setting values in the Edit Parameter window. 
(But, controller transmission will not be executed.)
As parameters will not be transmitted to the controller, close the top menu of Easy Parameter 
Setup window, go to Edit Parameter window to save the parameter file and transmit the data to the 
controller.

(Note) If there is data in edit (data in red writing) in Edit Parameter window during online edit (controller 
edit) of parameters, Easy Parameter Setup feature cannot be used.
If you click Easy Parameter Setup, a message will appear saying “There is data not written to the 
controller. Write to the controller first, or close the edit window”.

1) Set up or change 
parameters

2) Click Transmit to Controller



8. Param
eter Edit W

indow

106 ME0398-6E 
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(4) After setting up or changing the parameters, click Transmit to Controller  and the setup change data 
gets transmitted to the controller and the setup window closes.
Once the setup window is finished, close the top menu of Easy Parameter Setup window, and the 
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(Note) If editing the parameters saved in the PC offline and clicking Easy Parameter Setup, Transmit to
Controller in the setup window changes to Reflect to Edit Parameter Window. 
Click Reflect to Edit Parameter Window, and the settings and changes conducted in Easy 
Parameter Setup will be reflected (changed) to the setting values in the Edit Parameter window. 
(But, controller transmission will not be executed.)
As parameters will not be transmitted to the controller, close the top menu of Easy Parameter 
Setup window, go to Edit Parameter window to save the parameter file and transmit the data to the 
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(Note) If there is data in edit (data in red writing) in Edit Parameter window during online edit (controller 
edit) of parameters, Easy Parameter Setup feature cannot be used.
If you click Easy Parameter Setup, a message will appear saying “There is data not written to the 
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1) Set up or change 
parameters

2) Click Transmit to Controller
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8.4.1 Explanation of Easy Parameter Setup

Parameter edit is to be conducted in the setting screen of each feature for those features listed below.  
The settings in each window should differ depending on the controller type and hardware construction.
Place the mouse cursor on the settings in each window, and the help for each item should be displayed.

• RS-232C
Setup of serial communication by general RS-232C port can be conducted.
Select the communication settings for use / not to use of communication features, baud rate and so on.
Click Change to Standard Setting, and all the settings should be adjusted to standard values.

Fig. 8.11 RS-232C Setting

Click Advanced to display the Advanced Setting Screen (IAI protocol multiple channel communication 
settings).

Fig. 8.12 Advanced Setting
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• Fieldbus (CC-Link, DeviceNet, PROFIBUS-DP, EtherCAT, PROFINET IO, CC-Link IE Field)
Setup of Fieldbus communication and I/O assignment can be conducted.
Basic settings for communication should be established in Communication Tab. Settings should differ 
depending on the fieldbus type.
Click Change to Standard Setting, and all the settings should be adjusted to standard values.

Fig. 8.13 Communication Setting

Click Detail Setting, and the detailed setting window for such as the timeout duration should open.
(There should be no need of setting change in normal use.)

Fig. 8.14 Advanced Setting
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Set I/O start port number and the number of ports to be used in SEL Controller in I/O Assignment Setting 
(SEL Controller) Tab.
Click Change to Standard Setting, and all the settings should be adjusted to standard values.
* There is a setting for the number of remote register words only in CC-Link IE Field setting.

Fig. 8.15 I/O Assignment Setting (SEL controller)

Display the I/O assignment information for the device SEL Controller is connected to (such as PLC) and 
SEL Controller in I/O Assignment Setting (SEL Controller) Tab.
Input the I/O assignment top address of PLC to “Top Address”, and such information as the range of the 
fieldbus I/O assigned to the device SEL Controller is connected to (such as PLC) can be confirmed.

Fig. 8.16 I/O Assignment Information (device which connects to SEL controller)(For CC-Link) 
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Fig. 8.17 I/O Assignment Information (device which connects to SEL controller)(For DeviceNet and Others)

Fig. 8.18 I/O Assignment Information (device which connects to SEL controller)(For CC-Link IE)
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Fig. 8.17 I/O Assignment Information (device which connects to SEL controller)(For DeviceNet and Others)

Fig. 8.18 I/O Assignment Information (device which connects to SEL controller)(For CC-Link IE)
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• Ethernet
Setup of I/O communication, IAI protocol B/TCP communication and program message communication 
by Ethernet can be conducted

Fig. 8.19 Ethernet Setting (Common)

Setting of IP address on SEL Controller side and baud rate should be established in Common Tab.
In RSEL, it is necessary to set the addresses individually for I/O communication and for message 
communication.
(Setting of address only for message communication is available when there is no EtherNet/IP module 
connected.)
Click Change to Standard Setting, and all the settings should be adjusted to standard values.

Click Detail Setting, and the detailed setting window for such as the timeout duration should open.
(There should be no need of setting change in normal use.)

Fig. 8.20 Advanced Setting (Common)
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Fig. 8.21 Ethernet Setting (I/O)

When it is required to establish settings for I/O communication for EtherNet/IP, 
click Fieldbus Communication Setting in I/O Setting Tab, and the fieldbus communication setting window 
can be displayed in a separate window.

Fig. 8.22 Ethernet Setting (IAI Protocol B/TCP)
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Fig. 8.21 Ethernet Setting (I/O)

When it is required to establish settings for I/O communication for EtherNet/IP, 
click Fieldbus Communication Setting in I/O Setting Tab, and the fieldbus communication setting window 
can be displayed in a separate window.

Fig. 8.22 Ethernet Setting (IAI Protocol B/TCP)
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Setup for having the message communication with IAI protocol B/TCP can be done in IAI Protocol B/TCP 
Communication Tab.
Click Set to the Same as AUTO Mode, and the setting in MANU Mode can be set to the same as those 
in AUTO Mode.
Click Set to the Same as MANU Mode, and the setting in AUTO Mode can be set to the same as those 
in MANU Mode.
Click Change to Standard Setting, and all the settings should be adjusted to standard values.

Click Detail Setting, and the detailed setting window for such as the retry pitch should open.
(There should be no need of setting change in normal use.)

Fig. 8.23 Advanced Setting (IAI Protocol B/TCP)

Fig. 8.24 Ethernet Setting (SEL Program Message Communication)

Setup for having the message communication in SEL program can be done in SEL Program Message 
Communication Tab.
Click Change to Standard Setting, and all the settings should be adjusted to standard values.
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Click Detail Setting, and the detailed setting window for such as the timeout duration should open.
(There should be no need of setting change in normal use.)

Fig. 8.25 Advanced Setting (Message Communication)
• Vision System
Setup of Vision System I/F feature can be conducted.

Fig. 8.26 Vision System Setting

Setup for selection of Vision System I/F features and selection of vision system manufacturer can be done 
in “Basic Setting”.
Setup for communication setting for the controller and vision system can be done in “Communication 
Setting”.
Select either to use RS-232C or Ethernet in “Select Communication Device”.
Click Ethernet Message Communication Setting and the Ethernet communication setting window can be 
displayed in a separate window.
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Click Detail Setting, and the detailed setting window for such as the timeout duration should open.
(There should be no need of setting change in normal use.)

Fig. 8.25 Advanced Setting (Message Communication)
• Vision System
Setup of Vision System I/F feature can be conducted.

Fig. 8.26 Vision System Setting

Setup for selection of Vision System I/F features and selection of vision system manufacturer can be done 
in “Basic Setting”.
Setup for communication setting for the controller and vision system can be done in “Communication 
Setting”.
Select either to use RS-232C or Ethernet in “Select Communication Device”.
Click Ethernet Message Communication Setting and the Ethernet communication setting window can be 
displayed in a separate window.
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Click RS-232C Communication Setting and the RS-232C setting window can be displayed in a separate 
window.
Setup for capturing command physical output port and vision system coordinate axis number can be done 
in “Vision System Setting”.
* For RSEL, indicate an axis number in Axes Group No. 1. An axis in Axes Group No. 2 cannot be set as 

the vision system coordinate axis.

Click Change to Standard Setting, and all the settings should be adjusted to standard values.
Click Detail Setting, and the detailed setting window for such as the timeout duration should open.
(There should be no need of setting change in normal use.)

Fig. 8.27 Advanced Setting



8.
 P

ar
am

et
er

 E
di

t W
in

do
w

116 ME0398-6E

8.5 How to Initialize Parameter (at the time of shipment)

(1) Right-click a blank space in the tool bar (refer to [Fig. 8.28]) while pressing the Ctrl button. The Input 
Password will be displayed as shown in the Fig. 8.29.

Fig. 8.28 Menu Bar

Fig. 8.29 Input Password Screen

(2) Enter a password (5119) in the displayed Input Password screen. The Parameter of Shipping menu will 
be displayed in the Initialize Memory menu (Fig. 8.30). 
* The password will be valid until the end of application once it has been entered.

Fig. 8.30 Menu Bar (Parameter Initialization [Shipment Values])

Right-click a blank space in the 
tool bar while pressing Ctrl.
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(3) Selecting the displayed menu Parameter of Shipping displayed in (2) will display a dialog in Fig. 8.31. 
If you have no problem, click Yes. 

Fig. 8.31 Warning Dialog

(4) After completion of rewriting, write the parameters to the flash ROM.

Caution: Driver unit parameters are not initialized. Because of this an unexpected error may be 
detected when the actuator different from the one at the time of shipment is 
connected.
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8.6 Parameter Comparison

Comparison of the parameter files below can be performed.
• Saved parameter files
• Parameters in the controller and saved parameters

[Comparable Parameter Files]
Parameters in the same controllers and files of the same activated axis pattern at the same time

8.6.1 How to Compare Parameters
Choose either to open parameter files by selecting “File (F)” → “Open (O)” or to select 
“Parameter (P)” → “Edit (E)” to open the parameter edit window.

Fig. 8.32 Edit Parameter Window

Click Data Compare. 

Parameter files which are open should be subject to comparison.

Data Compare
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Click Data Compare. 

Parameter files which are open should be subject to comparison.

Data Compare
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A dialog will open if there are files exist available for parameter comparison.

Fig. 8.33 Select Dialog Window

The message shown in Fig. 8.34 should be displayed when there is no data existed available for 
parameter comparison.

Fig. 8.34 Message

Select parameter data to be compared in the select dialog and click OK. 
Parameter comparison will start.
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After the parameter comparison is finished, the form gets changed and numbers in difference are 
displayed and parameters in difference turns to yellow.

Fig. 8.35 CompResult

Fig. 8.36 Edit Window after Comparison Result

[1] SyncScroll: Effect : When it is displayed in blue, the scroll of the grid gets synchronized to the 
move.
The form that the button is not pressed also moves.
Tab movement also synchronizes.

SyncScroll: Invalid : When it is displayed in black, each form scrolls and tab moves individually.
[2] PrevDiff : The actuator moves to the nearest previous difference from the cell position of which 

PrevDiff button was pressed.
[3] NextDiff : The actuator moves to the nearest previous difference from the cell position of which 

NextDiff button was pressed.

[1] [2] [3]
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8.7 I/O Output Setting

There is a feature to output each type of the monitor data such as the current position to the output port 
domains in RSEL.
The I/O output setting is a feature to perform this monitor setting easily.
Also, it is available to establish the settings for the input feature select and the output feature select.
There are two ways to start up the I/O output setting feature.

(1) Click I/O Output Setting in the parameter edit window to start up the I/O output setting feature.

Fig. 8.37 I/O Output Setting Feature.

(2) Select “Parameter (P)” → “I/O Output Setting (I)” in the menu to start up the I/O output setting feature.

Fig. 8.38 I/O Output Setting

<Explanation of I/O Output Setting Feature> 
The I/O output setting feature shows the following window based on the parameter values in the parameter 
edit window.

Fig. 8.39 I/O Output Setting (Monitor Data)

In the left window, shows the menu for each setting. The monitor data output setting window should be 
displayed after startup.
In the right window, shows the status of port assignments. The output port assignment status should be 
displayed after startup.
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8.7.1 Monitor Data Output Setting
After starting up the I/O output setting feature, the monitor output setting window should be displayed in the 
left window.
In the monitor output setting window, operations stated below should be available.

Operation Things Available to Do
Select “Output Feature Select Setting” tab in the left 
window.

The left window can be switched to the output 
feature select setting window.

Select “Input Feature Select Setting” tab in the left 
window.

The left window can be switched to the input 
feature select setting window.

Select “Axis Number” combo box in the list in the 
left window.

A list of axes available in the monitor data output 
setting can be displayed. Refer to [8-7-1 (1)]

Select “Item” combo box in the list in the left 
window.

A list of items in the monitor data output setting can 
be displayed. Refer to [8-7-1 (1)]

Select “Top Output Port Number” text box in the list 
in the left window.

A port number can be input. Refer to [8-7-1 (1)]

Select “Justify to Left” check box in the list in the left 
window.

Left justification feature for output port assignment 
can be turned ON/OFF.

Select “Input Port” tab in the right window. The right window can be switched to the input port 
assignment status window.

Select “Automatic Assignment” button in the left
window.

Automatic assignment of the monitor data output 
setting can be performed. Refer to [8.7.1 (3)]

Select “Clear All Assignment” button in the left 
window.

The monitor data output setting can be all cleared.

Select “Help” button in the left window. Helps for operation in the monitor data output 
setting can be displayed.

Select “Monitor” button in the left window. The monitor window should be displayed.
Refer to [8-7-5]

Select “Transfer to Controller” button on the bottom 
of the window.

The setting data can be transferred to the 
controller. Refer to [8-7-4]

Select “Cancel” button on the bottom of the window. I/O output setting feature window closes.

(1) How to Establish Monitor Data Output Setting
Established the settings in “Axis Number”, “Item” and “Top Output Port Number” to conduct the monitor 
data output setting.
“Axis Number” setting is to be done in a combo box.
In the combo box list, axis numbers (axes group numbers) available for setting should be displayed.
Select an axis for monitoring from the list.

Item to be Displayed Example for Display
Axis Number (Axes Group Number) When axes from Axis No. 1 to Axis No. 4 are 

available in Axes Group 1, the combo box list 
should show as it is shown below.

1 (Axes Group No. 1)
2 (Axes Group No. 1)
3 (Axes Group No. 1)
4 (Axes Group No. 1)

When Axes Group No. 2 and later are invalid, there 
should be no display of the axis group number.
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“Axis Number” setting is to be done in a combo box.
A list of the items for the monitor data output setting should be displayed in the combo box list.
Select an item for monitoring from the list.

Item to be Displayed Explanation of Item
Current Position [mm] (2W) The current position should be displayed in the 

monitor in unit of [mm].
The current position in the range of -2, 147, 483, 648 
~ 2, 147, 483, 647 [mm] (for two words) should be 
displayed in the monitor.

Current Position [0.01mm] (2W) The current position should be displayed in the 
monitor in unit of [0.01mm].
The current position in the range of -21, 474, 836.48 
~ 21, 474, 836.47 [mm] (for two words) should be 
displayed in the monitor.

Current Position [0.001mm] (2W) The current position should be displayed in the 
monitor in unit of [0.001mm].
The current position in the range of -2, 147, 483.648 
~ 2, 147, 483.647 [mm] (for two words) should be 
displayed in the monitor.

Current Position [mm] (1W) The current position should be displayed in the 
monitor in unit of [mm].
The current position in the range of -32, 768 ~ 32, 
767 [mm] (for one word) should be displayed in the 
monitor.

Current Position [0.01mm] (1W) The current position should be displayed in the 
monitor in unit of [0.01mm].
The current position in the range of -327.68 ~ 327.67 
[mm] (for one word) should be displayed in the 
monitor.

Current Velocity [mm/sec] (1W) Current velocity should be displayed in the monitor in 
the unit of [mm/sec].
The current velocity in the range of 0 ~ 65, 535 
[mm/sec] (for one word) should be displayed in the 
monitor.

Current Velocity [0.1mm/sec] (1W) Current velocity should be displayed in the monitor in 
the unit of [0.1mm/sec].
The current velocity in the range of 0 ~ 6, 553.5 
[mm/sec] (for one word) should be displayed in the 
monitor.

Alarm Code (1W) The alarm code (from 0000h to FFFFh) should be 
displayed in the monitor.

Axis Operation Status (1W) Axis Operation Status (from 0000h to FFFFh) should 
be displayed in the monitor.
The configuration for axis operation status is the 
same as for the ECMD 5 command.
Refer to [SEL Language Programming Manual 
(MJ0224)] for details.

Motor Command Current [Rated Ratio %] (1W) The motor command current should be displayed in 
the monitor in the unit of [rated ratio %].
The motor command current in the range of -32, 768 
~ 32, 767 [%] (for one word) should be displayed in 
the monitor.
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Item to be Displayed Explanation of Item
Motor Command Current [Rated Ratio 0.1%] 
(1W)

The motor command current should be displayed in 
the monitor in the unit of [rated ratio 0.1%].
The motor command current in the range of -3,276.8
~ 3,276.7 [%] (for one word) should be displayed in 
the monitor.

Motor Command Current [mA] (2W) The motor command current should be displayed in 
the monitor in the unit of [mA].
The motor command current in the range of -2, 147, 
483.648 ~ 2, 147, 483.647 [mA] (for two words) 
should be displayed in the monitor.

Motor Command Current [mA] (1W) The motor command current should be displayed in 
the monitor in the unit of [mA].
The motor command current in the range of -32, 768 
~ 32, 767 [mA] (for one word) should be displayed in 
the monitor.

Position Deviation [Pulse] (2W) The position deviation in the range of -2, 147, 
483.648 ~ 2, 147, 483.647 [pulse] (for two words) 
should be displayed in the monitor.

Position Deviation [Pulse] (1W) The position deviation in the range of -32, 768 ~ 32, 
767 [pulse] (for one word) should be displayed in the 
monitor.

Overload Level [0.1%] (1W) The overload level should be displayed in the monitor 
in the unit of [0.1%].
The overload level in the range of 0 ~ 6, 553.5 [%] 
(for one word) should be displayed in the monitor.

Motor Feedback Current [Rated Ratio %] (1W) The motor feedback current should be displayed in 
the monitor in the unit of [rated ratio %].
The motor feedback current in the range of -32, 768 ~ 
32, 767 [%] (for one word) should be displayed in the 
monitor.

Motor Feedback Current [Rated Ratio 0.1%] (1W) The motor feedback current should be displayed in 
the monitor in the unit of [rated ratio 0.1%].
The motor feedback current in the range of -3,276.8 ~ 
3,276.7 [%] (for one word) should be displayed in the 
monitor.

Motor Feedback Current [mA] (2W) The motor feedback current should be displayed in 
the monitor in the unit of [mA].
The motor feedback current in the range of -2, 147, 
483.648 ~ 2, 147, 483.647 [mA] (for two words) 
should be displayed in the monitor.

Motor Feedback Current [mA] (1W) The motor feedback current should be displayed in 
the monitor in the unit of [mA].
The motor feedback current in the range of -32, 768 ~ 
32, 767 [mA] (for one word) should be displayed in 
the monitor.

Output Voltage (Power Supply Unit) [V] (1W) The output voltage of the power supply unit should be 
displayed in the monitor in the unit of [V].
The output voltage in the range 0 ~ 255 [V] should be 
displayed in the monitor.

Auxiliary Winding Voltage (Power Supply Unit) [V] 
(1W)

The auxiliary winding voltage of the power supply unit 
should be displayed in the monitor in the unit of [V].
The auxiliary winding voltage in the range 0 ~ 255 [V] 
should be displayed in the monitor.
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32, 767 [mA] (for one word) should be displayed in 
the monitor.

Output Voltage (Power Supply Unit) [V] (1W) The output voltage of the power supply unit should be 
displayed in the monitor in the unit of [V].
The output voltage in the range 0 ~ 255 [V] should be 
displayed in the monitor.
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should be displayed in the monitor in the unit of [V].
The auxiliary winding voltage in the range 0 ~ 255 [V] 
should be displayed in the monitor.
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Item to be Displayed Explanation of Item
Output Current (Power Supply Unit) [0.1A] (1W) The output current of the power supply unit should be 

displayed in the monitor in the unit of [0.1A].
The output current in the range 0 ~ 25.5 [A] should be 
displayed in the monitor.

Peak Hold Current (Power Supply Unit) [0.1A] 
(1W)

The peak hold current of the power supply unit should 
be displayed in the monitor in the unit of [0.1A].
The peak hold current in the range 0 ~ 25.5 [A] 
should be displayed in the monitor.

Load Ratio (Power Supply Unit) [Rated Ratio %] 
(1W)

The load ratio of the power supply unit should be 
displayed in the monitor in the unit of [rated ratio %].
The load ratio in the range 0 ~ 255 [%] should be 
displayed in the monitor.

Fan Revolution Speed (Power Supply Unit) 
[100rpm] (1W)

The fan revolution speed of the power supply unit 
should be displayed in the monitor in the unit of 
[100rpm].
The fan revolution speed in the range 0 ~ 25, 500 
[rpm] should be displayed in the monitor.

Internal Temperature (Power Supply Unit) [degC] 
(1W)

The internal temperature of the power supply unit 
should be displayed in the monitor in the unit of 
[degC].
The internal temperature in the range 0 ~ 255 [degC] 
should be displayed in the monitor.

Maintenance Bit (EC Status) (1W) Display ELECYCLINDER ALML bits in the monitor in 
axis number order.

In case of selecting a monitor item for the power supply unit, the axis number setting should become “in 
common”.
• The power supply unit output will be the number of power supply units connected (Other Parameter 

No. 61) × 1W
• The data configuration for each power supply unit is as follows.

bit15 : Power supply unit connection status (ON once communication is established)
bit9 : Reduced FAN revolution speed error (FAN revolution speed reduced 30%)
bit8 : Reduced FAN revolution speed error (FAN revolution speed reduced 50%)
bit0-7 : Selection data
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Input a port number with 3 to 4 digits in “Top Output Port Number” to set it up.
Content of Input Explanation for Value to Input

Value with 3 to 4 Digits Input a value with 3 to 4 digits of decimal number.
Input a value in the range of either the physical 
output port (300 to 599) or the extension output port 
(4000 to 6999).

It is available to set nine at the maximum in the monitor data output setting.
The settings from 1 to 9 should be displayed in the colors shown below in the port assignment status of 
the output in the window on the right.

Fig. 8.40 Colors

Set “Axis Number”, “Item”, “Top Output Port Number”, and the monitor data output setting should be 
displayed in the port assignment status in the window on the right.

eg. When setting 1 (Axes Group No. 1), Current Position [mm] (2W) and Port No. 300 in the first monitor 
data output setting.

Fig. 8.41 eg. Monitor Data Output Setting

Clue: Place the mouse cursor on the monitor data output setting in the window on the right, and a help 
display shows up to display the contents of setting.
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Set “Axis Number”, “Item”, “Top Output Port Number”, and the monitor data output setting should be 
displayed in the port assignment status in the window on the right.

eg. When setting 1 (Axes Group No. 1), Current Position [mm] (2W) and Port No. 300 in the first monitor 
data output setting.

Fig. 8.41 eg. Monitor Data Output Setting

Clue: Place the mouse cursor on the monitor data output setting in the window on the right, and a help 
display shows up to display the contents of setting.
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(2) How to Move up Output Ports
Check in the Move up check box, and port numbers in a row after the those for the one step previous in 
the monitor item can be allocated automatically.
eg. 1 (Axes Group No. 1), Current Position [mm] (2W) and Port No. 300 are set in the first monitor data 
output setting. When 1 (Axes Group No. 2) and Alarm Code (1W) are set in the second monitor data 
output setting, and Move up gets turned on.

Fig. 8.42 How to Move up Output Ports

With Move up ON, output port numbers (332 to 347) which are in row after the port numbers (300 to 
331) set to the first setting item can be allocated to the second setting item automatically.
When the port numbers are set automatically with Move up ON, the top output port number turns to grey 
and gets banned to input.
When you require to turn Move up OFF, remove the check mark in the check box.
Even if Move up gets turned OFF, the port numbers should remain without being cleared.
Move on setting should be kept activated while the check box is ON.
If the port number for the first setting item in the example above is changed from 300 to 4000, the port 
number for the second setting item should automatically be updated to 4032.
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(3) How to Automatic Assignment
Select the “Automatic Assignment” button, and the automatic assignment of the monitor data output 
setting should be conducted.
The setting items for automatic assignment may differ depending on the number of effective axes.

Relation between Monitoring Items for Automatic Assignment and Effective Axes

Monitoring Items for Automatic 
Assignment

Number of Effective Axes
1 2 3 4 5 and more

Current Position [0.001mm] (2W) ○ ○ ○ ○ ○
Current Velocity [0.1mm/sec] (1W) ○ ○ ○ ○ ×
Alarm Code (1W) ○ ○ ○ × ×
Axis Operation Status (1W) ○ ○ × × ×
Monitor Command Current [mA] (2W) ○ × × × ×

When there is one effective axis, five monitoring items, Current Position [0.001mm] (2W), Current 
Velocity [0.1mm/sec] (1W), Alarm Code (1W), Axis Operation Status (1W) and Monitor Command 
Current [mA] (2W), should be assigned automatically to the axis.

When there are two effective axes, four monitoring items, Current Position [0.001mm] (2W), Current 
Velocity [0.1mm/sec] (1W), Alarm Code (1W) and Axis Operation Status (1W), should be assigned 
automatically to each axis.

When there are three effective axes, three monitoring items, Current Position [0.001mm] (2W), Current 
Velocity [0.1mm/sec] (1W) and Alarm Code (1W), should be assigned automatically to each axis.

When there are four effective axes, two monitoring items, Current Position [0.001mm] (2W) and Current 
Velocity [0.1mm/sec] (1W), should be assigned automatically to each axis.

When there are five or more effective axes, the monitoring item of Current Position [0.001mm] (2W) 
should be assigned automatically to each axis.
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(3) How to Automatic Assignment
Select the “Automatic Assignment” button, and the automatic assignment of the monitor data output 
setting should be conducted.
The setting items for automatic assignment may differ depending on the number of effective axes.

Relation between Monitoring Items for Automatic Assignment and Effective Axes

Monitoring Items for Automatic 
Assignment

Number of Effective Axes
1 2 3 4 5 and more

Current Position [0.001mm] (2W) ○ ○ ○ ○ ○
Current Velocity [0.1mm/sec] (1W) ○ ○ ○ ○ ×
Alarm Code (1W) ○ ○ ○ × ×
Axis Operation Status (1W) ○ ○ × × ×
Monitor Command Current [mA] (2W) ○ × × × ×

When there is one effective axis, five monitoring items, Current Position [0.001mm] (2W), Current 
Velocity [0.1mm/sec] (1W), Alarm Code (1W), Axis Operation Status (1W) and Monitor Command 
Current [mA] (2W), should be assigned automatically to the axis.

When there are two effective axes, four monitoring items, Current Position [0.001mm] (2W), Current 
Velocity [0.1mm/sec] (1W), Alarm Code (1W) and Axis Operation Status (1W), should be assigned 
automatically to each axis.

When there are three effective axes, three monitoring items, Current Position [0.001mm] (2W), Current 
Velocity [0.1mm/sec] (1W) and Alarm Code (1W), should be assigned automatically to each axis.

When there are four effective axes, two monitoring items, Current Position [0.001mm] (2W) and Current 
Velocity [0.1mm/sec] (1W), should be assigned automatically to each axis.

When there are five or more effective axes, the monitoring item of Current Position [0.001mm] (2W) 
should be assigned automatically to each axis.
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8.7.2 Output Feature Select Setting

Fig. 8.43 Output Feature Select Setting

In the output feature select setting window, the following operations can be performed.

Operation Things Available to Do
Select “Monitor Data Output Setting” in left window. The left window can be switched to the monitoring 

data output setting window.
Select “Input Feature Select Setting” tab in the left 
window.

The left window can be switched to the input 
feature select setting window.

Select “Feature Select” combo box in the list in the 
left window.

A list of items available for setting in each output 
feature should be displayed. Refer to [8.7.2 (1)]

Select “Output Port Number” text box in the list in 
the left window.

A port number can be input. [Refer to 8.7.2 (1)]

Select “Justify to Left” check box in the list in the 
left window.

Left justification feature for output port assignment 
can be turned ON/OFF.

Select “Input Port” tab in the right window. The right window can be switched to the input port 
assignment status window.

Select “Change to Standard Setting” button in the 
left window.

The standard setting should be set to the output 
feature select setting. Refer to [8.7.2 (3)]

Select “Help” button in the left window. Helps for operation in the output feature select 
setting can be displayed.

Select “Monitor” button in the right window. The monitor window should be displayed. 
Refer to [8.7.5]

Select “Transfer to Controller” button on the bottom 
of the window.

The setting data can be transferred to the controller. 
Refer to [8.7.4]

Select “Cancel” button on the bottom of the window. I/O output setting feature window closes.



8.
 P

ar
am

et
er

 E
di

t W
in

do
w

130 ME0398-6E 

(1) Way of Output Feature Select Setting
Establish the settings in “Feature Select” and “Output Port Number” to perform the output feature select 
setting.

The setting for “Feature Select” is to be conducted in the combo box.
Items for each output feature number should be displayed in the list of the combo box.
Select an item to set from the list.

Items in List for Output Feature No. 300 Items in List for Output Feature No. 300 (Area 2)
General Output No Feature Assigned

Error output higher than operation cancellation level (ON)
Error output higher than operation cancellation level (OFF)
Error output higher than operation cancellation level + emergency stop output (ON)
Error output higher than operation cancellation level + emergency stop output (OFF)
Error output higher than cold start level (ON)
Error output higher than cold start level (OFF)
Error output in maintenance information alert feature related message level (ON)
Error output in maintenance information alert feature related message level (OFF)

Items in List for Output Feature No. 301 Items in List for Output Feature No. 301 (Area 2)
General Output No Feature Assigned

READY Output (PIO trigger program available for operation)
READY Output (PIO trigger program available for operation and error higher than operation cancellation
level not occurred)
READY Output (PIO trigger program available for operation and error higher than cold start level not 
occurred)

Items in List for Output Feature No. 302 Items in List for Output Feature No. 302 (Area 2)
General Output No Feature Assigned

Emergency Stop Output (ON)
Emergency Stop Output (OFF)

Items in List for Output Feature No. 303 Items in List for Output Feature No. 303 (Area 2)
General Output No Feature Assigned

AUTO Mode Output
Output During Automatic Operation (Other Parameter No. 12)

Items in List for Output Feature No. 304 Items in List for Output Feature No. 304 (Area 2)
General Output No Feature Assigned

Output When All Effective Axes at Home Position (= 0)
Output When All Effective Axes Home-Return Complete Status (Coordinates Firm)
Output When All Effective Axes at Home Position Preset Coordinates

Items in List for Output Feature No. 305 Items in List for Output Feature No. 305 (Area 2)
General Output No Feature Assigned

1st Axis In-Position Output (OFF when pressing missed)
1st Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 306 Items in List for Output Feature No. 306 (Area 2)
General Output No Feature Assigned

2nd Axis In-Position Output (OFF when pressing missed)
2nd Axis Servo-on Output (System Monitoring Task Output)
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(1) Way of Output Feature Select Setting
Establish the settings in “Feature Select” and “Output Port Number” to perform the output feature select 
setting.

The setting for “Feature Select” is to be conducted in the combo box.
Items for each output feature number should be displayed in the list of the combo box.
Select an item to set from the list.

Items in List for Output Feature No. 300 Items in List for Output Feature No. 300 (Area 2)
General Output No Feature Assigned

Error output higher than operation cancellation level (ON)
Error output higher than operation cancellation level (OFF)
Error output higher than operation cancellation level + emergency stop output (ON)
Error output higher than operation cancellation level + emergency stop output (OFF)
Error output higher than cold start level (ON)
Error output higher than cold start level (OFF)
Error output in maintenance information alert feature related message level (ON)
Error output in maintenance information alert feature related message level (OFF)

Items in List for Output Feature No. 301 Items in List for Output Feature No. 301 (Area 2)
General Output No Feature Assigned

READY Output (PIO trigger program available for operation)
READY Output (PIO trigger program available for operation and error higher than operation cancellation
level not occurred)
READY Output (PIO trigger program available for operation and error higher than cold start level not 
occurred)

Items in List for Output Feature No. 302 Items in List for Output Feature No. 302 (Area 2)
General Output No Feature Assigned

Emergency Stop Output (ON)
Emergency Stop Output (OFF)

Items in List for Output Feature No. 303 Items in List for Output Feature No. 303 (Area 2)
General Output No Feature Assigned

AUTO Mode Output
Output During Automatic Operation (Other Parameter No. 12)

Items in List for Output Feature No. 304 Items in List for Output Feature No. 304 (Area 2)
General Output No Feature Assigned

Output When All Effective Axes at Home Position (= 0)
Output When All Effective Axes Home-Return Complete Status (Coordinates Firm)
Output When All Effective Axes at Home Position Preset Coordinates

Items in List for Output Feature No. 305 Items in List for Output Feature No. 305 (Area 2)
General Output No Feature Assigned

1st Axis In-Position Output (OFF when pressing missed)
1st Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 306 Items in List for Output Feature No. 306 (Area 2)
General Output No Feature Assigned

2nd Axis In-Position Output (OFF when pressing missed)
2nd Axis Servo-on Output (System Monitoring Task Output)
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Items in List for Output Feature No. 307 Items in List for Output Feature No. 307 (Area 2)
General Output No Feature Assigned

3rd Axis In-Position Output (OFF when pressing missed)
3rd Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 308 Items in List for Output Feature No. 308 (Area 2)
General Output No Feature Assigned

4th Axis In-Position Output (OFF when pressing missed)
4th Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 309 Items in List for Output Feature No. 309 (Area 2)
General Output No Feature Assigned

5th Axis In-Position Output (OFF when pressing missed)
5th Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 310 Items in List for Output Feature No. 310 (Area 2)
General Output No Feature Assigned

6th Axis In-Position Output (OFF when pressing missed)
6th Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 311 Items in List for Output Feature No. 311 (Area 2)
General Output No Feature Assigned

7th Axis In-Position Output (OFF when pressing missed)
7th Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 312 Items in List for Output Feature No. 312 (Area 2)
General Output No Feature Assigned

8th Axis In-Position Output (OFF when pressing missed)
8th Axis Servo-on Output (System Monitoring Task Output)

Items in List for Output Feature No. 313 Items in List for Output Feature No. 313 (Area 2)
General Output No Feature Assigned

Items in List for Output Feature No. 314 Items in List for Output Feature No. 314 (Area 2)
General Output No Feature Assigned

Items in List for Output Feature No. 315 Items in List for Output Feature No. 315 (Area 2)
General Output No Feature Assigned

Input the port number in 3 to 4 digits in “Output Port Number” for setting.
Content of Input Explanation for Value to Input

Value with 3 to 4 Digits Input a value with 3 to 4 digits
Input a value in the range of either the physical 
output port (300 to 599) or the extension output port 
(4000 to 6999).
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The output feature select setting should be shown in the following color.

Establish the settings in “Feature Select” and “Output Port Number”, and the output feature select 
setting should be displayed in the port assignment status for the output port in the right window.

eg. When Error output higher than operation cancellation level (ON) and Port No. 316 are set in Output 
Feature No. 300.

Fig. 8.44 Output Feature Select Setting Color
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The output feature select setting should be shown in the following color.

Establish the settings in “Feature Select” and “Output Port Number”, and the output feature select 
setting should be displayed in the port assignment status for the output port in the right window.

eg. When Error output higher than operation cancellation level (ON) and Port No. 316 are set in Output 
Feature No. 300.

Fig. 8.44 Output Feature Select Setting Color
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(2) Way to Move up to Output Ports
Check in the Move up check box, and port numbers in a row after the those for the one step previous in 
the output feature select setting item can be allocated automatically.

eg. When Error output higher than operation cancellation level (ON) and Port No. 316 are set in Output 
Feature No. 300.
And READY output (PIO trigger program available for operation) is set to Output Feature No. 301 and 
Move up is turned ON.

Fig. 8.45 Way to Move up to Output Ports

Once Move up at Output Feature No. 301 is turned ON, the output port number (317) in a row to the 
output port number set in Output Feature No. 300 (316) should be automatically set.
When the port numbers are set automatically with Move up ON, the output port numbers turn to grey 
and get banned to input.
When you require to turn Move up OFF, remove the check mark in the check box.
Even if Move up gets turned OFF, the port numbers should remain without being cleared.
Move ON setting should be kept activated while the check box is ON.
If the port number for the setting item in Output Feature No. 300 is changed from 316 to 4000, the port 
number for Output Feature No. 301 should automatically be updated to 4001.
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(3) Way to Change to Standard Setting
Select “Change to Standard Setting” button, and the standard setting should be allocated to the output 
feature select setting.

Contents of Standard Setting in Output Feature Select Setting

Output Feature Select Setting Items Output Port 
Number

Output Feature No. 300 Error output higher than operation cancellation
level (OFF)

300

Output Feature No. 301 READY Output (PIO trigger program available 
for operation and error higher than cold start 
level not occurred)

301

Output Feature No. 302 Emergency stop output (OFF) 302
Output Feature No. 303 General Output 303
Output Feature No. 304 General Output 304
Output Feature No. 305 General Output 305
Output Feature No. 306 General Output 306
Output Feature No. 307 General Output 307
Output Feature No. 308 General Output 308
Output Feature No. 309 General Output 309
Output Feature No. 310 General Output 310
Output Feature No. 311 General Output 311
Output Feature No. 312 General Output 312
Output Feature No. 313 General Output 313
Output Feature No. 314 General Output 314
Output Feature No. 315 General Output 315
Output Feature No. 300 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 301 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 302 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 303 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 304 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 305 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 306 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 307 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 308 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 309 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 310 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 311 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 312 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 313 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 314 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 315 (Area 2) No Feature Assigned Not Allocated
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(3) Way to Change to Standard Setting
Select “Change to Standard Setting” button, and the standard setting should be allocated to the output 
feature select setting.

Contents of Standard Setting in Output Feature Select Setting

Output Feature Select Setting Items Output Port 
Number

Output Feature No. 300 Error output higher than operation cancellation
level (OFF)

300

Output Feature No. 301 READY Output (PIO trigger program available 
for operation and error higher than cold start 
level not occurred)

301

Output Feature No. 302 Emergency stop output (OFF) 302
Output Feature No. 303 General Output 303
Output Feature No. 304 General Output 304
Output Feature No. 305 General Output 305
Output Feature No. 306 General Output 306
Output Feature No. 307 General Output 307
Output Feature No. 308 General Output 308
Output Feature No. 309 General Output 309
Output Feature No. 310 General Output 310
Output Feature No. 311 General Output 311
Output Feature No. 312 General Output 312
Output Feature No. 313 General Output 313
Output Feature No. 314 General Output 314
Output Feature No. 315 General Output 315
Output Feature No. 300 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 301 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 302 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 303 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 304 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 305 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 306 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 307 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 308 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 309 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 310 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 311 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 312 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 313 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 314 (Area 2) No Feature Assigned Not Allocated
Output Feature No. 315 (Area 2) No Feature Assigned Not Allocated
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8.7.3 Input Feature Select Setting

Fig. 8.46 Input Feature Select Setting

In the input feature select setting window, the following operations can be performed.

Operation Things Available to Do
Select “Monitor Data Output Setting” in left window. The left window can be switched to the monitoring 

data output setting window.
Select “Output Feature Select Setting” tab in the left 
window.

The left window can be switched to the output
feature select setting window.

Select “Feature Select” combo box in the list in the 
left window.

A list of items available for setting in each input
feature should be displayed. Refer to [8.7.3 (1)]

Select “Input Port Number” text box in the list in the 
left window.

A port number can be input. Refer to [8.7.3 (1)]

Select “Justify to Left” check box in the list in the 
left window.

Left justification feature for input port assignment 
can be turned ON/OFF.

Select “Input Port” tab in the right window. In the input function selection setting, the right side 
of the screen can be switched from the input port 
display (default) to the output port display.

Select “Change to Standard Setting” button in the
left window.

The standard setting should be set to the input
feature select setting. Refer to [8.7.3 (3)]

Select “Help” button in the left window. Helps for operation in the input feature select 
setting can be displayed.

Select “Monitor” button in the left window. Select 
Input Port.

The monitor window should be displayed. 
Refer to [8.7.5]

Select “Transfer to Controller” button on the bottom 
of the window.

The setting data can be transferred to the controller. 
Refer to [8.7.4]

Select “Cancel” button on the bottom of the window. I/O output setting feature window closes.
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(1) Way of Input Feature Select Setting
Establish the settings in “Feature Select” and “Input Port Number” to conduct the feature select setting.

The setting for “Feature Select” is to be conducted in the combo box.
Items for each input feature number should be displayed in the list of the combo box.
Select an item to set from the list.

List Items of Input Feature No. 000
General Input
Program Start Signal (ON-edge)
(Indication Program Number for Input Port Numbers from No. 007 to 014BCD)
Program Start Signal (ON-edge)
(Binary Indication Program Number for Input Port Numbers from No. 007 to 014)
Program Start Signal (ON-edge)
(Indication Program Number for Input Port Numbers from No. 008 to 014BCD)
Program Start Signal (ON-edge)
(Binary Indication Program Number for Input Port Numbers from No. 008 to 014)

List Items of Input Feature No. 001
General Input
Soft Reset Signal (ON for 1sec)

List Items of Input Feature No. 002
General Input
Servo-ON

List Items of Input Feature No. 003
General Input
General Input (Automatic start program startup with power-ON reset / soft reset in AUTO Mode)
Automatic Start Program Startup Signal (ON-edge: Start, OFF-edge: All operations and programs 
stopped (excluding I/O process program at operation and program stop))

List Items of Input Feature No. 004
General Input
All Servo Axes Soft Interlock (OFF level) (Effective in commands other than Servo-OFF Command) 
(Operations withheld at interlock during automatic operation, Operations stopped at interlock during 
non-automatic operation)

List Items of Input Feature No. 005
General Input
Operation Resume Signal (ON-edge)

List Items of Input Feature No. 006
General Input
Operation Pause Signal (OFF level)

List Items of Input Feature No. 007
General Input
Program Start Indicating Program Number (Lowest bit)

List Items of Input Feature Numbers from No. 008 to No. 012
General Input
Program Start Indicating Program Number
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(1) Way of Input Feature Select Setting
Establish the settings in “Feature Select” and “Input Port Number” to conduct the feature select setting.

The setting for “Feature Select” is to be conducted in the combo box.
Items for each input feature number should be displayed in the list of the combo box.
Select an item to set from the list.

List Items of Input Feature No. 000
General Input
Program Start Signal (ON-edge)
(Indication Program Number for Input Port Numbers from No. 007 to 014BCD)
Program Start Signal (ON-edge)
(Binary Indication Program Number for Input Port Numbers from No. 007 to 014)
Program Start Signal (ON-edge)
(Indication Program Number for Input Port Numbers from No. 008 to 014BCD)
Program Start Signal (ON-edge)
(Binary Indication Program Number for Input Port Numbers from No. 008 to 014)

List Items of Input Feature No. 001
General Input
Soft Reset Signal (ON for 1sec)

List Items of Input Feature No. 002
General Input
Servo-ON

List Items of Input Feature No. 003
General Input
General Input (Automatic start program startup with power-ON reset / soft reset in AUTO Mode)
Automatic Start Program Startup Signal (ON-edge: Start, OFF-edge: All operations and programs 
stopped (excluding I/O process program at operation and program stop))

List Items of Input Feature No. 004
General Input
All Servo Axes Soft Interlock (OFF level) (Effective in commands other than Servo-OFF Command) 
(Operations withheld at interlock during automatic operation, Operations stopped at interlock during 
non-automatic operation)

List Items of Input Feature No. 005
General Input
Operation Resume Signal (ON-edge)

List Items of Input Feature No. 006
General Input
Operation Pause Signal (OFF level)

List Items of Input Feature No. 007
General Input
Program Start Indicating Program Number (Lowest bit)

List Items of Input Feature Numbers from No. 008 to No. 012
General Input
Program Start Indicating Program Number
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List Items of Input Feature No. 013
General Input
Program Start Indicating Program Number
Error Reset (ON-edge)

List Items of Input Feature No. 014
General Input
Drive Cutoff Release Input (ON-edge) (Effective after cause removed)
Program Start Indicating Program Number

List Items of Input Feature No. 015
General Input
All Activated Axes Home-Return (ON-edge)
All Incremental Axes Home-Return (ON-edge)

Input the port number in 1 to 4 digits in “Input Port Number” for setting.
Content of Input Explanation for Value to Input

Value with 1 to 4 Digits Input a value with 1 to 4 digits
Input a value in the range of either the physical 
input port (0 to 299) or the extension input port 
(1000 to 3999).

The input feature select setting should be shown in the following color.

Set “Feature Select” and “Input Port Number”, and the input feature select setting should be displayed in 
the port assignment status in the window on the right.

e.g. When Program Start Signal (ON-edge) (Input Port No. 007 to 014 BCD Indication Program 
Number) and Port No. 16 are set in Input Feature No. 000. 

Fig. 8.47 Input Feature Select Setting Color
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(2) Way to Move up Input Port
Check in the Move up check box, and port numbers in a row after those for the one step previous in the 
input feature select setting can be allocated automatically.

e.g. Program Start Signal (ON-edge) (Input Port No. 007 to 014 BCD Indication Program Number) and 
Port No. 16 are set in Input Feature No. 000. And Soft Reset Signal (ON for 1sec) is set to Input Feature 
No. 001 and Move up gets turned ON.

Fig. 8.48 Way to Move up Input Port

Once Move up at Input Feature No. 001 is turned ON, the input port number (17) in a row to the input 
port number set in Input Feature No. 000 (16) should be automatically set.
When the port numbers are set automatically with Move up on, the input port numbers turn to grey and 
get banned to input.
When you require to turn Move up OFF, remove the check mark in the check box.
Even if Move up gets turned OFF, the port numbers should remain without being cleared.
Move on setting should be kept activated while the check box is ON.
If the port number for the setting item in Input Feature No. 000 is changed from 16 to 1000, the port 
number for Input Feature No. 001 should automatically be updated to 1001.
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(2) Way to Move up Input Port
Check in the Move up check box, and port numbers in a row after those for the one step previous in the 
input feature select setting can be allocated automatically.

e.g. Program Start Signal (ON-edge) (Input Port No. 007 to 014 BCD Indication Program Number) and 
Port No. 16 are set in Input Feature No. 000. And Soft Reset Signal (ON for 1sec) is set to Input Feature 
No. 001 and Move up gets turned ON.

Fig. 8.48 Way to Move up Input Port

Once Move up at Input Feature No. 001 is turned ON, the input port number (17) in a row to the input 
port number set in Input Feature No. 000 (16) should be automatically set.
When the port numbers are set automatically with Move up on, the input port numbers turn to grey and 
get banned to input.
When you require to turn Move up OFF, remove the check mark in the check box.
Even if Move up gets turned OFF, the port numbers should remain without being cleared.
Move on setting should be kept activated while the check box is ON.
If the port number for the setting item in Input Feature No. 000 is changed from 16 to 1000, the port 
number for Input Feature No. 001 should automatically be updated to 1001.
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(3) Way to Change to Standard Setting
Select Change to Standard Setting, and the standard setting should be allocated to the input feature 
select setting.

Contents of Standard Setting in Input Feature Select Setting

Input Feature Select Setting Items Input Port 
Number

Input Feature No. 000 Program Start Signal (ON-edge)
(Indication Program Number for Input Port 
Numbers from No. 007 to 014BCD)

000

Input Feature No. 001 General Output 001
Input Feature No. 002 General Output 002
Input Feature No. 003 General Input (Automatic start program startup 

with power-ON reset / soft reset in AUTO Mode)
003

Input Feature No. 004 General Output 004
Input Feature No. 005 General Output 005
Input Feature No. 006 General Output 006
Input Feature No. 007 Program Start Indicating Program Number 

(Lowest bit)
007

Input Feature No. 008 Program Start Indicating Program Number 008
Input Feature No. 009 Program Start Indicating Program Number 009
Input Feature No. 010 Program Start Indicating Program Number 010
Input Feature No. 011 Program Start Indicating Program Number 011
Input Feature No. 012 Program Start Indicating Program Number 012
Input Feature No. 013 Program Start Indicating Program Number 013
Input Feature No. 014 General Output 014
Input Feature No. 015 General Output 015
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8.7.4 Option Unit Input Setting / Option Unit Output Setting

The Option Unit Input Output Setting Screen and Option Unit Output Setting Screen are used to display 
areas assigned as I/O slot areas and PIO unit areas, and to display or configure ports assigned for EC 
connection units, input/output feature selection, etc.

Example: Assignments with 1 RCON-NP and 1 RCON-EC connected

Fig. 8.49 Option Unit Input Setting / Option Unit Output Setting

Input ports and output ports are displayed as follows.

Display Description

Unassigned area

Area with an assigned I/O slot for fieldbus, etc.

Area with an assigned PIO unit

Area with an assigned EC connection unit port

Area with an EC connection unit port assigned to an I/O slot area

Area with an EC connection unit port assigned to a PIO unit area

Example: Assignments with 1 RCON
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Display Description

Area with an assigned input/output feature selection port

Area with an input/output feature selection port assigned to an I/O slot area

Area with an input/output feature selection port assigned to a PIO unit area

Duplicate assigned port

Port with another feature already assigned

[If an EC unit is connected]
If an EC unit is connected, "Control Method" (located on the left side of the screen) can be used to select the 
following.

SEL program: Select this if a SEL program will be used to perform EC axis control and monitor its status.

Host program: Select this if a host device will be used to perform EC axis control and monitor its status. 
Assign the leading input port number or leading output port number to an I/O slot or PIO 
unit area.
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8.7.5 Way of Data Transfer
Transfer the setting data to the controller with Transfer to Controller after the monitoring data output setting, 
output feature select setting and input feature select setting are conducted.
The transfer to the setting data should get cancelled when there is an error in the setting and the content of 
the error should show up.

e.g. When Top Output port Number is not set in the monitoring data output setting

Fig. 8.50 Way of Data Transfer

An error should be displayed.
The content of an error occurred should be displayed on the lower left of the window.
The port number in the line that the error occurred should be shown in the following color.

Close the error dialog and select Move to Where Applicable, and the cursor should move to the line that the 
error has occurred.
Select Move to Where Applicable again, and the cursor should move to the line that the next error has 
occurred.

Once the cursor moves to the line that the error has occurred, correct the setting where there is an error.

Error Correction
There is an item that is not set. Establish the setting in the item with no setting 

done.
There is a port that the assignments are duplicated. Set the port numbers that should not duplicate.
There is a port that the monitoring items are 
duplicated.

Change the duplicated settings or delete them.

There is a port out of the setting range. Set the port numbers that are in the effective range.
There is a port used that should not be used. Set the port numbers that do not duplicate with the 

ports that have other features already assigned.
The monitoring data output is set to a port not for 
the fieldbus.

Set the fieldbus domain to the port number in the 
monitoring data output setting.

The setting of the program numbers is not in a row. Set the program numbers so they are in a row.
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Once all the errors are corrected, try to transfer the data again to the controller by Transfer to Controller. 
If the setting is correct, the error display should go away and the setting data should be transferred to the 
controller.

Example for Appropriate Setting

Clue: Even with the two errors, “There are ports that the monitoring items are duplicated.” and “The 
monitoring data output is set to a port not for the fieldbus.”, the setting data can be transferred to 
the controller.
Once you select Transfer to Controller, there should appear a confirmation dialog. Select OK in the 
confirmation dialog when the setting data is to be transferred.

Clue: Do not include “general input” in “program start indicating program numbers” in the input feature 
select setting.

In a row

Input Feature No. 007  Program Start Indicating Program No.  Input Port No. 000
Input Feature No. 008  Program Start Indicating Program No.  Input Port No. 001
Input Feature No. 009  Program Start Indicating Program No.  Input Port No. 002
Input Feature No. 010  Program Start Indicating Program No.  Input Port No. 003
Input Feature No. 011  Program Start Indicating Program No.  Input Port No. 004
Input Feature No. 012  General Input  Input Port No. 016
Input Feature No. 013  General Input  Input Port No. 017

In a row

Input Feature No. 007  Program Start Indicating Program No.  Input Port No. 000
Input Feature No. 008  Program Start Indicating Program No.  Input Port No. 001
Input Feature No. 009  Program Start Indicating Program No.  Input Port No. 002
Input Feature No. 010  Program Start Indicating Program No.  Input Port No. 003
Input Feature No. 011  Program Start Indicating Program No.  Input Port No. 004
Input Feature No. 012  Program Start Indicating Program No.  Input Port No. 005
Input Feature No. 013  Program Start Indicating Program No.  Input Port No. 006

In a row

Input Feature No. 007  General Input  Input Port No. 016
Input Feature No. 008  General Input  Input Port No. 017
Input Feature No. 009  Program Start Indicating Program No.  Input Port No. 002
Input Feature No. 010  Program Start Indicating Program No.  Input Port No. 003
Input Feature No. 011  Program Start Indicating Program No.  Input Port No. 004
Input Feature No. 012  Program Start Indicating Program No.  Input Port No. 005
Input Feature No. 013  Program Start Indicating Program No.  Input Port No. 006 
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Example for Wrong Setting

Parameter Type / Number Feature Name
I/O Parameter No. 28 I/O Ready Output Port Number
I/O Parameter No. 29 Drive Cutoff (SDN) Notice Output Port Number
I/O Parameter No. 74 Number of TP User Output Port Use (hand, etc.)
I/O Parameter No. 75 TP User Output Port Start Number
I/O Parameter No. 76 AUTO Mode Output Port Number
I/O Parameter No. 77 PC/TP Servo Operation Command Reception 

Permission Input Port Number
I/O Parameter No. 79 Remote Mode Control Input Port Number
I/O Parameter No. 356 Vision System I/F1 Initial Complete Status 

Physical Input Port Number
I/O Parameter No. 357 Vision System I/F1 Capturing Command 

Physical Output Port Number
Axis Parameter No. 23 Zone 1 Output Number
Axis Parameter No. 26 Zone 2 Output Number
Axis Parameter No. 29 Zone 3 Output Number
Axis Parameter No. 32 Zone 4 Output Number
Axis Parameter No. 37 OLWNO Driver Overload Warning Output

Number

Input Feature No. 007  Program Start Indicating Program No.  Input Port No. 000
Input Feature No. 008  Program Start Indicating Program No.  Input Port No. 001
Input Feature No. 009  General Input  Input Port No. 016
Input Feature No. 010  General Input  Input Port No. 017
Input Feature No. 011  General Input  Input Port No. 018

Input Feature No. 012  Program Start Indicating Program No.  Input Port No. 002 
Input Feature No. 013  Program Start Indicating Program No.  Input Port No. 003

Setting of input port numbers
is not in a row

Input Feature No. 007  Program Start Indicating Program No.  Input Port No. 000
Input Feature No. 008  Program Start Indicating Program No.  Input Port No. 001
Input Feature No. 009  Program Start Indicating Program No.  Input Port No. 002
Input Feature No. 010  Program Start Indicating Program No.  Input Port No. 003
Input Feature No. 011  Program Start Indicating Program No.  Input Port No. 016
Input Feature No. 012  Program Start Indicating Program No.  Input Port No. 017
Input Feature No. 013  Program Start Indicating Program No.  Input Port No. 018

Clue: When the IO output setting feature is started up offline, Transfer to Controller should be turned into 
Reflect to Parameter Edit Window. 
When also the parameters are to be reflected to the parameter edit window with Reflect to
Parameter Edit Window, if there is an error in the setting, the error should be displayed and 
reflecting of the setting data to the parameter edit window should be cancelled.

Clue: The ports that have other features already assigned are the ports that the parameters below are 
used. Check separately for the features and settings for each parameter.
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used. Check separately for the features and settings for each parameter.
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8.7.6 Way of Controller Data Monitoring
After transferring the setting data to the controller, select Monitor to open the output port monitoring window.
In the output port monitor window, the values in the output port indicated in the monitoring data output can be 
monitored.

e.g. When setting 1 (Axes Group No. 1), Current Position [mm] (2W) and Port No. 316 in the first monitoring 
data output setting. And setting 1 (Axes Group No. 2), Alarm Code (1W) and Port No. 348 in the second 
monitor data output setting.

Fig. 8.51 Way of Controller Data Monitoring

From Top No. to Size, the contents set in the monitoring data output setting should be displayed.
The way to display the output port numbers can be selected in Monitor Radix.

Monitor Radix Status Display
Bit Order 0 to 31 / Bit Order 0 to 15 Data is to be shown in binary numbers with the left 

LSB. (LSB: Lowest bit)
Bit Order 31 to 0 / Bit Order 15 to 0 Data is to be shown in binary numbers with the left 

MSB. (MSB: Highest bit)
10 (with no sign) Data is to be shown in decimal numbers with no 

sign.
10 (with sign) Data is to be shown in decimal numbers with sign.
16 Data is to be shown in hexadecimal numbers.
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8.7.7 Way of Monitoring Data Swap Setting

Fig. 8.52 Way of Monitoring Data Swap Setting

In the detail setting window, the endian for monitoring data read from the controller can be set.

Setting Detail
Byte Swap Select either to activate or deactivate.

When selected to activate, swapping should be 
conducted in the byte unit.

Word Swap Select either to activate or deactivate.
When selected to activate, swapping should be 
conducted in the word unit.

Clue: In the swap setting, the data shown in the monitoring window can be set in four ways as shown 
below.

Data Indicated in Monitoring Item (Big Endian)

Data Displayed in Monitoring Window (Big Endian)

Byte Swap = Deactivated
Word Swap = Deactivated
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Data Indicated in Monitoring Item (Big Endian)

Byte Swap = Activated
Word Swap = Deactivated

Data Displayed in Monitoring Window (PDP Endian)

Data Indicated in Monitoring Item (Big Endian)

Data Displayed in Monitoring Window

Byte Swap = Deactivated
Word Swap = Activated

Data Indicated in Monitoring Item (Big Endian)

Byte Swap = Activated
Word Swap = Activated

Data Displayed in Monitoring Window (Little Endian)
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8.8 Driver Unit Parameters
Save the driver unit parameters to files by axis or transfer to the controller.

8.8.1 Saving to a File
From the menu, select Parameter (P) → Drive unit parameter (D) 
→ Save to file (S) to display the file saving axis selection screen. 

Fig. 8.53 File Saving Axis Selection Screen

Click and enter a checkmark in the save column for the axis to be saved. (Multiple axes can be selected.)
Click OK to display the save destination folder selection screen.
Select a folder and click OK to begin saving to the file.
The file name will be "Axis+axis number.extension".
When saving is complete, a save complete message will be displayed.

Fig. 8.54 Saving to File Complete Message
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8.8.2 Transfer to Controller
From the menu, select Parameter (P) → Drive unit parameter (D) 
→ Transfer to controller (L) to display the parameter transfer axis selection screen. 

Fig. 8.55 Controller Transfer Axis Selection Screen

Only one axis can be selected.
Click OK to display the parameter file transfer selection screen. 
Only the extensions of the same unit type as the selected axis can be selected.
Click Open to begin transfer to the controller.
When transfer to the controller is complete, a load complete message will be displayed.

Fig. 8.56 Transfer to Controller Complete Message
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The extensions supported by the drive unit parameters are shown below.

Unit Extension Support start version

RCON-PC/PCF
.prrpc

V14.01.13.00

.prrpcm

RCON-AC
.prrac

.prracm

RCON-DC
.prrdc

.prrdcm

RCON-SC
.prrsc2

.prrsc2m

SCON-CB
.prrsc

.prrscm

SCON2-CG
.prs2r

V14.02.05.00
.prs2rm
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9. Symbol Edit Window
9.1 About Symbols

Variable numbers, flag numbers and other values can be treated as symbols. 

(1) Values supporting symbol conversion
The following values can be treated as symbols:
Variable number, flag number, tag number, subroutine number, program number, position number, input 
port number, output port number, input/output ports, axis number, constant 

(2) Symbol description rules 
[1] First character: A single-byte alphabet, single-byte underscore, single-byte character (half-width 

kana) in ASCII Code 0x80 or later or two-byte character (excluding full-width space)
[2] Second and subsequent characters: Any single-byte character or two-byte character (excluding full-

width space) in ASCII Code 0x21 or later.
[3] Maximum number of characters: 40 single-byte characters (20 two-byte characters). 
[4] Definition of the same symbol for two or more values within a given function is prohibited. (The 

same symbol can be defined for two or more local values that are each used in a different 
program.)

[5] Definition of the same symbol for two or more flag numbers, input ports, output ports and/or 
input/output ports is prohibited.
(The same symbol can be defined for two or more local flags/ports that are each used in a different 
program.)

[6] Definition of the same symbol for two or more integer variable numbers and/or real variable 
numbers is prohibited.
(The same symbol can be defined for two or more local variables that are each used in a different 
program.)

[7] Definition of the same symbol for two or more integer constants and/or real constants is prohibited. 

(3) Number of symbol definitions: Up to 2,000

(4) Number of symbol uses allowed in commands: Up to 20,000
* Defining the input condition, operands 1 and 2 and output in a step all using symbols is equivalent to 

four symbol uses in one step.



9.
 S

ym
bo

l E
di

t W
in

do
w

152 ME0398-6E

9.2 Explanation of the Symbol Edit Window
(1) Click Symbol (Y) from the menu bar, and then select Edit (E). 
(2) The symbol edit window (Edit Symbol) will open. 

Save to File
Clicking this button will open a dialog box where you can save the parameter data to a file under a 
desired name.

Caution: X-SEL-P/Q applicable for increased memory capacity, PX/QX (equipped with the 
gateway feature) and SSEL controllers are not capable of saving the symbols in 
Program No. 65 and after and Position No. 4001 and after in "Symbol File Format 1" 
in the normal format.
Save them in "Position File Format 2" in the extension format.

Transfer to Controller
Clicking this button will transfer the parameter data to the controller. 

Print
Clicking this button will print the parameter data.

Fig. 9.1 Symbol Edit

* The above symbol edit window is for integer variables. You can display other symbols by clicking each 
category tab.

(3) Right-click in the symbol edit window will display the pop-up menu which has the options of Cut (T), 
Copy (C) and Paste (P).
The cut or copied data can be pasted only in the symbol edit window. (The data cannot be pasted in the 
other windows such as the program edit window and position data edit window.)



9. Sym
bol Edit W

indow

152 ME0398-6E

9.2 Explanation of the Symbol Edit Window
(1) Click Symbol (Y) from the menu bar, and then select Edit (E). 
(2) The symbol edit window (Edit Symbol) will open. 

Save to File
Clicking this button will open a dialog box where you can save the parameter data to a file under a 
desired name.

Caution: X-SEL-P/Q applicable for increased memory capacity, PX/QX (equipped with the 
gateway feature) and SSEL controllers are not capable of saving the symbols in 
Program No. 65 and after and Position No. 4001 and after in "Symbol File Format 1" 
in the normal format.
Save them in "Position File Format 2" in the extension format.

Transfer to Controller
Clicking this button will transfer the parameter data to the controller. 

Print
Clicking this button will print the parameter data.

Fig. 9.1 Symbol Edit

* The above symbol edit window is for integer variables. You can display other symbols by clicking each 
category tab.

(3) Right-click in the symbol edit window will display the pop-up menu which has the options of Cut (T), 
Copy (C) and Paste (P).
The cut or copied data can be pasted only in the symbol edit window. (The data cannot be pasted in the 
other windows such as the program edit window and position data edit window.)

ME0398-6E 153

(4) A symbol character string can be dragged and dropped between the symbol edit window and program 
edit window.
By dragging a symbol character string on the symbol edit window while pressing the Ctrl key and then 
dropping it into any cell of Cnd, Operand 1, Operand 2 and Pst, the symbol character string can be 
copied.
The reverse operation (drag & drop operation from the program edit window to the symbol edit window) 
is also available.

Fig. 9.2 Symbol Edit Window                       Fig. 9.3 Program Edit Window

In the coordinate system definition data edit window, clicking Edit (E) from the menu bar and then 
selecting Undo (U) can cancel up to the most recent 10 input operations.
Alternatively, pressing the Ctrl key and Z key simultaneously can cancel the operations.
However, the cancel function will become disabled when any of the following operations is performed: 
 Transfer of data on the edit screen to the controller 
 Saving data on the edit screen to a file 
 Closing of the edit screen 

When this operation is performed, the warning screen in Fig. 9.4 will be displayed. 
Clicking Yes will cancel the operation executed immediately before.

Fig. 9.4 Warning
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* Setting in binary and hexadecimal numbers is available in the definition value for the integral constants.

Fig.9.5 2 Setting with Binary and Hexadecimal Systems

[How to set up]
When using the binary numbers, apply “&B” at the top of the value.
When using the hexadecimal numbers, apply “&H” at the top of the value.
Eight digits can be input at maximum for binary and hexadecimal numbers.
* In the operand to input the axis pattern (the operand input values in binary system), do not apply “&B” at 

the top to input with the binary numbers.
* Binary numbers are treated as an integer with no signal.
(e.g. &B11111111 = 255)

* Hexadecimal numbers treated as an integer with a symbol.
(e.g. &HFFFFFFFF = -1)

(5) The remaining number of symbols in the command available for use can be checked in the main window 
and program number select window.

Fig.9.6 Display of Remaining Number of Symbols in Command Available for Use (Main Window)

Fig.9.7 Display of Remaining Number of Symbols in Command Available for Use (Program Number Select 
Window)
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9.3 Saving Symbol Data and Closing the Edit Window
(1) Saving to a file the symbol data you are editing 

Click Save to File in the symbol edit window.
This is the same as clicking File (F) and then selecting Save As (A). 
After clicking Save to File, File Save Select screen will be displayed.
Select “Format 2”.

Fig. 9.8 File Save Select Screen

(2) Transferring to the controller the symbol data you are editing You can save the symbol data you are 
editing to the controller’s memory. 
Click Transfer to Controller in the symbol edit window. 
This button is selectable only in the online edit mode. 

 (3) Writing to the flash ROM
Once the symbol has been transferred to the controller, the following confirmation dialog box with the 
message, “Write Flash ROM?” will be displayed.

Fig. 9.9 Confirmation

Click and select a desired item (Symbols, etc.) to write to the flash ROM.
Click Yes → The memory data will be written to the flash ROM.
Click No → The memory data will not be written to the flash ROM. 

If No is selected, the controller will clear all data in its memory after a reset (i.e., after the 
controller power is reconnected or a software reset is executed), and then load the data 
from the flash ROM. (The controller will operate in accordance with the transferred data 
until a reset is executed.) 

* The number of writing to the flash ROM is limited (approx. 100,000 times). If you do not write all the 
data, select Write Selected Data Region and write to the flash ROM.

Caution: If you click "Always save with 
Format 2", files will be always 
saved with Format 2. And this 
screen won’t be displayed after 
that. It can be displayed again by 
setting in the Environment Setup 
screen (12. Tool).
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(4) Closing the symbol edit window 
Attempting to close the symbol edit window will display the following confirmation dialog box with the 
message, “Save edited data in the Controller?” 

Fig. 9.10 Confirmation

Yes The edited data will be transferred to the controller.
No The software will close the symbol edit window without saving the edited data. 
Cancel The software will cancel the operation and return to the symbol edit window.

(Note) If a symbol in use in SEL program gets deleted or changed, 44C "Symbol Searching Error" could 
occur when the SEL program is executed.
In such a case, have the SEL program that refers the deleted or changed symbol transferred  
again to the controller.
* In case the error would not be cleared, it may be necessary to edit the SEL program again.

* Symbol edit is available also in the following windows.

[1]  Conduct the following operations, and the symbol input dialog should appear.

Window Name Editable Symbols How to Show

Position Edit Window
(Offline Edit) Position Number

Right-click on the position data 
while in symbol display -> select 
“Symbol Edit (&E)” in the right-
click menu

Program Number Select Window 
(Edit, Copy/Move, Clear) Program Number

Right-click on the program 
information -> select “Symbol 
Edit (&E)” in the right-click menu

Tree View Program Number
Right-click on the program 
number -> select “Symbol Edit 
(&E)” in the right-click menu

Input Port Monitor Input Port
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu

Output Port Monitor Output Port
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu

Input and Output Port Monitor Input and Output Port
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu

Integer Variables Monitor Integer Variables
Right-click on the monitor -> 
select “Symbol Edit” in the right-
click menu

Real Variables Monitor Real Variables
Right-click on the monitor -> 
select “Symbol Edit” in the right-
click menu

Flag Monitor Flag
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu
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(4) Closing the symbol edit window 
Attempting to close the symbol edit window will display the following confirmation dialog box with the 
message, “Save edited data in the Controller?” 
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Yes The edited data will be transferred to the controller.
No The software will close the symbol edit window without saving the edited data. 
Cancel The software will cancel the operation and return to the symbol edit window.

(Note) If a symbol in use in SEL program gets deleted or changed, 44C "Symbol Searching Error" could 
occur when the SEL program is executed.
In such a case, have the SEL program that refers the deleted or changed symbol transferred  
again to the controller.
* In case the error would not be cleared, it may be necessary to edit the SEL program again.

* Symbol edit is available also in the following windows.

[1]  Conduct the following operations, and the symbol input dialog should appear.

Window Name Editable Symbols How to Show

Position Edit Window
(Offline Edit) Position Number

Right-click on the position data 
while in symbol display -> select 
“Symbol Edit (&E)” in the right-
click menu

Program Number Select Window 
(Edit, Copy/Move, Clear) Program Number

Right-click on the program 
information -> select “Symbol 
Edit (&E)” in the right-click menu

Tree View Program Number
Right-click on the program 
number -> select “Symbol Edit 
(&E)” in the right-click menu

Input Port Monitor Input Port
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu

Output Port Monitor Output Port
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu

Input and Output Port Monitor Input and Output Port
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu

Integer Variables Monitor Integer Variables
Right-click on the monitor -> 
select “Symbol Edit” in the right-
click menu

Real Variables Monitor Real Variables
Right-click on the monitor -> 
select “Symbol Edit” in the right-
click menu

Flag Monitor Flag
Right-click on the monitor while in 
symbol display -> select “Symbol 
Edit (&E)” in the right-click menu
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[2]  Input a symbol name and click OK. 
The symbol that was input should be transferred to the controller.

Fig. 9.11 Symbol Name Input

[3]  Flash ROM writing window opens.
Put a check mark at Symbol and click Yes. 
It should be reflected also to the symbol edit window.

Fig. 9.12 Flash ROM Writing Window.

* If you click No to cancel writing, the symbol setting should get back to that before change after the 
power is turned off or controller reset is performed.
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10. Coordinate System Definition Data Edit Window
10.1 Explanation of Coordinate System Definition data Edit Window

Edit of the coordinate system definition data can be performed for the 6-axis cartesian robot. 

Fig. 10.1 Coordinate System Definition Data Edit Screen

(1) Click Coordinate System (D) from the menu bar, and then select Edit (E). 
In the coordinate system definition data edit window, clicking Edit (E) from the menu bar and then 
selecting Undo (U) can cancel up to the most recent 10 input operations. 
Alternatively, pressing the Ctrl key and Z key simultaneously can cancel the operations. 
However, the cancel function will become disabled when any of the following operations is performed: 
 Transfer of data on the edit screen to the controller 
 Saving data on the edit screen to a file 
 Closing of the edit screen 

When this operation is performed, the warning screen in Fig. 10.2 will be displayed. 
Clicking Yes will cancel the operation executed immediately before.

Fig. 10.2 Warning
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10.2 Work Coordinate System

The work coordinate system (X, Y, Z, Rx, Ry and Rz) should be defined by the offset against the base 
coordinate system.

Fig. 10.3 Work Coordinate System

1st Axis

2nd Axis

3rd Axis

Base Coordinate System

Work Coordinate System

(Xofw, Yofw, Zofw)
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coordinate system.

Fig. 10.3 Work Coordinate System

1st Axis

2nd Axis

3rd Axis

Base Coordinate System

Work Coordinate System

(Xofw, Yofw, Zofw)

ME0398-6E 161

The edit window should be as shown below.

Fig. 10.4 Work Coordinate System Offset Setting Window

The content of each edit item is as stated below.

<Work Coordinate System Offset>
No. Work coordinate system number should be shown.
X[mm] Input the offset value of the X-axis to the base coordinate.
Y[mm] Input the offset value of the Y-axis to the base coordinate.
Z[mm] Input the offset value of the Z-axis to the base coordinate.
Rx[deg] Input the rotation angle around the X-axis on the base coordinate.
Ry[deg] Input the rotation angle around the Y-axis on the base coordinate.
Rz[deg] Input the rotation angle around the Z-axis on the base coordinate.
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10.3 Tool Coordinate System

(1) Mechanical Interface Coordinate System
It is the orthogonal coordinate system (Xm, Ym and Zm) that has the datum at the center of the T-axis 
(6th axis) tool attachment surface.
With the T-axis rotation axis defined as Zm-axis, the line connecting the center of the tool attachment 
surface and the positioning hole should be the Ym-axis. The positive direction of the Ym-axis should be 
the opposite to the direction from the center to the positioning hole. The point of crossing with the center 
of the tool attachment surface should be the origin of the Xm-axis, Ym-axis and Zm-axis.

Fig. 10.5 Mechanical Interface Coordinate System

[0] X-Y-Z-R-(B-T) [1] X-Z-Y-R-(B-T)

Ym

Xm

0
0 0

0

Yb Yb
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Xb XbXm

Zm
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ZbZb

1st Axis

3rd Axis

3rd
Axis

2nd Axis

Mechanical
Interface Coordinate System

Mechanical
Interface Coordinate System
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Base Coordinate System Base 
Coordinate System

Positioning Hole

Direction of Mechanical Interface Coordinate

2nd
Axis



10. C
oordinate System

 D
efi nition D

ata Edit W
indow

162 ME0398-6E

10.3 Tool Coordinate System

(1) Mechanical Interface Coordinate System
It is the orthogonal coordinate system (Xm, Ym and Zm) that has the datum at the center of the T-axis 
(6th axis) tool attachment surface.
With the T-axis rotation axis defined as Zm-axis, the line connecting the center of the tool attachment 
surface and the positioning hole should be the Ym-axis. The positive direction of the Ym-axis should be 
the opposite to the direction from the center to the positioning hole. The point of crossing with the center 
of the tool attachment surface should be the origin of the Xm-axis, Ym-axis and Zm-axis.

Fig. 10.5 Mechanical Interface Coordinate System

[0] X-Y-Z-R-(B-T) [1] X-Z-Y-R-(B-T)

Ym

Xm

0
0 0

0

Yb Yb

Ym

Ym

Xb XbXm

Zm

Zm

ZbZb

1st Axis

3rd Axis

3rd
Axis

2nd Axis

Mechanical
Interface Coordinate System

Mechanical
Interface Coordinate System

1st Axis

Base Coordinate System Base 
Coordinate System

Positioning Hole

Direction of Mechanical Interface Coordinate

2nd
Axis

ME0398-6E 163

(2) Tool Coordinate System
The tool coordinate system (X, Y, Z, Rx, Ry and Rz) should be determined by the offset against the 
mechanical interface coordinate system. If all the offsets are 0, it should be same as the mechanical 
interface coordinate system.

Fig. 10.6 Tool Coordinate System
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The edit window should be as shown below.

Fig. 10.7 Tool Coordinate System Offset Setting Window

The content of each edit item is as stated below.

<Tool Coordinate System Offset>
No. Tool coordinate system number should be shown.
X[mm] Input the offset value of the X-axis to the mechanical interface coordinate.
Y[mm] Input the offset value of the Y-axis to the mechanical interface coordinate.
Z[mm] Input the offset value of the Z-axis to the mechanical interface coordinate.
Rx[deg] Input the rotation angle around the X-axis on the mechanical interface 

coordinate.
Ry[deg] Input the rotation angle around the Y-axis on the mechanical interface 

coordinate.
Rz[deg] Input the rotation angle around the Z-axis on the mechanical interface 

coordinate.
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The edit window should be as shown below.

Fig. 10.7 Tool Coordinate System Offset Setting Window

The content of each edit item is as stated below.

<Tool Coordinate System Offset>
No. Tool coordinate system number should be shown.
X[mm] Input the offset value of the X-axis to the mechanical interface coordinate.
Y[mm] Input the offset value of the Y-axis to the mechanical interface coordinate.
Z[mm] Input the offset value of the Z-axis to the mechanical interface coordinate.
Rx[deg] Input the rotation angle around the X-axis on the mechanical interface 

coordinate.
Ry[deg] Input the rotation angle around the Y-axis on the mechanical interface 

coordinate.
Rz[deg] Input the rotation angle around the Z-axis on the mechanical interface 

coordinate.
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10.4 Simple Interference Check Zone

It is a feature to avoid interference by external output and error output when the tip of a tool (center of flange 
surface when Tool Coordinate System No. 0 selected) gets into the simple interference check zone.
It will not detect any invasion of any parts other than the tip of a tool.

The edit window should be as shown below.

Fig. 10.8 Simple Interference Check Zone Definition Coordinate Setting Window
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The content of each edit item is as stated below.

<Simple Interference Check Zone Coordinate Definition>
Zone Number Zone number should be displayed.
Coordinate Number Coordinate number should be displayed. There 

are Coordinate 1 and Coordinate 2.
X[mm] Input the interference zone data of the X-axis.
Y[mm] Input the interference zone data of the Y-axis.
Z[mm] Input the interference zone data of the Z-axis.
Physical/Extension 
Output Port Number/
Global Flag Number

Input the output port / flag number when getting 
into the check zone.

Error Type Select the error type.
0 = Error not to be processed
1 = Error output in message level
2 = Error output in operation cancel level

[Supplementary]
 There is no change to how to operate in the coordinate system definition data edit window.
 In RSEL, the effective ranges of the work coordinate system numbers and tool coordinate system numbers 

are different from other models.
 Work coordinate system definition numbers: 0 to 15, Tool coordinate system definition numbers: 0 to 15
 There is no difference to the simple interference check zone numbers from other models.

●X, Y, Z
Set the values for the space diagonal points on a rectangular parallelepiped on the base coordinates to 
Coordinate 1 and Coordinate 2.

Fig. 10.9 Simple Interference Check Zone

●Output Port / Global Flag Numbers
Set the values for 300 to 599 / 4000 to 6999 / 600 to 899.
If there are values set, signal turns on while the tip of the 6-axis cartesian robot tool is in the zone and off 
when out of the zone.

●Error Type
Establish the setting from:
0 = No error process while in the zone
1 = Message level error while in the zone
2 = Operation cancel level error while in the zone

Coordinate 1

Coordinate 2

Interference Check Zone 1

Indicate space diagonal points on
rectangular parallelepiped
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The content of each edit item is as stated below.

<Simple Interference Check Zone Coordinate Definition>
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Coordinate Number Coordinate number should be displayed. There 

are Coordinate 1 and Coordinate 2.
X[mm] Input the interference zone data of the X-axis.
Y[mm] Input the interference zone data of the Y-axis.
Z[mm] Input the interference zone data of the Z-axis.
Physical/Extension 
Output Port Number/
Global Flag Number

Input the output port / flag number when getting 
into the check zone.

Error Type Select the error type.
0 = Error not to be processed
1 = Error output in message level
2 = Error output in operation cancel level

[Supplementary]
 There is no change to how to operate in the coordinate system definition data edit window.
 In RSEL, the effective ranges of the work coordinate system numbers and tool coordinate system numbers 

are different from other models.
 Work coordinate system definition numbers: 0 to 15, Tool coordinate system definition numbers: 0 to 15
 There is no difference to the simple interference check zone numbers from other models.

●X, Y, Z
Set the values for the space diagonal points on a rectangular parallelepiped on the base coordinates to 
Coordinate 1 and Coordinate 2.

Fig. 10.9 Simple Interference Check Zone

●Output Port / Global Flag Numbers
Set the values for 300 to 599 / 4000 to 6999 / 600 to 899.
If there are values set, signal turns on while the tip of the 6-axis cartesian robot tool is in the zone and off 
when out of the zone.

●Error Type
Establish the setting from:
0 = No error process while in the zone
1 = Message level error while in the zone
2 = Operation cancel level error while in the zone

Coordinate 1

Coordinate 2

Interference Check Zone 1

Indicate space diagonal points on
rectangular parallelepiped
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●Caution
 If the operation cancel level error while in the zone is selected, the robot will decelerate and stop after the 

tool tip gets into the simple interference check zone, thus the position where the robot actually stops 
should be in the zone. It is recommended to have the zone range set relatively large considering the size 
of the tool and the distance to decelerate and stop.

 The simple interference check zone gets valid after the absolute coordinates are confirmed.
Note that the interference check will not be held when the absolute coordinates are not confirmed.

 The frequency of invasion monitor is 5ms.
There may be a case that the invasion cannot be detected if the tool tip stays in the zone for 5ms or more.
It is recommended to have the zone range set relatively large considering the size of the tool and the 
duration not detected. There may be a case that it takes 5ms before the change to the simple interference 
check zone setting gets reflected. It is recommended to have the robot stopped while in the simple 
interference check zone setting change.

 The tool tip that the invasion monitor is to be conducted should be determined by the tool coordinate 
system definition data and currently selected tool coordinate system number. It is mandatory to have the
tool coordinate system definition data and currently selected tool coordinate system number set properly.
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  Fig. 10.11 Warning

10.5 Coordinate System Definition Data Clear Window

The procedure to delete coordinate system definition data is explained below: 

[1] Click Coordinate System (D) from the menu bar, and then select Clear (L). 
[2] The coordinate system definition data clear window will be displayed.

Fig. 10.10 Coordinate System Definition Data Clear

Select the type of coordinate system data you 
wish to delete. 
Next, click OK. 
A warning message will be displayed to confirm 
if you really want to delete the data. 
Click OK. 
The data will be transferred to the controller.
Clicking Cancel will cancel the operation.

Click in the applicable checkbox to select 
the type of data you wish to delete.
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10.6 Printing of Coordinate System Definition Data

The procedure to print coordinate system definition data is explained below. 

[1] Click in the menu if the coordinate system data definition edit window. 
[2] Select whether to print all types or the coordinate system data being displayed.

Fig. 10.13 Print Type Selection

[3] The coordinate system definition data will be printed in accordance with the selected content.
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11. Monitor
You can check the current statuses of various items from the Monitor menu. 

(1)  Task status monitor window
This window shows the statuses of running programs.

Fig. 11.1 Task Status
No.: Task No.
Prg: Program No.
Sts: Task status

Task status managed by the internal OS.
 RUN (Run) : Being executed
 RDY (Ready) : The task is ready to be performed.
 WAT (Wait) : The task is suspended.
 WAS (Wait Suspend) : Double Suspension
 SUS (Suspend) : Compulsory Suspension
(Supported by main application version 0.14 or later for X-SEL J/K, and all versions for other controllers.)  
(PC software version 0.0.7.2. or later) 

Lvl: Task level
Step: Program executed step number
AGRP: Axes group number indication current value
Stp: While in execution stop command (0 or 1)
W: Waiting (in response to the TIMW, WTxx, WZxx, WRIT or READ command, waiting for a servo 

command to be completed, etc.) (0 or 1)
H: HOLD input (0 or 1)
C: CANC input (0 or 1)

(2)  System status monitor window

Fig. 11.2 System Status

The current operation mode is 
displayed. (MANUAL, AUTO) 

Of the errors currently occurring, the 
most serious level system error number 
is displayed. 

Of the errors currently occurring, the 
latest system error number is 
displayed. 

Various statuses are displayed.



11
. M

on
ito

r

172 ME0398-6E 

(3) Axis status monitor window
This window shows the status of each axis.

Fig. 11.3 Axis status monitor

Select axes group number to be monitored 
(Displayed only when Axes Group No. 2 is available)

Displayed only when there is 6-axis cartesian robot
in axis setting

Error detected by driver 
unit to be displayed

Error detected by controller 
to be displayed

Displayed only when there is 
6-axis cartesian robot
in axis setting
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(4) Input port, virtual input port, output port and virtual output port windows
These windows show the ON/OFF status of each input/output. 1: ON, 0: OFF
The physical ports and extension ports can be monitored in one window.

Fig. 11.4 Input Ports

Fig. 11.5 Output Ports

The 1/0 (ON/OFF) of output ports and virtual output ports can be switched by double-clicking the 
applicable port or pressing the Ctrl key and space key simultaneously.

Physical Port Area

Extension Port Area

Physical Port Area

Extension Port Area
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The virtual input/output port No. 7000 to 7599 are shown all together.
Refer to [SEL Language Programming Manual] for the assignment of the virtual input/output ports
The display on the right will be shown when a tick mark is put in the “Symbol” box, and the display on the left 
will be shown when a tick mark is removed.

   

(Note) A48 “Virtual Input/Output Port Operation Error” will occur if the ON/OFF of the input ports in 
Virtual Input/Output Port No. 7000 to 7599 are switched over.

Fig. 11.6 Virtual Input/Output 
Ports (with Symbol display)

Fig. 11.7 Virtual Input/Output 
Ports (No Symbol display)
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An ON filter has 
been set for this port.

In the input port window, you can set an input port debug filter.
“Input port debug filter” is a function that causes the controller to recognize a given physical input port as 
ON or OFF regardless of the actual input status of the physical input port.

To set a debug filter, use the following four buttons provided on the Debug filter setting panel in the input 
port window (available in the MANUAL mode). 
[1] ON

Clicking this button will set an ON filter for the input port corresponding to the cursor position.
The controller will always recognize the specified port as ON. 

[2]  OFF 
Clicking this button will set an OFF filter for the input port corresponding to the cursor position.
The controller will always recognize the specified port as OFF. 

[3] CLR
Clicking this button will clear the debug filter currently set for the input port corresponding to the 
cursor position. 

[4] ACLR
Clicking this button will clear the debug filters currently set for all physical input ports. 
* While a debug filter is set, the status of the port (“0” or “1”) for which the ON or OFF filter is set will 

be shown in red (all ports for which a debug filter is not set will be shown in black). 

Fig. 11.8 Input Port Window

Clicking CLR or ACLR will display the warning message shown in Fig. 11.9. 
Select Yes (clear the filter(s)) or No (cancel the clear) after carefully reading the content of the 
message.

Buttons on the Debug filter 
setting panel (from left): 
[1] ON (Set an ON filter) 
[2] OFF (Set an OFF filter) 
[3] CLR (Clear a filter) 
[4] ACLR (Clear all filters) 

Port number selection 
cursor
(Port No. 53 is selected 
in this example.) 

An OFF filter has 
been set for this port.
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Fig. 11.9 Warning Message

The status (ON/OFF) of each input port as recognized by the controller changes the moment the 
debug filter is cleared or controller operation mode (MANUAL or AUTO) is changed. 

(1)  Upon clearing a filter
Actual input status

Filter type ON OFF 

ON ———— ON → OFF
OFF OFF → ON ————

(2)  Upon switching the controller mode from MANUAL to AUTO
Actual input status

Filter type ON OFF 

ON ———— ON → OFF
OFF OFF → ON ————

(3) Upon switching the controller mode from MANUAL to AUTO and then back to MANUAL
Actual input status

Filter type ON OFF 
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If any function is assigned to an input port, the applicable process will be executed. Exercise caution 
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controller

Note
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Fig. 11.9 Warning Message
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(5)  Global flag, global integer variable, global real variable and global string windows

Fig. 11.10 Global

You can change the values in global variables or assign values to global variables.
You can also change the characters in global strings or assign characters to global strings.
The 1/0 (ON/OFF) of global flags can be switched by double-clicking the applicable global flag or 
pressing the Ctrl key and space key simultaneously. 

In the integer variable monitor, select Decimal or Hexadecimal for the data radix.
(Select it from the combo box at the top of the window.) 

Fig. 11.11 Decimal Notation             Fig. 11.12 Hexadecimal Notation
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Select “Move to Indicated Variable (Flag) Number” in the right-click menu in each variable monitoring window 
or press Ctrl+G keys, and the variable (flag) number shown at the top of the window should change.

The window to input the top variable (flag) number should be displayed.
Input the top variable (flag) number and click Move button, and cursor should move to the input variable 
(flag) number.
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Activate “Displayed only in character strings” in the String Variable window, and the number of characters to 
be shown in one line should increase to 100 characters, however, the variables in each column number 
should be hidden.
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(6) Local Data
Select “Monitor (M)” → “Local Data (B)” in the main menu and the Show Local Data window opens.
The Program No. selected in the Show Local Data window and the local data in the Category of Local 
Data are displayed.

Fig. 11.13 Show Local Data Window

Select the Program No. to the local data and the Category of Local Data by following the steps below to 
show the local data.
1) Selection of Program No.

Select a Program No. from the Selectable Program No. and click on it. The background color of the 
Selectable Program No. turns into blue. Click  > . The data will be displayed in the Selectable Program 
No..

2) Selection of Category of Local Data
Click in the box □ for the item to be displayed from the Category of Local Data. A tick mark  will be 
shown in the selected box.
(Click again to remove the tick mark  and cancel the selection.) 
Click Batch selection to select all the selectable items at once.
(Click Batch release to make all the selected ones cancelled.)

3) Click Show and the local data display window will be shown.
(Click (Hide) and the display window will be hidden.)
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All are shown at once at the first time one on top of another.

Fig. 11.14 Local Data Display Window (display at first time)

Drag one by one from the top to bottom and show all in the screen.

Fig. 11.15 Local Data Display Window

11. M
onitor

Numbers in the brackets 
[ ] show the program 
numbers.
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(7)  Detailed error information
Clicking Monitor (M) from the main menu and then selecting Detailed Error Information (E) will display 
the Error Number Select screen.
Clicking OK after setting the Error Number Select will display the Detailed Error Information screen.

Fig. 11.16 Error Number Select Screen
When errors occur, error codes, messages and other information will be displayed.

Fig. 11.17 Detailed Error Information

(Note) If date & time data is lost, the following error occurs. In this case, the date & time data becomes 
2000/01/01 00:00:00. 

Fig. 11.18 Error Display

Save the error list in a file. (CSV format)*
Print the error list.

Update the error list to the latest one.
Clear the error list.

Program No.rogram No.rogram No.
Step No.

pdate the error list to the latest one.
Axis Number in Axes Group

Driver Unit No.Driver Unit No.
Driver Number in Driver UnitDriver Number in Driver Unit

Position No.

Info. 1 to Info. 4 is
information for our company 
to analyze
error causes.
(The contents vary 
depending on the error No.) 

Error Occurrence Time
Error messagerror messagerror message

Error code
The smaller the number is, the more recently the error occurrex.
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(Note) Refer to [12.6 Setting Time] for how to set the internal clock of the controller. 
(Note) When bits 0 to 3 of Other parameter No. 47, “Other setting bit pattern 2” are set to 2, (Do not 

use the calendar function (use the elapsed time after the reset)), the header of the time of error 
column becomes “After Reset (elapsed time after the reset).”
(The factory default for bits 0 to 3 of Other parameter No. 47, “Other setting bit pattern 2” is 1 
(Use the calendar function).)

* When trouble occurs, you may be requested to send the error list saved in a file to resolve the problem 
at an early stage. The error list file cannot be opened by this PC interface software.

The     (Information on birth time) button is enabled only when SCON2 driver alarms are displayed.
Clicking the    button displays the information at the time of alarm for the error currently selected in 
the alarm list.

* Information at the time of alarm occurrence cannot be displayed when error No. FFF is selected.
(   button becomes invalid.)

↓
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(8) Maintenance information screen  
The total number of times the actuator has moved, and total distance travelled by the actuator, are 
displayed.
Also, the pairing I.D. of the battery-less absolute encoder can be cleared in this window.
Refer to [How to Clear Paring ID] in this section.

Fig. 11.19 Maintenance Information Monitor (RSEL)

There is no change to the tool button specifications.

[Monitored Items when RSEL Connected]
Total movement count : It shows the sum of the number of actuator movement.
Threshold of total movement count : It shows the setting value of the total number of movement.
Total mileage [km] : It shows the sum of the actuator drive distance.
Threshold of total mileage [km] : It shows the setting value of the total drive distance.
Overload Warning Level : With the motor assumed raising temperature to cause overload 

alarm as 100%, the overload warning should be generated 
when the motor temperature exceeds the ratio set in this item.

Fan Total Driving Time : In this, displays the total driving time of the fans on the 
controller and driver unit.

Actuator Replaced Date & Time : In this, displays the date and time when the actuator was 
replaced.

Driving Distance after Grease Supply : The sum-up of the driving distance of an actuator after grease 
was supplied should be displayed.

Grease Supplied Date & Time : In this, displays the date and time when grease was supplied.

“Fan Total Driving Time” for the controller is to be displayed only when a fan is connected to the controller.
“Actuator Replaced Date & Time”, “Driving Distance after Grease Supply” and “Grease Supplied Date & 
Time” are to be displayed only when both the driver unit and actuator support the actuator recognition 
feature.

Select axes group number / axis to be monitored.
(Axes group number tabs should be displayed only when Axes Group No. 2 is valid)
Select Controller and the maintenance information of the controller should be shown.

Unit to display total drive distance can be switched here.

Transfer the data of entered new 
values to the controller.

Save the maintenance 
information data to a file 
(CSV format).

Print the maintenance 
information data.
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[Caution in Total Drive Distance Unit]
When the total drive distance display unit is in [km], the number below the decimal point should be 
rounded down.
(eg.: When the actual total drive distance is 3,600 [m]. The display in the widow should show 3 [km])
Also, when the total drive distance display unit is in [km], the total drive distance setting in the 
maintenance information window should be in km unit.
(eg.: when the total drive distance setting before change is 3,500 [m], and if the total drive distance 
setting in the maintenance information window (total drive distance display unit: [km]) is set to 3 [km], 
the total drive distance setting after change should become 3,000 [m])
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[Features of Buttons Displayed when RSEL Connected]
Information Initialization : The maintenance information data should be initialized.

(Displayed only when there is an error in maintenance 
information data)

Pairing ID Clear : The pairing ID to the battery-less absolute encoder should be 
cleared.
(Valid only when password 5119 is valid and battery-less 
absolute encoder is mounted)

Fan Replacement : The fan total driving time should be reset.
(Valid only when “Fan Total Driving Time” is in display)

Actuator Replacement : The total number of driving times and total driving distance 
should be reset and the actuator replaced date and time should 
be updated.

Grease Supply : The driving distance after grease supply should be reset and 
the grease supplied date and time should be updated.
(Valid only when “Driving Distance after Grease Supplied” and 
“Grease Supplied Date & Time” are displayed)

By setting the values for the total number of movements and total distance travelled, you can notify an 
external device, by means of a message level error or output signal that each setting value has been 
exceeded. (Alert function)

[How to establish setting values in alert function]
Method 1: 
Change Axis Parameter No. 20 “Total Number of Driving Times Setting”, Driver Unit Parameter No. 148 
“Total Driving Distance Setting” and Driver Unit Parameter No. 143 “Overload Warning Load Level 
Ratio” in the parameter edit window.

Method 2: 
Perform one of the following operations in the desired “New value” cell and enter a new setting value:

• Double-click the cell. 
• Press the “Ctrl” and “Space” keys together. 
• Press a number key. 

When the new setting value has been entered, click to transfer the new setting value to the 
controller.

When the transfer to the controller is complete, the confirmation message, “Write Flash ROM?” appears. 

Fig. 11.20 Confirmation
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Click to select the items (parameters, etc.) you want to write to the flash ROM.
Yes Write the memory data to the flash ROM. 
No Do not write the memory data to the flash ROM. 

When a reset is performed (by turning off the power and then turning it back on, or 
resetting the software), the memory data will be destroyed and data will be loaded 
from the flash ROM. (The controller will use the transferred memory data until the 
reset takes effect.) 

(Note) If a reset is performed (by turning off the power and then turning it back on, or resetting the 
software) without writing the parameters to the flash ROM first, the threshold under the alert 
function will not be changed and the value set before the change will be restored. 

(Note) The flash ROM can be written only for so many times (approx. 100,000 times). 
Unless all data are written, select “Write the selected data areas” before writing to the flash 
ROM. 

When the flash ROM has been written, the confirmation message, “Restart the controller?” appears. 

Fig. 11.21 Confirmation
Yes Restart the controller (reset the software). 
No Do not restart the controller (reset the software). 

When the flash ROM has been written, the confirmation message, 
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[How to Clear Pairing ID] 
(1) Right-click a blank space in the tool bar while pressing the Ctrl button. The Input Password will be 

displayed. 

Fig. 11.22 Menu Bar

Fig. 11.23 Input Password Screen
(2) Enter a password (5119) in the displayed Input Password screen. Clear Pairing ID will show up in 

the bottom of Maintenance Information screen.
Click Clear Pairing ID, and the pairing ID for the battery-less absolute encoder will be cleared.

Fig. 11.24 Maintenance Information

Or, “Clear Pairing ID” will show up to the menu in Controller in Menu. 
Select “Pairing ID Clear” and the pairing ID clear window for the battery-less absolute encoder 
should appear.

Right-click a blank space in the 
tool bar while pressing Ctrl. 
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(9) Monitoring data
The servo monitoring window in RSEL applies the system to indicate the monitoring target axes and 
data types in the channel (CH).

Fig. 11.25 Servo Monitoring Window (when RSEL connected)

<Procedure for Monitoring> 

1) Select “Monitor Registration” tab in the servo monitoring window.

2) Set the monitoring items for each channel.
Select [CH1-CH16] tab when establishing setting for CH1 to CH16.
Select [CH17-CH32] tab when establishing setting for CH17 to CH32.

Fig. 11.26 Monitor Registration Window
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[Validity]
Put a check mark on the channels to monitor.

[Monitoring Type]
Select “Axis Monitor” when the axis data is to be monitored.
Select “I/O Monitor” when the I/O data is to be monitored.

[Axis Group Number]
Select axis group numbers of axes to monitor.
* Valid only when “Axis Monitor” selected in “Monitoring Type”
* Not displayed when Axis Group No. 2 is invalid

[Target Axis]
Select an axis number of an axis to be monitored.
* Valid only when “Axis Monitor” selected in “Monitoring Type”

[Data Type]
Select axis data to be monitored.
* Valid only when “Axis Monitor” selected in “Monitoring Type”

The following data is available for monitoring in RSEL.

Table: List of Monitoring Data Type

Data Type Data Detail
Servo Monitoring Window 

Output Unit
(When Output Magnification ×× 1)

Operation Amount Original command pulse count or original 
command distance per sampling time PLS/ST or mm/ST 

Feedback Pulse Feedback pulse count per sampling time PLS/ST or mm/ST
Position Deviation Position Deviation PLS or mm
Current Command Motor current command value Rated ratio (100% = 4,096) (*)

Feedback Current

Motor feedback current
[Note] 
Monitoring is not available on an axis 
connected to the driver unit RCON-PC/PCF. 
(Monitoring value should always be 0)

Rated ratio (100% = 4,096) (*) 

Current Position Current position for each axis PLS or mm
Command Position Command position for each axis PLS or mm
* Displayed with rated ratio 100% = 4,096 as standard.

Rated Ratio [%] = Displayed Value / 4,096 × 100

[I/O Type]
Select the I/O data type to be monitored.

IN : Input Port
OUT : Output Port
IN/OUT : Virtual Input and Output Port
FLG : Global Flag (Local flag not available to monitor)

 * Valid only when “I/0 Monitor” selected in “Monitoring Type”

[Top No.] 
Enter the leading number of the port/flag for the I/O data to monitor.
* Valid only when "I/O Monitor" selected in "Monitoring Type"

[No. of ports] 
Select the number of I/O points to monitor at the same time (1, 8, 16, or 32).
The selected number of points will be monitored as a single unit of data (the leading number will be 
the lowest bit).
* Valid only when "I/O Monitor" selected in "Monitoring Type"
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[Sign]
Select this to handle monitored data as signed.
* Valid only when "I/O Monitor" selected in "Monitoring Type" and a value other than "1" selected in 

"No. of I/O points"

3) Establish the setting for the sampling period (1 to 10msec) when it is required to have the buffering 
monitor.

The continuous monitoring time may vary depending on the setting for the sampling period and 
number of channels to be monitored at the same time. (More the number of simultaneously 
monitored channels are, the shorter the monitoring time gets.)

4) Select “PC Monitoring Type” in the servo monitoring window.

5) The channels registered in (2) should be displayed in “List of Registered for Monitoring”. Establish 
the setting for the graph output here.

* Eight channels should be shown in “List of Registered for Monitoring”. Select a channel to be set 
in “CH1-CH8”, “CH9-CH16”, “CH17-CH24” or “CH25-CH32” tab.

Fig. 11.27 List of Registered for Monitoring

1  is provided to put a check mark on the channels to be plotted in the graph.
2  displays the monitoring types and axis numbers registered in“Monitoring Type”.
3  shows a type of line plotted in the graph.
4  is provided to set up the output magnification when the graph is plotted.
5  is to be set the offset when the I/O data is displayed.

(Same setting as the I/O data offset in the current servo monitoring window)

6)  is to be clicked to start monitoring.6)  

5 4

1 3

2

1 3

2

1 3

2
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<Other Operations>

[Tool Buttons]

The function of each button is the same as those for the servo monitor in the XSEL PC software.

[Position / Speed Display Setting]

Select the unit for display of position / speed data (mm system or PLS system).

[PC Monitoring Setting]

Buffering : Using data that buffers on the controller side, a graph should be shown.

Non-buffering : Reading out the Data at each point of every interval set in “Polling Interval”, a graph 
should be shown.

* There is no “Synthesis Rate” or “Movement Average Period” setting in the servo monitoring window 
for RSEL

(10) Servo Added Data Monitor
All the servo added data that the controller supports can be monitored in one window at once.

Fig. 11.28 Servo Added Data Monitor
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(11) Power Supply Unit Information
The information regarding the power supply unit PSA-24 should be displayed.

Fig. 11.29 Power Supply Unit Information

Items Detail

Output Voltage

This power supply unit fluctuates the output voltage 
in response to the load.
The output voltage monitoring value may vary, but it 
is not an error.

Auxiliary Winding Voltage

It is the control power supply voltage inside the 
power source.
It fluctuate the output just as the output voltage 
does in response to the load on the output voltage 
side.

Peak Hold Voltage It is the peak value of the output voltage.
Output Current It is the transient value of the output current.
Peak Hold Current It is the peak value of the output current.

Load Percentage

It is the ratio of the integrated value of the output 
current and the rated output current.
If this value exceeds 100%, the overload error 
should occur and the output voltage will be cut off.

Peak Hold Load Ratio It is the mark-up percentage of the peak value.
Fan Revolution Speed It is the revolution speed of the fan.

PCB Temperature. Inside Temperature: It is the temperature around 
the secondary output capacitor.

Total Electric Conduction Time It is the total electric conduction time.

The background color should change in respond to the acquired power supply unit status.
 • Auxiliary Winding Voltage : Light green if 15V or higher, White if 10V or lower
 • Load Percentage : Light green if equipped with 330W fan, White if no 220W fan equipped
 • Fan Revolution Speed : Grey if no fan, White if fan in normal condition, Yellow shows warning, 

  Red in error
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12. Supplemental Information on Controller Menu Items
12.1 Software Reset

Selecting this menu item will restart the controller.
Caution is required because data that is not yet written to the flash ROM will be lost after this operation. Click 
Controller (C) from the menu bar, and then select Software Reset (R). 

12.2 Reset Error 

Selecting this menu item will reset message level errors and operation-cancellation level errors.
Even after selecting Reset Error, those errors whose cause has not been removed will occur again.
Click Controller (C) from the menu bar, and then select Reset Error (E). 
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12.3 Axis Setting

When the PC software gets launched with no axis setting is established, it automatically make [RSEL Axis 
Setting] dialog open.
When it is required to open the dialog from the menu, select Controller (C) → RSEL Axis Setting (G).

(1) Simple Setting
At the startup for the first time, the logical axes should be assigned in the order of the actually mounted 
physical axes in the driver unit.
If there is no need of change, press Yes. 
If it is required to assign the logical axes individually, press No. 

Fig. 12.1 Initial Startup Window

When Yes Pressed
The following message should appear. Press Yes if okay.

Fig. 12.2 Confirmation Window for Writing to Controller

Caution: When the writing to the flash ROM is conducted, initialization of the position data 
should be conducted at the same time.
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When No Pressed
The screen switches to the window shown in Fig. 11.3.
Drag the actuator figure (hereinafter described as axis figure) located in the physical axis area on the 
top of the window, drop it in the logical axis area, and the assignment of the axes can be performed.

In order to cancel the axis figure assigned in the logical axis area;
• Drag the axis figure and drop it in the physical axis area
• Select the axis figure and right-click → “Cancel Assignment” or press “Delete” key

In case of cancel all at once;
• In the logical axis area, right-click → “Cancel All Assignments”
• In the logical axis are, press “Ctrl” + “A” to select all and then press “Delete” key

Fig. 12.3 Axis Setting Rearrangement Window

Once the assignment is finished, press Confirm and the window shown in Fig. 12.2 should show up.
Press Close and the setting should be finished.

Physical axis area

Logical axis area



12
. S

up
pl

em
en

ta
l I

nf
or

m
at

io
n 

on
 C

on
tro

lle
r M

en
u 

Ite
m

s

198 ME0398-6E

(2) Explanation of Areas
◎◎Physical Area

In the physical area, there should be the driver units and already installed axis figures displayed.

Fig. 12.4 Physical Area Image (with 5 units of drivers connected)

[1] Driver Unit Type
The driver units should be shown in the order of actually installed.
SCON series should be displayed as the last driver unit always.

[2] Already Installed Axis Figures
In the figure of the already installed axis, there should be following information displayed.

A Driver Unit Number (Unit 0 to Unit 7)
B Physical Axis Number in Driver Unit (Drv 0 to Drv 1)
C Actuator Figure

(A picture showing “No Image” should be shown when 
there is no figure)

D Actuator Name
(Unknown should be shown when no name acquired)

E Axis Number Assigned to Axis Setting Status 
(Axis 1 to Axis 8)
(It should be displayed with translucent letter only 
when assignment is allocated)

Fig. 12.5 Already Installed Axis Figures

[1] Driver Unit Type

[2] Already Installed
Actuators

A B

C

D

E
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[1] Driver Unit Type

[2] Already Installed
Actuators

A B

C

D

E
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 ◎◎Logical Axis Area
In the logical axis area, the axis figures that was assigned should be displayed.
There should always be eight axis slots (Axis 1 to Axis 8), and in the slot with no axis assigned should 
show “Not Assigned”.

Fig. 12.6 Axis Setting Status

In the logical axis area, it is available to move the axis figures.

However, because there is a limit in the order of logical axes for the special functional axes, there may 
be a limit in the move of the axes. Pay special attention.

e.g.
The message shown in the frame with red dotted lines in Fig. 12.6 is an error message when it 
happened to assign the axis figure of Axis 5 to Axis 3.

  

  

Drag & Drop to Move 
among Slots
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◎◎Special Feature Axes
The special feature axis is a name of axes that special features are allocated as the function of the 
actuator.
There are three types as shown below for the special feature axes.

[1] 6-axis cartesian robot

Fig. 12.7 6-axis cartesian robot

In case of connecting the 6-axis cartesian robot, there should be some limitations as shown below:
• The logical axis numbers should be fixed regardless of the order of the driver unit mount.
• It is not available to cancel the axes assignment (move between physical axis area and logical 

axis area).
• The actuator names should be C1, C2, C3, R, B and T.
• The actuator figure should be the figure of the 6-axis cartesian robot. 

[2] Multiple Slider Axes

Fig. 12.8 Multiple Slider Axes

Regarding the multiple slider axes, drag & drop in physical axis area <=> logical axis area of an 
axis, and the paired axes (MS1-1 to MS1-4 in the case above) should also come together.

[3] Wrist Units

Fig. 12.9 Wrist Units

Regarding the wrist units, drag & drop in physical axis area <=> logical axis area of an axis, and the 
paired axis should also come together. Also, in the logical axis area, it is necessary to have the B-
axis assigned to a logical axis number lower than that for the T-axis.

MS 〇-×

Shorten Form for Multiple Slider
Combination Number
Slider Number

WU(〇)-×

Shorten Form for Wrist Unit
B: B-axis, T: T-axis
Combination Number
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 ◎◎Axes Group Setting

Fig. 12.10 Axes Group Setting

  In the axes group setting, multiple axes should be managed in the unit of “Axes Group”, and individual 
position data can be allocated to each group. With this feature, it is available to move the axes with the 
same position data when there are two axes with the same structure. Also, the position data for 
combination axes and added axes can be held separately, thus it gets easier to manage them. If there 
are two groups with a combination of three axes, it used to input using Axis 1 to Axis 6 for the position 
data. Grouping enables to have two position data for three axes. In the SEL program, declare the 
group to be used and indicate the position data to be used. Click Set Axes Group in Fig. 12.10 
above and two groups should appear in the logical axis area as shown in Fig. 12.11, and it becomes 
available to assign the axis figure to each.

 * The same axes group show the same background color in the axis figure in the physical axis area.

Fig. 12.11 Condition of 3 Axes Assigned in Axes Group 1 and 2
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12.4 SEL Programming Support Tool

The SEL programming support tool is an application that helps to create a flowchart for a program and 
performs a trial run.
Refer to [SEL Programming Support Tool Instruction Manual (ME0396)] provided separately for detail.

12.5 Drive-source Recovery Request and Operation-pause Reset Request

(1) Drive-source recovery request 
[1] How to issue a drive-source recovery request A drive-source recovery request is required only in 

the following case: 
 When you set I/O parameter No.44 to 1, drive power cut-off occurs. -→ Recovery after the main 

cause of cut-off is solved. 

[2] How to issue a drive-source recovery request A drive-source recovery request can be issued using 
one of the following methods: 
 Set I/O parameter No.44 to 1 (input selection function 014 = Drive-source cut-off reset input), and 

then input the ON edge on input port No. 14 
 From the software menu, execute Controller (C) → Request Drive Power Recovery (P). 

(2) Operation pause release request 
[1] Case where an operation pause release request is required

An operation pause release request is required in any of the following cases: 
 When you set other parameter No.10 to 2, (emergency stop recovery according to type = 

continuous operation recovery during automatic operation only), emergency stop during 
automatic operation → recovery after emergency stop release (operation pause release). 

 When you set other parameter No.11 to 2, (according to recovery type during safety gate open 
recovery = continuous operation recovery (during automatic operation only), safety gate OPEN 
during automatic operation → recovery after safety gate CLOSE (operation pause release). 

 When you set I/O parameter No.36 to 1, (input selection function 006 = pausing operation signal), 
OFF level input on input port No.6 at automatic operation (pausing operation) → recovery after 
ON level input on input port No.6 (operation pause release). 

[2] How to issue an operation pause release request An operation pause release request can be 
issued using one of the following methods: 
 Set I/O parameter No.35 to 1 (input selection function 005 = operation pause release signal), and 

then input the ON edge on input port No.5. 
 From the software menu, execute Controller (C) → Request Release Pause (L). 

Caution: If the case in [2] of (1) and any of the cases in [2] of (2) are present at the same time, 
a drive-source recovery request must be issued first, followed by an operation-pause 
reset request.
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12.6 Setting Time 

Select “Controller (C)” → “Time Setting (T)” from the PC Software Menu to display the Set Time screen.  

Fig. 12.12 Time Setting Screen

Manual entry: Directly enter the time (date & time) you want to set to the controller.
Show PC time: The time (date & time) set in the PC you are currently using is shown. 
Show controller time: The time (date & time) currently set in the controller is shown. 
“Setting” button: Set the time (date & time) shown on the screen to the controller. 

12.7 SEL Global Data Backup

[1] Saving to a file
Global flags, global integer variables, global real variables and global strings can be saved.
Select SEL global data backup (G) from the Controller pop-up menu and then click Save File AS
(S).
The SEL global data backup screen (Save File AS) will be displayed.
Clicking will save the global data.

Fig. 12.13 SEL Global Data Backup Screen (Save File AS)
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[2] Transmitting to the controller
Global flags, global integer variables, global real variables and global strings can be transmitted to 
the controller.
Select SEL global data backup (G) from the Controller (C) pop-up menu and then click Transmit to 
Controller(L). 
The SEL global data backup screen (Transmit to Controller) will be displayed.
If an error occurs, focus will move to the Detailed Error Information tag to display the error 
description.

Fig. 12.14 SEL Global Data Backup Screen (Transmit to Controller) 

Clicking will display the SEL global data type select screen. 
Select a desired data type and click OK. The data will be transmitted to the controller.

Fig. 12.15 SEL Global Data Type Select Screen
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12.8 Excel File Save and Readout 

The position data can be saved and read out in the Excel file formats.
However, it can only be available on a PC that Microsoft Office Excel has already been installed.

12.8.1 Excel File Save
Click Save to File in the position edit window.
This is the same as clicking File and then selecting Save As. 

Next, the file save dialog will show up.
Select “Excel 97-2003 Workbook (*.xls)”, put a file name and conduct saving.
Excel will open and the file will be saved to the sheet on the leftmost.

Fig. 12.16 File Save Dialog



12
. S

up
pl

em
en

ta
l I

nf
or

m
at

io
n 

on
 C

on
tro

lle
r M

en
u 

Ite
m

s

206 ME0398-6E

[File Format]
The file format available to save file is only “Excel 97-2003 Workbook (*.xls)”.
(Note) Files cannot be saved or read out in other formats such as “Excel Workbook (.xlsx)”.

[Position Data Format]
The first line of the saved Excel data will become the next title and the data in the second line and below are 
to be stored.
When the position data with the 6-axis cartesian robot not in the axis setting is saved in the Excel format, the 
format should be the same as that for XSEL-RA/SA.
The format should be as shown in the table below when the position data with the 6-axis cartesian robot
existed in the axis setting is saved in the Excel format.

Table: 6-axis Cartesian Robot Position Data Title Line (Excel Format)

No. Type Axis
(1 to 8)

Wrist Vel Acc Dcl (OutFn) (OutNo.) (OutPara1) (OutPara2) (Comment)

Position 
No.

Coordinat
e system 
of 
positions 
(Axis 1 to 
Axis 6)

Each axis 
position 
data

Wrist 
ype

Velocity Acceleration Deceleration Output 
function 
code

Output 
ports and 
flags

Function 
Parameter 1

Function 
Parameter 2

Position 
comment

* 1 These should be displayed when the output operation feature is valid in TTA, MSEL, XSEL-
RA/SA/RAX/SAX/RAXD/SAXD and RSEL Controllers.

* 2 It should be displayed only on the models with the position comment feature available.

◎◎Explanation of Each Column Data
No. Column …Position No.. Data with only integer digits
Type Column …Coordinate system of positions (Axis 1 to Axis 6). Data of “Rect” or “Joint”.
Axis Column …Position data. Data with down to three decimal digits.
Wrist Column …Wrist type. Data of “Flip” or “Non Flip”.
Vel Column …Velocity data. Data with only integer digits.
Acc Column …Acceleration data. Data with down to two decimal digits.
Dcl Column …Deceleration data. Data with down to two decimal digits.
OutFn Column …Output Function code. Data of any from “ON”, “OFF”, “OND”, “OFFD”, “ONR” or 

“OFFR”.
OutNo. Column …Output ports and flags. Data with only integer digits
Outpara1 Column …Function Parameter 1. Data with down to three decimal digits.
Outpara2 Column …Function Parameter 2. Data with down to three decimal digits.
Comment Column …Position comment.

[Caution]
When “Rest” is selected in Type Line, the data input in Axis 7 and 8 lines should be ignored in the file
reading.
When “Joint” is selected in Type Line, the data input in Wrist Line should be ignored in the file reading.

* 1 * 2
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* 1 * 2

ME0398-6E 207

12.8.2 Excel File Readout
Click Open File in the toolbar.
It can also be conducted by operating File → Open. 
Open File dialog will appear.
Select either “Excel 97-2003 Workbook (*.xls)” or “All Files (*.*)” and all the “.xls” files should appear.

Fig. 12.17 Open File Dialog

The controller selection window will show up once a “Excel 97-2003 Workbook (.xls)” file with the correct 
position data file format is selected. Select a controller to be used, press OK, and Microsoft Office Excel 
opens and the file will start to be read out. File error will be displayed if the file format is incorrect.

Fig. 12.18 Target Selection

Fig. 12.19 File Error
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12.8.3 Excel File Create and Edit
When creating and editing the position data in Microsoft Office Excel and reading out in the XSEL PC 
software, input the title line in the first line of the first Excel sheet, and input the position data from the second 
line.
Or, by creating a new file and save it with a name in the XSEL PC software, an Excel file with title line and 
number column are already input can be generated. With using this file, create and edit the position data on 
the Excel sheet.
Refer to [12.8.1 Position Data Format] for the title line.

12.8.4 Caution
(1) Do not attempt to input any information except for those described in the position data format to the title 

line and position number column. Doing so will disturbs reading the data correctly.
In the area hatched in the figure below can be used for free input.
(Note) Once the file gets overwritten in the XSEL PC software, the data input in the hatched area will 

all be deleted.

Fig. 12.20 Position Data Input Area

(2) If there is a restriction on the edit or readout of the Excel file, it will cause a file readout error.

(3) If you work on Microsoft Office Excel while the file is being saved or read out, file save or readout could 
fail.
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In the area hatched in the figure below can be used for free input.
(Note) Once the file gets overwritten in the XSEL PC software, the data input in the hatched area will 

all be deleted.

Fig. 12.20 Position Data Input Area

(2) If there is a restriction on the edit or readout of the Excel file, it will cause a file readout error.

(3) If you work on Microsoft Office Excel while the file is being saved or read out, file save or readout could 
fail.
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If this checkbox is not selected, symbol 
errors will not be checked. 

If this checkbox is not selected, the 
communication port which can be used will 
not be checked.
However, selectable communication ports 
are extended to COM1 to COM256 in the 
communication check window. 
If the selected communication port cannot 
be used, the "EC5: communication port open 
error" will occur. 

If this checkbox is not selected, partial 
correction will be possible when the ‘Cmnd’ 
column is double-clicked.

For the next startup of the XSEL PC 
software and later, the controller select 
window should be skipped and the controller 
connected in the last operation should be 
connected with the same communication 
settings (COM port number, baud rate, etc.).
The specifications of the PC software (RSEL 
/ not RSEL) should be automatically 
switched over in response to the connected 
controller type.

Remove the check mark and the error 
countermeasure window (refer to [16. Error 
Countermeasures]) should not be displayed 
and a notification should be received in the 
error dialog (Figure 13.3) showing an error 
has occurred.

13. Tool
(1) Setting

Specify whether or not to check symbols during the program error check.

Fig. 13.1 Setting (Offline)
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If this checkbox is selected, symbols will be 
shown in the variable window, I/O window, flag 
monitor window and position data edit window. 

For the next startup of the XSEL PC software 
and later, the controller select window should be 
skipped and the controller connected in the last 
operation should be connected with the same 
communication settings (COM port number, 
baud rate, etc.).
The specifications of the PC software (RSEL / 
not RSEL) should be automatically switched 
over in response to the connected controller 
type.

Put a check mark, and the home-return 
operation of the axis with the home-return 
operation completed becomes unable in the 
position edit window.

Remove the check mark and the error 
countermeasure window (refer to [16. Error 
Countermeasures]) should not be displayed and 
a notification should be received in the error 
dialog (Figure 13.3) showing an error has 
occurred.

Fig. 13.2 Setting (Online)

Fig. 13.3 Error dialog
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14. CR (6-axis Cartesian Robot) Simulator
14.1 Outline

By editing the SEL program or position data and operating the program execution in the program editing 
window, operation check becomes available on the PC. 

Caution: Even though operation can be performed in simulation, there may be a case that the 
overload error can occur and not able to operate in the actual robot operation.

Caution: If there is an input signal awaiting in a program, it will not go on to the next step until 
this program gets executed. If there is an input signal awaiting, use the debug filtering 
feature in the input port monitor window.

14.2 Preparation

14.2.1 System Requirements

14.2.1.1 Required System / Recommended System Requirements

Item Specifications
OS Windows 10
CPU Intel Core i Series or Intel Core 2 Quad or higher
Memory 2G byte or more
Hard Disk Space Space of 1G byte or more required

(This software is to be installed to the hard disk drive to use)
Graphic 1280 × 1024 dots or more

Operating environment of DirectX 9.0c is required
Graphic memory of 64MB or more required

Others .Net Framework 4.8.1 or more required

Caution: The software cannot be installed to a PC with Virfit provided by Computer 
Engineering & Consulting Ltd. already installed.
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14.2.2 How to Install
It is mandatory that X-SEL PC Software V14.00.01.00 or later is installed in order to operate the CR
simulator.

[1] Insert the DVD-ROM containing this software into your DVD-ROM drive.
[2] The installed data selection screen will be displayed.

Select English and click OK. 

Fig. 14.1 Select language Screen

[3] Select IXA/CR Simulator and click Installation. 

Fig.14.2 Software installation Screen
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14.2.2 How to Install
It is mandatory that X-SEL PC Software V14.00.01.00 or later is installed in order to operate the CR
simulator.

[1] Insert the DVD-ROM containing this software into your DVD-ROM drive.
[2] The installed data selection screen will be displayed.
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[3] Select IXA/CR Simulator and click Installation. 

Fig.14.2 Software installation Screen
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[4] The screen will change to the installation screen. 

Fig. 14.3 Installation Screen

[5] Click Next >. The data necessary for simulation gets installed.
Following window appears when the installation of simulation data is complete.

Fig. 14.4 Installation Screen

[6] Click Finish. 
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[7] Installation of 3D Drawing Software (Virfit) starts.

Caution: If this software is installed to a PC with Virfit provided by Computer Engineering & 
Consulting Ltd. already installed, it will be overwritten by the one dedicated for CR 
simulation. Cancel the process and install the software to another PC.

1. Select English as the language to be 
displayed in Virfit.

Click OK. 

* It is the display only in recovery 
installation.

2. The setup start window for installation 
appears.

Click Next >. 

3. A window to indicate the destination 
location to install the software shows up.

Click Next > with the default setting 
unless necessary to change.
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4. Ready to Install window comes up.

Confirm there is no problem in the 
display and click Install. 

5. Install Visual C++ 2005 Redistributable 
Package.

Click OK. 

* It may take time to start the installation.

6. A message appears when the installation 
of Visual C++ 2005 Redistributable 
Package is complete.

Click OK. 

7. Install Visual C++ 2008 Redistributable 
Package.

Click OK. 
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8. A setup window for Visual C++ 2008 
Redistributable shows up.

Click Next >. 
Move on to Step 9.

8-1. For a PC with Visual C++ 2008 
Redistributable Package already 
installed, a window shown on the right 
appears.

Click Cancel. 

8-2. Setup should be cancelled and a window 
shown on the right appears.

Click Finish. 
Move on to Step 11. 
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8. A setup window for Visual C++ 2008 
Redistributable shows up.

Click Next >. 
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8-1. For a PC with Visual C++ 2008 
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installed, a window shown on the right 
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Click Cancel. 

8-2. Setup should be cancelled and a window 
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Click Finish. 
Move on to Step 11. 

ME0398-6E 217

9. License Terms for Visual C++ 2008 
Redistributable software gets displayed.

Check to the acceptance and click
Install. 

10. A setup complete window for Visual C++ 
2008 Redistributable appears.

Click Finish. 

11. A message appears when the installation 
of Visual C++ 2008 Redistributable 
Package is complete.

Click OK. 

12. Install Visual C++ 2010 Redistributable 
Package.

Click OK. 
* For a PC with Visual C++ 2010 

Redistributable Package already 
installed, this window will not appear and 
the process moves on to Step 16.
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13. License Terms for Visual C++ 2010 
Redistributable software gets displayed.

Check to the acceptance and click
Install. 

* It may not be displayed in some 
environments of use.

14. A setup complete window for Visual C++ 
2010 Redistributable appears.

Click Finish. 

15. A message appears when the installation 
of Visual C++ 2010 Redistributable 
Package is complete.

Click OK. 
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13. License Terms for Visual C++ 2010 
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Package is complete.
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16. Install DirectX Runtime.

Click OK. 
* For a PC with DirectX already installed, 

this window will not appear and the 
process moves on to Step 22.

17. The software license agreement shows 
up.

Click Yes. 

18. A setup window for DirectX shows up.

Check on [accept the agreement] and 
click Next >. 
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19. A installation confirmation window comes 
up.

Click Next >. 

20. A DirectX installation complete window 
appears.

Click Finish. 

21. A message appears when the installation 
of DirectX Runtime is complete.

Click OK. 

22. Install HASP HL Device Driver.

Click OK. 
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19. A installation confirmation window comes 
up.

Click Next >. 

20. A DirectX installation complete window 
appears.

Click Finish. 

21. A message appears when the installation 
of DirectX Runtime is complete.

Click OK. 

22. Install HASP HL Device Driver.

Click OK. 
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23. A setup window for Sentinel Runtime 
shows up.

Click Next >. 

24. A license agreement window shows up.

Check on [I accept the license 
agreement] and click Next >. 

25. Ready to Install window comes up.

Click Next >. 
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26. A Sentinel Runtime installation complete 
window appears.

Click Finish. 

27. A message appears when the installation 
of HASP HL Device Driver is complete.

Click OK. 

28. Installation of Virfit starts.

Wait for a while.
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26. A Sentinel Runtime installation complete 
window appears.

Click Finish. 

27. A message appears when the installation 
of HASP HL Device Driver is complete.

Click OK. 

28. Installation of Virfit starts.

Wait for a while.
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29. A setup complete window for Virfit 
appears.

Click Finish to complete the installation.
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14.3 How to Start up

14.3.1 Startup

Once you start up “XSEL PC Software” from the start menu of Windows, the controller select window (figure 
below) will show up. Click RSEL, XSEL2-T Series.

Fig. 14.4 Controller Select Window

Select “Simulator” (*1) from the list in “Port Name” and click OK.
* 1 PC software can be launched in several windows on one PC, however it should be only one window on 

one PC that can be connected to the simulator.

Fig. 14.5 Connection Confirmation Screen
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After clicking OK, a robot select window comes up.
Select the combined profiles and stroke length for each stroke, and then click OK. 

Fig. 14.6 Robot Select Screen

The parameters should be initialized when a robot model different from the one selected previously is 
selected.
Refer to [14.5.1 Flash ROM Writing Operation] 
In case requires to change the robot model, end the simulation once and reboot.
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14.3.2 Cycle Time Measurement PC Performance Adjustment

Cycle time measurement is available also when connected to the simulator, however, it can vary due to the 
performance and load on the PC to be used, and will not perfectly match with the time measured on the 
actual controller. Utilize this as a reference for cycle time consideration. If the difference between the actual 
controller and the simulator is expectable in advance, the result on the PC (simulator) can be adjusted 
slower or faster on the slider bar. (10% of increase/decrease by one gradation)
Refer to [4.5 Cycle Time Measurement] 

[1] Conditions at Cycle Time Measurement
Note that there are some limitations as follows in the cycle time measurement in the simulator.

Caution: • Do not attempt to use a program with conditional change of input signals.
A program that waits for a signal from outside should be commented out at that 
part or extract only the part to be measured to conduct the cycle time 
measurement. In case of considering the cycle time of such a program, add the 
waiting time into the consideration on top of the measurement result.

• Use a program that does not run in infinite loop.
In case of a program in loop and the time between the end and start in the range 
of measurement is short, the measurement result display time gets short and 
always displays under measurement.

[2] Cause of Cycle Time Measurement Variance in Simulator
(1) Variance due to CPU Process Speed and Memory Access Difference

There is a tendency in general that a PC has a CPU with better performance and the process is faster 
(cycle time measurement result shorter) except for the robot operation system commands (arithmetic 
operation, brunch instruction, etc.). Also in commands to operate the global data, the way of memory 
access is different from the controller making the cycle time measurement result shorter in a PC
(simulator).

(2) Using Commands Dependent to Condition of Robot Main Unit
In the cycle time measurement in a simulator, there is no connection to a robot unit or external device.
This makes the simulator unable to measure the cycle time properly in such commands as those to 
monitor external force against the robot or those to communicate with external devises.
Described below are the applicable commands.

No. Feature Command Explanation

1 Pressing PUSH As there is nothing to push against, always 
finishes with miss-pressing.

2 Communication OPEN/CLOS/READ/
WRIT/TMRW

Moves on to the next step without conducting 
communication process.
It makes the cycle time shorter than the actual 
controller.

3 Vision System I/F SLVS/GTVD Go to the next step without having the vision 
system I/F process conducted.
The cycle time should get shorter than the actual 
controller.
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14.3.3 Warning at First Startup

There may be a case that a warning window as shown below appears at the first startup of the simulator.
When this window appears, confirm that there is a check mark in a check box corresponding to your 
environment of use and click Allow access. It is necessary in order to operate of 3D view.

Fig. 14.7 Example of Warning Window at First Startup of Simulator

14.3.4 Start of Simulation

Either read out a SEL program or position data to be simulated from a file (File - Open in the menu bar) or 
create a new (File - Create New in the menu bar) and transfer to the simulator. Refer to 3.2 Explanation of 
the Commands [1], 4. Program Edit Window and 6. Position Data Edit Window for detail of how to edit and 
transfer a SEL program or position data.
After data transfer, refer to 4.4 Running the Program in order to execute a program.

Caution: As it will be launched with “Safety VEL Specified” at the PC software startup, switch it 
to “Safety VEL Not Specified” if necessary. Refer to [3.3 Explanation of the Toolbar]
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14.3.5 Stop of Simulation
Refer to 4.4 Running the Program in order to stop the program.

14.3.6 Termination of Simulation
Either finish the PC software or execute Off-line work (Exit Simulator) in the controller menu. If it is required 
to perform simulation again from offline condition, reconnect and execute it in the process of startup in 3.1.
(Reconnection menu gets active offline.)

Fig 14.8 Controller Menu
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14.4 Basic operation in 3D View Window

Fig. 14.9 3D View Window

14.4.1 View Operation (Normal Mode)
(1) View Operation Using a Wheel Mouse (3-button Mouse)

Action How to Operate
Rotation Press and hold the wheel button (middle button) and press the left 

button to drag.
Panning Press and hold the wheel button (middle button) and drag it.
Zooming When using a wheel mouse, turn the wheel to zoom in and out.

When using a 3-button mouse, press and hold the middle button, click 
the left button once and then drag.

Changing Rotation Center Click the wheel button (middle button) at a point to make the center.

(2) View Operation Using Keys and Mouse
Action How to Operate
Rotation Press and hold Alt Key and press the left button and drag.
Panning Press and hold Ctrl Key and press the left button and drag.
Zooming Press and hold Ctrl + Alt Keys and press the left button and drag.
Changing Rotation Center Press and hold Ctrl + Alt Keys and click the left button.
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(3) Normal Camera Work from Tool Bar

Click Front View Icon in the tool bar.
The view confronts the ZX plane.

Click Right View Icon in the tool bar.
The view confronts the ZY plane.
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(3) Normal Camera Work from Tool Bar

Click Front View Icon in the tool bar.
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The view confronts the ZY plane.
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Click Left View Icon in the tool bar.
The view confronts the ZY plane (backside).

Click Rear View Icon in the tool bar.
The view confronts the ZX plane (backside).
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Click Top View Icon in the tool bar.
The view confronts the YX plane.

Click Bottom View Icon in the tool bar.
The view confronts the YX plane (backside).
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Click Top View Icon in the tool bar.
The view confronts the YX plane.

Click Bottom View Icon in the tool bar.
The view confronts the YX plane (backside).
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Click Isometric View Icon in the tool bar.
The view comes slanted (isometric view).

Click Zoom to Fit Icon in the tool bar.
The view shows the whole element without changing the view angle.
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14.4.2 View Operation (Walkthrough Mode) 

(1) Switching to Walkthrough Mode

Click [Walkthrough Icon] . 
During Walkthrough Mode, the icon is kept pressed.
Click on the icon while it is pressed, it gets back to the normal mode.

Normal Mode Walkthrough Mode

(2) View Operation Using a Wheel Mouse (3-button Mouse)
Action How to Operate
Panning (XY plane) Press the left button and drag it.

For a wheel mouse, turn the wheel to move back and forth.
Vertical Move (Z direction) Press and hold the wheel button (middle button) and drag it.
Camera Rotation Press the right button and drag it.

(3) View Operation in Camera Coordinate Window
Input numbers in camera coordinate window and click Apply. 

Fig. 14.10 Camera Coordinate Screen

The view moves to the point of coordinates that was input.

Caution: Moving the mouse pointer in the view area during number input should cancel the 
input.

] . 
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14.4.3 Track Plotting

The track of the vertical axis tip can be displayed. If the SCARA tool coordinate system offset in the 
coordinate system definition data is set up, the amount of offset is considered in the display.

(1) Turning on Track Plotting

Click [Track Display Activated Icon] .
The track of the tip of the vertical axis gets plotted in response to the robot animation.
The track display shows a certain amount of movement and disappears from the older.

Fig. 14.11 During Track Plotting

Caution: The pitch of robot track plotting may get longer in such conditions as described 
below:
• Robot movement speed high
• View changed
• PC performance is low
• Another application in operation
etc.

Click [Track Display Inactivated Icon] .
Track plotting stops.

Click [Track Display Clear Icon] .
The displayed track are cleared up.
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Click [Track Display Setup Icon] . 
Color and line width of track and show/hide of robot is to be set up.

Fig. 14.12 Locus Display Settings

* Robot Number Display Color: Color of “Robot 1” displayed on the 3D view robot in the track display 
setup window

To change color, click on the colored portion and a color setting window pops up. Select a desired 
color and click OK. 

Fig. 14.13 Color

Line width can be changed in the range from 0.1 to 10.0.
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Click [Track Display Setup Icon] . 
Color and line width of track and show/hide of robot is to be set up.

Fig. 14.12 Locus Display Settings

* Robot Number Display Color: Color of “Robot 1” displayed on the 3D view robot in the track display 
setup window

To change color, click on the colored portion and a color setting window pops up. Select a desired 
color and click OK. 

Fig. 14.13 Color

Line width can be changed in the range from 0.1 to 10.0.
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14.4.4 Other Displays

(1) Lettering Mode
Display format of an object can be changed.
◆ Solid

Click [Solid Display Icon] .
During the solid display, the icon is kept pressed.

Fig. 14.14 Solid Display

◆ Wireframe
Click [Wireframe Display Icon] .
During the wireframe display, the icon is kept pressed.

Fig. 14.15 Wireframe Display
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14.5 Operation on PC Software

The features described in Chapters from 4 to 13 are available to use while the simulator is connected.
However, in Chapter 12, 12.3 Axis Setting, 12.5 Drive-source Recovery Request and 12.6 Setting Time 
cannot be used.

14.5.1 Flash ROM Writing Operation
Conducting flash ROM writing operation in the PC software should make each type of data (program data, 
position data, symbols, coordinate system definition data and parameters) recorded in the hard disk in the 
PC. The recorded data is available for simulation in the next startup.
However, when the robot model is changed in the robot select window at the startup, each type of data 
(program data, position data, symbols, coordinate system definition data and parameters) will get initialized.

14.5.2 Operation of Software Reset
Conducting an operation of software reset in the PC software should bring the robot current position data 
back to the initial position.

14.6 SEL Commands not Applicable for Simulation

Shown below are those with different behaviors between controller and simulator in SEL Commands.

No. Feature Command Explanation

1 Pressing PUSH As there is nothing to push against, always 
finishes with miss-pressing.

2 Communication OPEN/CLOS/READ/
WRIT/TMRW

Moves on to the next step without conducting 
communication process.
The output part should be set, but return codes or 
received messages should not be set.
In case of debugging READ Command, set the 
received message in advance to executing READ 
Command.

3 Expansion 
Command

ECMD 1 /ECMD 10 The value read out always comes 0.

4 Task Level Change CHPR This software runs on Windows and strict level 
change operation cannot be performed.

5 Vision System I/F SLVS/GTVD Go to the next step without having the vision 
system I/F process conducted.
Even though the output part should get set, other 
data should not be set.
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15. EC teaching tool
15.1 Overview
The EC teaching tool is used to perform teaching for an ELECYLINDER axis connected to an RSEL unit.

15.2 Startup

Select [EC (E)] then [Teaching tool (T)] from the main menu of the XSEL PC software.
The following connected axis check screen is displayed during startup. "Connected" will be displayed for any 
axes confirmed to be connected, while others will be blank.
(Only axes recognized by the RSEL unit will be checked.)

Once the connected axes have been confirmed, the main screen will be displayed.

Tree view

Tool buttons

Main menu
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15.3 Main menu

15.3.1 Operation using the main menu

(1) File
(1) [Open] 

Reads position data or parameters from a file.

(2) [Close]
Closes the file.

(3) [Load to CTL] > [Position]
Writes position data from the file to the controller.

(4) [Load to CTL] > [Parameter]
Writes parameters from the file to the controller.

(5) [Backup] > [Save all data]
Saves all position data and parameters from the controller 
to a file.

(6) [Backup] > [Load all data]
Transfers all position data and parameters from a file to the 
controller.

(7) [Backup] > [Print Backup Data]
Prints backup data.

(8) [Backup] > [Edit parameter]
Allows parameters from a backup file to be edited on the parameter editing screen.

(9) [Backup] > [Edit position data]
Allows position data from a backup file to be edited on the parameter editing screen.

(10) [Backup] > [Back up multi axes]
Saves position data and parameters for axes selected from multiple connected axes to individual 
backup files.

(11) [Backup] > [Restore multi axes]
Transfers position data and parameters from a file to the selected folder.

(12) [Recent Files]
Displays a list of recently loaded files. A file can be selected and read from this list.

(13) [Exit]
Exits the application.
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15.3.1 Operation using the main menu

(1) File
(1) [Open] 
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(2) [Close]
Closes the file.
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to a file.
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(8) [Backup] > [Edit parameter]
Allows parameters from a backup file to be edited on the parameter editing screen.

(9) [Backup] > [Edit position data]
Allows position data from a backup file to be edited on the parameter editing screen.

(10) [Backup] > [Back up multi axes]
Saves position data and parameters for axes selected from multiple connected axes to individual 
backup files.

(11) [Backup] > [Restore multi axes]
Transfers position data and parameters from a file to the selected folder.

(12) [Recent Files]
Displays a list of recently loaded files. A file can be selected and read from this list.

(13) [Exit]
Exits the application.
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(2) Position
(1) [Edit/Teaching]

Reads position data from the controller in order to edit data or perform 
teaching.

(2) [Test run]
Displayed only in CCM connection
It should operate CCM in the indicated operational condition to perform a 
trial run.

(3) [Load to CTL]
Transfers (writes) edited position data to the controller.

(4) [Print]
Prints position data being edited.

(3) Parameter
(1) [Edit]

Reads parameters from the controller for editing.

(2) [Load to CTL]
Transfers (writes) edited parameters to the controller.

(3) [Print]
Prints parameters being edited.

(4) Monitor
(1) [Status]

Allows the status of each axis (axis status, internal flags, input/output 
ports) to be viewed.
Refer to [Status monitor screen].

(2) [CTL alarm list]
Displays the controller alarm list screen.
Refer to [Controller alarm list screen].

(3) [Velocity/Current]
Displays the velocity/current monitor screen.
Refer to [Velocity/current monitor screen].

(4) [Maintenance info]
Displays the maintenance information screen.
Refer to [Maintenance information screen].



15
. E

C
 te

ac
hi

ng
 to

ol

242 ME0398-6E 

(5) Setting
(1) [Application]

Allows application settings to be configured.
Refer to [Application setting screen].

(2) [Controller] > [Disconnect]
Disconnects connected axes and closes the 
application.
[Controller] > [Software reset]

Resets (restarts) the software.
[Controller] > [Actuator replacement]
Resets maintenance information (total moving count, total moving distance) to 0.
[Controller] > [Clear Pairing ID]

Clears the pairing ID of a controller compatible with a battery-less absolute controller.
Enter 5119 as the password and then click OK. 
(Note) If an actuator motor is replaced, be sure to perform home return without clearing the 

pairing ID.
The home position will not be set if home return is not performed.

[Controller] > [Lubrication date and time renewal]
Sets the current time as the "lubrication time" displayed on the maintenance information screen, 
and resets the total moving distance after lubrication to 0.
(Note) This is available only if the actuator recognition function is supported.

(6) Window
(1) [Cascade]

Displays windows cascaded.

(2) [Horizontal]
Displays windows arranged horizontally.

(3) [Vertical]
Displays windows arranged vertically.

(4) [Arrange icons]
Arranges windows displayed as icons (minimized).

(5) [Minimizing]
Switches all windows to icons (minimized).

(6) [Normalizing]
Reverts all windows switched to icons (minimized) as windows.

(7) [Close all]
Closes all open windows.

(8) [Font size] > [Largest]/[Larger]/[Medium]/[Smaller]/[Smallest]
Allows the font size on each screen to be changed.

(9) [Tree View]
Shows/hides the tree view.  
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(5) Setting
(1) [Application]

Allows application settings to be configured.
Refer to [Application setting screen].

(2) [Controller] > [Disconnect]
Disconnects connected axes and closes the 
application.
[Controller] > [Software reset]

Resets (restarts) the software.
[Controller] > [Actuator replacement]
Resets maintenance information (total moving count, total moving distance) to 0.
[Controller] > [Clear Pairing ID]

Clears the pairing ID of a controller compatible with a battery-less absolute controller.
Enter 5119 as the password and then click OK. 
(Note) If an actuator motor is replaced, be sure to perform home return without clearing the 

pairing ID.
The home position will not be set if home return is not performed.

[Controller] > [Lubrication date and time renewal]
Sets the current time as the "lubrication time" displayed on the maintenance information screen, 
and resets the total moving distance after lubrication to 0.
(Note) This is available only if the actuator recognition function is supported.

(6) Window
(1) [Cascade]

Displays windows cascaded.

(2) [Horizontal]
Displays windows arranged horizontally.

(3) [Vertical]
Displays windows arranged vertically.

(4) [Arrange icons]
Arranges windows displayed as icons (minimized).

(5) [Minimizing]
Switches all windows to icons (minimized).

(6) [Normalizing]
Reverts all windows switched to icons (minimized) as windows.

(7) [Close all]
Closes all open windows.

(8) [Font size] > [Largest]/[Larger]/[Medium]/[Smaller]/[Smallest]
Allows the font size on each screen to be changed.

(9) [Tree View]
Shows/hides the tree view.  
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15.3.2 Operation using the tool buttons

(1) Open file
This is the same as selecting [File] > [Open].

(2) Edit/teach position data
This is the same as selecting [Position] > [Edit/Teaching].

(3) Edit parameters
This is the same as selecting [Parameter] > [Edit].

(4) Status monitor
This is the same as selecting [Monitor] > [Status].

(5) Controller alarm list
This is the same as selecting [Monitor] > [CTL alarm list].

(6) Speed/current
This is the same as selecting [Monitor] > [Speed/Current].

(7) Disconnect
This is the same as selecting [Setting] > [Controller] > [Disconnect].

(8) Save all data
This is the same as selecting [File] > [Backup] > [Save all data].

(9) Transfer all data
This is the same as selecting [File] > [Backup] > [Load all data].

* Items that are dimmed cannot be selected.

(10) Display windows cascaded
This is the same as selecting [Window] > [Cascade].

(11) Display windows arranged vertically
This is the same as selecting [Window] > [Horizontal].

(12) Display windows arranged horizontally
This is the same as selecting [Window] > [Vertical].

(13) Enables or disables the safety speed.
* This is enabled when the controller switch is set to manual (MANU).
* This selection will be enabled if "EC I/O directive prohibition" is specified in the XSEL PC software.
 Safety speed effective (I/O directive prohibition)

The maximum speed will be the speed set in the parameters, regardless of the position data speed
specification.

 Safety speed ineffective (I/O directive prohibition)
It will be possible to operate at the speed (above the safety speed) given by the position data speed
specification.

(1)(1)(1) (2)(2)(2)(3)(3)(3)(3)(3)(4)(4)(4)(4)(4) (5)(5)(5)(5)(5)(6)(6)(6) (7) (9)(9)(9)(9)(9)(10)(10)(10)(10)(10)(10)(10)(11)(7)(7) (9)(9)(9)(9)(8) (11)(11)(11)(11)(12) (13)
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15.3.3 Tree view
Select [Window] then [Tree View] from the main menu.

(1)
The axis numbers and axis names are displayed.
A blue icon will be displayed if the connection is normal, while a red icon will be displayed if there is an 
error.
* Items displayed on the application setting screen can be modified.

(2)
Double-click this to open the simple data setting screen.
(Note) The simple data setting screen and parameter editing screen cannot be opened at the same 

time.

Displayed only in CCM connection
Double-click it and Trial Run window can open.
(Note) Trial Run window and Edit Parameter window cannot be opened at the same time

(3)
Double-click this to open the parameter editing screen.

(4)
Double-click this to open the status monitor screen.

(5)
Double-click this to open the controller alarm list screen.

(6)
Double-click this to open the velocity/current monitor screen.

(7)
Double-click this to open the maintenance information screen.

15.3.4 Axis selection
To perform an operation such as position editing, select the corresponding axis number on the select axis 
screen.
Axis numbers that can be selected are displayed in the "Connected axes" box.

Items displayed on the application setting screen can be modified.

pen the parameter editing screen.

click this to open the velocity/current mo
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15.3.3 Tree view
Select [Window] then [Tree View] from the main menu.
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15.3.4 Axis selection
To perform an operation such as position editing, select the corresponding axis number on the select axis 
screen.
Axis numbers that can be selected are displayed in the "Connected axes" box.
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Move the cursor and click > to select an axis, and then click OK. 
To select all axes, click >> and then click OK. 

Caution: Numbers for axes that are already open on the 
"Parameter editing screen" or "Simple data setting 
screen" will not be displayed. To select such an 
axis, first close the applicable screen.
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15.4  Simple data setting screen

Either select [Position] > [Edit/Teaching] from the main menu, or double-click [Position data] in the tree view 
to display the simple data setting screen.

Caution: If the simple data setting screen is open for an axis, the parameter editing screen for 
the same axis cannot be opened.

The simple data setting screen is used to configure operating conditions (velocity, acceleration, deceleration, 
push force) and position settings (forward end, backward end, pushing start point); display the current 
position, cycle time, and settings log; and perform manual operation.

Operating condition data and position setting data configured here will be valid after being transferred to the 
controller.
This can be transferred using either of the following operations.
 Click Transfer on the bottom right corner of the screen.
 Click the icon (transfer to controller button) in the tool buttons area.

Manual operation will be performed after transferring data to the controller.

Tool buttons Operating condition settings

Position settings

Transfer log

Manual operation Transfer button
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15.4.1 Tool buttons

(1) Save as
Saves the displayed data to a file.

(2) Transfer to controller
Transfers (writes) data to the controller.

(3) Refres
Refreshes the data display after rereading all data on the screen from the controller.

(4) Print
Prints data.
Clicking this opens the print setting screen, which allows the top/left 
margins and row spacing (mm) to be set, along with the print 
orientation.
Click print to print.

(5) Stop moving
Click this to forcibly stop axis movement.

(6) Unit change
Switches the units shown for setting items and display items as follows.

Velocity: % ⇔ mm/s
Acceleration/deceleration: % ⇔ G 
Push: % ⇔ N (reference value)

(7) Load setting
Displays the transported load setting screen.
Enter the installation position and the forward/return transported 
load to calculate the optimal velocity and acceleration/deceleration 
values.

(8) Trial operation window display
Displays the trial operation 
screen.

(2)(2)(2) (3)(3)(3)(3)(3)(4) (5) (6) (7) (8)(2)(2)(2)(2)(1)
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15.4.2 Operating condition settings, position settings

[Positioning operation]

(1) Push checkbox : If the push checkbox is not selected (□), a positioning operation will be performed.

(2) Position setting [mm] : Enter the backward end and forward end values.
Enter the position from home as a positioning coordinate value.
The unit used is mm, and the value can be entered up to two positions after the 
decimal point.
The unit used for EC rotary type actuators degrees/s, and the value can be 
entered up to two positions after the decimal point.

(3) Velocity [% or mm/s] : Set the positioning operation velocity.
This can be set as a number from 1% to 100%.
The unit can be switched to mm/s by pressing Unit Change. 
When set to mm/s, the value can be entered up to two positions after the 
decimal point.
The unit used for EC rotary type actuators degrees/s, and the value can be 
entered up to two positions after the decimal point.
Note) Use the following equation to calculate the minimum velocity.

Minimum velocity [mm/s] = Lead length [mm] ÷ 800 ÷ 0.001 [s]

(4) Acceleration [% or G] : Set the acceleration when movement starts.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
When set to G, the value can be entered up to two positions after the decimal point.

(5) Deceleration [% or G] : Set the deceleration when movement stops.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
When set to G, the value can be entered up to two positions after the decimal point.

(6) Cycle time [s] : The displayed cycle time is calculated from the set velocity, acceleration, and 
deceleration.

(2)

(3)

(4)

(5)

(3)(4)(5)

(6)

(1)
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[Positioning operation]

(1) Push checkbox : If the push checkbox is not selected (□), a positioning operation will be performed.
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Enter the position from home as a positioning coordinate value.
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entered up to two positions after the decimal point.
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This can be set as a number from 1% to 100%.
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When set to mm/s, the value can be entered up to two positions after the 
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Note) Use the following equation to calculate the minimum velocity.

Minimum velocity [mm/s] = Lead length [mm] ÷ 800 ÷ 0.001 [s]

(4) Acceleration [% or G] : Set the acceleration when movement starts.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
When set to G, the value can be entered up to two positions after the decimal point.

(5) Deceleration [% or G] : Set the deceleration when movement stops.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
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(6) Cycle time [s] : The displayed cycle time is calculated from the set velocity, acceleration, and 
deceleration.

(2)

(3)

(4)

(5)

(3)(4)(5)

(6)

(1)

ME0398-6E 249

[Push-motion operation]

(1) Push checkbox : If the push checkbox is selected (☑), a push-motion operation will be 
performed.

(2) Position setting [mm] : Set the movement start position (forward end or backward end) and pushing 
start position.
Enter the position from home as a positioning coordinate value.
The unit used is mm, and the value can be entered up to two positions after the 
decimal point.
The unit used for EC rotary type actuators degrees/s, and the value can be 
entered up to two positions after the decimal point.

(3) Velocity [% or mm/s] : Set the velocity up to the movement start position (forward end or backward 
end) and pushing start position.
This can be set as a number from 1% to 100%.
The unit can be switched to mm/s by pressing the Unit Change. 
When set to mm/s, the value can be entered up to two positions after the 
decimal point.
The unit used for EC rotary type actuators degrees/s, and the value can be 
entered up to two positions after the decimal point.
Note) Use the following equation to calculate the minimum velocity.

Minimum velocity [mm/s] = Lead length [mm] ÷ 800 ÷ 0.001 [s]

(4) Acceleration [% or G] : Set the acceleration when movement starts.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
When set to G, the value can be entered up to two positions after the decimal 
point.

(2)

(3)

(4)

(5)

(6)

(2)

(1)
(3)(4)(5)
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(5) Deceleration [% or G] : Set the deceleration up to the pushing start position.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
When set to G, the value can be entered up to two positions after the decimal 
point.

(6) PushPower [% or N] : Set the push torque (current limit value) as a % or N value.
The push velocity will be 20 mm/s.
This will be 20 degrees/s for EC rotary type actuators.
If the set velocity is 20 mm/s or less (20 degrees/s for EC rotary type actuators), 
pushing will be performed at the set velocity.
The unit can be switched to N (reference value) by pressing the Unit Change. 

15.4.3 Manual operation

(Jog operation)

(1) Current Position [mm] : Displays the current position.

(2) Backward end : Moves toward the backward end as long as the button is pressed.
Movement stops when the button is released or the backward end LS signal 
switches ON.

(3) Forward end : Moves toward the forward end as long as the button is pressed.
Movement stops when the button is released or the forward end LS signal 
switches ON.

(Note) Backward end and Forward end can only be used when they are green. If they are not green, it 
means that the setting values have not yet been transferred. They will need to be transferred to the 
controller first.

(4) Transfer : Transfers data that has been set/changed to the controller.
* This will be dimmed when a jog operation can be performed.

(1)

(2) (3)
(4)
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(5) Deceleration [% or G] : Set the deceleration up to the pushing start position.
This can be set as a number from 1% to 100%.
The unit can be switched to G by pressing the Unit Change. 
When set to G, the value can be entered up to two positions after the decimal 
point.

(6) PushPower [% or N] : Set the push torque (current limit value) as a % or N value.
The push velocity will be 20 mm/s.
This will be 20 degrees/s for EC rotary type actuators.
If the set velocity is 20 mm/s or less (20 degrees/s for EC rotary type actuators), 
pushing will be performed at the set velocity.
The unit can be switched to N (reference value) by pressing the Unit Change. 

15.4.3 Manual operation

(Jog operation)

(1) Current Position [mm] : Displays the current position.

(2) Backward end : Moves toward the backward end as long as the button is pressed.
Movement stops when the button is released or the backward end LS signal 
switches ON.

(3) Forward end : Moves toward the forward end as long as the button is pressed.
Movement stops when the button is released or the forward end LS signal 
switches ON.

(Note) Backward end and Forward end can only be used when they are green. If they are not green, it 
means that the setting values have not yet been transferred. They will need to be transferred to the 
controller first.

(4) Transfer : Transfers data that has been set/changed to the controller.
* This will be dimmed when a jog operation can be performed.

(1)

(2) (3)
(4)
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15.4.4 Transfer log

When data is transferred to a controller and the forward movement or bag operating conditions (velocity, 
acceleration/deceleration, push) have been set/changed, the previous setting values are displayed in the 
Previous Setting area, while the new setting values are shown in the Current Setting area. The cycle time 
calculated from these setting values is also displayed.

If a push-motion operation was selected as an operating condition, the previous setting values and current 
setting values will not be displayed.

Caution: Reduce acceleration/deceleration if any shock or vibration is generated in the 
actuator or workpiece.
Continuing use in such a situation could drastically reduce operation life.

Reference

Speed

Time

9,800mm/s

1s

1G

2,940mm/s

0.3G

The acceleration/deceleration unit of (G) is described below.
1G = 9,800mm/s2: Acceleration possible up to 9,800mm/s per second.
For 0.3G, the acceleration per second is 9,800mm/s2 x 0.3 = 2,940mm/s2.
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15.4.5 Automatic Servo OFF Function

[1] Overview 

Automatic Servo OFF Function of ELECYLINDER can be set up.
With automatic servo OFF function, the servo turns OFF automatically after a certain period of time once 
(delay time) positioning is completed.
Conduct the next movement command input and the servo should turn on automatically and the positioning 
operation should be executed.
Since holding current does not flow during the stop, power consumption can be reduced.

[Pressing operation]
When it is necessary to have the pressing operation performed, do not set up Automatic Servo OFF 
Function.
Once ST Signal turns off after the pressing completed, Automatic Servo OFF Function should be activated 
and the servo gets turned off.

EC auto servo OFF supported version: V14.02.03.00 or later
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[2] Setting
Below explains how to set it up.

1. Click Automatic servo-off Setting on the 
simple data setup window.

・The simple data setup window 
should be displayed.

2. Set the duration from the time after 
positioning complete until Automatic servo OFF,
the Automatic servo-off setting window.

・Input for both the way forth (forward) and the way back (backward).
・The Automatic servo OFF delay time can be set in unit of 0.1 second.

3. Input the Automatic servo OFF delay time, 
and click OK . 

・Set it to "0.0" and this function will inactivated.  
"0.0" (The servo will not turn off.)
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4. After returning to the Easy Data Setup screen, 
click the Transfer button and proceed with
the settings according to each dialog box.

Caution: • Changing parameters only should not enable the changes made.
• Conduct reboot of the power or software reset after a change is made.

After ELECYLINDER is started up, the parameter changes should become enable.
• Do not attempt to turn the power off during the setting transfer.

Doing so may damage the controller.
• Do not use Automatic servo OFF with push-motion operation. When the pressing 

operation is conducted, it should be effective only when the pressing is missed.
(Operation complete without touching subject = same condition as completion 
when positioning)

• There is no holding torque during Automatic servo OFF. The actuator will move if 
external force is applied. Take extra care when setting. Pay attention to 
interference and safety when setting up.

• Automatic servo OFF functions only when the controller is in AUTO mode.
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15.5 Parameter editing screen

This screen is used to edit parameter data read from a controller or file.
* Displayed content will vary depending on the model.

Caution: If the parameter editing screen is open for an axis, the simple data setting screen for 
the same axis cannot be opened.

(1) Tool buttons
Save as
Saves parameter data to a file.

Transfer to controller
Transfers parameter data to the controller.
Once parameters have been transferred, a screen confirming whether to restart the controller 
(software reset) will be displayed.

Print
Prints parameter data.

(2) Editing area
Used to edit parameters.
For items that allow a value to be selected, clicking to the right of the item will display a list of options in 
a pull-down menu. Click the option you wish to set.
After editing, closing without transferring data to the controller will cause any changes to be reverted.

(3) Explanation area
An explanation of the selected item is displayed here.

(1)

(2)

(3)
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15.6 Monitor screens

These screens are used to monitor status, the controller error list, and velocity/current waveforms.

15.6.1 Status monitor screen

Either select [Monitor] > [Status] from the main menu, or double-click [Status monitor] in the tree view to 
display the status screen.

(1) Axis status
Displays the current location [mm], current speed (while moving) [mm/s], alarm code, cycle time [s], and 
overload level [%].
* The current motor revolution speed [rpm] should be shown only when CCM is connected.

(2) Internal flags
Power : ON/OFF status of controller main power supply
Servo : Servo command status
Home cmplt : Home return complete flag (ON/OFF)
RUN : Actual servo status

(3) Current
Displays the current current command value (mA) and rated current ratio (%).
Ripple compensation (☐) : Displays the command value of the motor ripple compensation amount.

This may be a larger value than the execution current in some models.
No ripple compensation (☑) : Displays the command value with the motor ripple compensation 

amount subtracted.
The value will be close to the motor execution current.

(4) Displays the ON/OFF status of the input data PIO input ports.

(1)

(4) (5)

(3)(2)

(3) (6)
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(1)

(4) (5)
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(5) Output data
Displays the ON/OFF status of the PIO output ports.

(6) I/O Test
Click I/O Test to display the D0 output screen.
Click the port to output. Selecting the checkbox (☑) will force the 
signal ON.

15.6.2 Controller alarm list

Either select “Monitor” → “CTL alarm list” from the main menu, or double-click “CTL alarm list” in the tree 
view to display the controller alarm list.

(1) Tool bar
Save as
Saves the alarm list as a file (CSV format).
* Files saved in this manner cannot be read by this application.

Print
Prints the alarm list.

Refresh
Reacquires the alarm list from the controller and refreshes the display.

Clear alarm list.
The alarm list is not cleared even if the power is turned OFF.
The clear alarm list button can be used to clear the alarm list.
Click the clear alarm list button. A warning is displayed.
Click Yes to clear the alarm list.

(2) Alarm list display
Displays the most recently detected warning code, the last 31 alarm codes and addresses with 
execution data errors (for manufacturer use), detail codes, and occurrence times.
(Note) The power ON log (no error) indicates that the controller power was turned ON. 

It is not an error. 
The occurrence time is indicated as the amount of time since the power on log (no error) was 
generated.

(1)

(2)
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15.6.3 Velocity/current monitor screen

Either select [Monitor] > [Velocity/Current] from the main menu, or double-click [Velocity/Current] in the tree 
view to display the velocity/current monitor screen.

(1) Tool  
Save as
Saves the displayed current, velocity, and deviation data as a file (CSV format).
* Only the data displayed in the data display area will be saved.
* Files saved in this manner cannot be read by this application.

Print
Prints the displayed current, velocity, and deviation data.

Start monitoring
Starts monitoring.

Stop monitoring
Stops monitoring.

Cur Mag, Vel Mag, Deviation Mag
Changes the vertical axis magnification in the current, velocity, and deviation data display areas.

Number of records
Changes the number of horizontal axis records in the current, velocity, and deviation data display 
areas.

Rated current ratio checkbox
Changes the type of data displayed in the current data display area.
Unselected (□): Current value (command value) [mA]
Selected (☑): Rated current ratio displayed [%]

(1)

(2)

(3)

(4)
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(1)

(2)

(3)

(4)
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No ripple compensation checkbox
If the current data display graph is set to display the current value (command value), this will switch to 
displaying the current.
Unselected (□): Displayed with ripple compensation

Displays the command value of the motor ripple compensation amount.
This may be a larger value than the execution current in some models.

Selected (☑): Displayed without ripple compensation
Displays the command value with the motor ripple compensation amount

subtracted.
The value will be close to the motor execution current.
* Default values can be set on the application setting screen.

(2) Current data display area
 Current value (command value) displayed (rated current ratio checkbox unselected (□))

The current value (command value) [mA] is shown on the vertical axis, and the time since monitoring 
began [100ms] is shown on the horizontal axis.

 Rated current ratio displayed (rated current ratio checkbox selected (☑))
The rated current ratio [%] is shown on the vertical axis, and the time since monitoring began [100ms] 
is shown on the horizontal axis.

(3) Velocity data display area
The velocity [mm/s] is shown on the vertical axis, and the time since monitoring began [100ms] is shown 
on the horizontal axis.

(4) Deviation data display area
Deviation is the difference between the actual command pulse and the feedback pulse (actual position).
The deviation [pulse] is shown on the vertical axis, and the time since monitoring began [100ms] is 
shown on the horizontal axis.

* Current data and velocity data are obtained from the controller on an approximately 100 [ms] cycle.
(The cycle at which data is obtained will vary depending on the number of connected axes.)
Any fluctuations in current and velocity that occur during this cycle cannot be monitored accurately.

* Monitoring will automatically stop if the horizontal axis reaches 65535.
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15.6.4 Maintenance information screen

Either select [Monitor] > [Maintenance info] from the main menu, or double-click [Maintenance Information] in 
the tree view to display the maintenance information screen.

(1) Current state
Displays the total moving count and total moving distance of the actuator.
 Total moving count: Displays the total moving count of the actuator.
 Total moving distance: Displays the total moving distance of the actuator.

The unit displayed for total moving distance can be switched between [km] and [m]. 
* This will be the back and forth count (back and forth operation between 0 degrees and 180 degrees) 
for EC rotary actuators

[Changing the total moving count and total moving distance]
The total moving count and total moving distance can be changed by entering a value for the 
maintenance information update data to the right and clicking Send. (You will need to enter the 
password.)

(2) Signal output timing setting
Displays the thresholds (target values) for total moving count and total moving distance.
If the total moving count or total moving distance is set to a value other than 0, a message level alarm 
(maintenance warning 1, maintenance warning 2) will be displayed when that value is exceeded.

[Changing the total moving count threshold and total moving distance threshold]
The total moving count threshold and total moving distance threshold can be changed by entering a 
value for the maintenance information update data to the right and clicking Send. 

Overload warning level
When the motor estimated rise temperature at which an overload alarm occurs is 100% and the ratio set 
on this screen exceeds the motor temperature, the green LED blinks to indicate an overload warning 
and the maintenance warning 3 screen is displayed.
[Changing the overload warning level]
The overload warning level can be changed by entering a value for the maintenance information update 
data to the right and clicking Send. 
No judgment will be made if this set to "100."

Maintenance information 
update
data

Switch between 
displaying km or m
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(3) Operating noise adjustment
Click Operating noise adjustment to display the operating noise adjustment screen.
The operating noise adjustment screen allows the level to be set from 0 to 14 (1 to 9 for Ultra Mini 
ELECYLINDER).
If an abnormal sound is generated (especially if a high tone abnormal sound is generated when stopped 
or operating at low velocity [50mm/s or less]), increase the level and click Setting. Doing so may prevent 
the abnormal sound from occurring.
However, setting the level too high could cause vibration.
(This should be adjusted by changing it one level at a time.)

Operating noise adjustment Screen
(Excluding Ultra Mini ELECYLINDER)

Operating noise adjustment Screen
(Ultra Mini ELECYLINDER)
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15.7 Setting of application screen

Select [Setting] > [Application] from the main menu.

(1) Start position of program
Click to select whether to start the simple program from the cursor position or from the top of the 
program.

(2) Input warning outside the recommended range
Click  to switch between showing and hiding the warning output when the input value being outside 
the recommended range could cause abnormal noise or vibration, when entering parameters or position 
data.

(3) Ripple compensation (current monitor)
This allows the default ripple compensation status to be set for the status screen and velocity/current 
monitor. 

Setting Default ripple compensation on the status screen and velocity/
current monitor screen

Enabled Ripple compensation Unselected (□)
Disabled No ripple compensation Selected (☑)

(4) OK and cancel buttons
If any of the settings from (1) to (3) were changed, clicking ✔ OK will save the changes as the default 
values for these items when the system is next started.
To cancel making changes, click ✘ Cancel. 
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(5) Axis name display setting
Click Setting to display the axis display screen.
The names of axes displayed in the tree view, etc. can be set here.

(1) Tree View with axis numbers: Select how each axis on the tree view in 
the main menu is displayed. Select from axis number, axis name, or 
axis number with axis name.

(2) Tree view with model names: Select whether to show or hide the 
controller name.

(3) Tree view with elapsed time: Select whether to show or hide the elapsed 
time from when the controller started.

(4) Show Screen title axis: Select what to display in addition to the screen 
title when screens such as the parameter editing screen and simple 
data setting screen are displayed. Select from axis number, axis name, 
or axis number with axis name.

(5) Save file name initial display: Select the filename that is displayed 
initially when saving parameters or position data as a file. Select from 
axis number, axis name, or axis number with axis name.

[Setting/editing axis names]
To set or edit an axis name, right-click the applicable axis name in the tree view on the main screen to 
display a pop-up menu, and then open the axis name setting screen from the menu.

An axis name may consist of up to 12 1-byte characters (6 2-byte characters).

(6) Change password
A password can be set for opening the parameter editing screen and 
simple data setting screen.
Follow the instructions below to change the password.

(1) Click Change Password to open the Select Password screen.

(2) To set a password for the parameter editing screen, select System 
Password.
To set a password for the simple data setting screen, select Position 
edit Password.

(3) The password editing screen will be displayed.
Enter the current password ('0000' by default)
and new password, and then click OK. 
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15.8 Trial Run Window Dedicated for CCM

The trial run window dedicated for CCM can be open whether if “Position” → “Trial Run” → “CCM” is 
selected in the main menu or double-clicking Trial Run at the CCM axis in the tree view.

Caution: An axis with the Trial Run window open should not be available for opening the Edit 
Parameter window.

In Trial Run Window Dedicated for CCM, setting of the trial run conditions (motor revolution velocity, 
acceleration time and deceleration time), monitor display and trial run are available.

(1) Trial run conditions
The trial run conditions can be operated by editing the values in each slider bar, up-down buttons and 
text boxes. These setting can be edited even during a trial run.

Acceleration time ：The acceleration time get the motor revolution velocity should be set.
Motor rotation speed ：The revolution velocity of a motor should be set. The setting can be performed 

in every 75rpm.
Deceleration time ：The deceleration time to reach stop state should be set.

(2) Monitor
The current motor revolution velocity, rotary direction, servo status and alarm status should be 
displayed.

(3) Trial run
When it is in the trial run operation window and the servo is on, click the CW or CCW button, and the trial run 
operation should start. In order to stop the trial run operation, click the stop button.
In order to switch the servo status, click the Switch Servo button.

(4) Reflect to Parameters
In order to reflect the parameters to the controller, click the  icon (transfer to controller button) in the tool 
buttons.

In order to reflect the same settings to several CCM, click the Reflect to Parameters button.
(Note) Perform the operation with the Trial Run window for CCM to reflect the settings closed in advance.
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16. Error Countermeasures

16.1 Display when Error Occurred

When an error has occurred, an error countermeasure window should open in the default setting.
* If it is required not to display an error countermeasure when an error has occurred, this feature can be 

deactivated in the menu "Tool" → "Environment Setting".

Click Troubleshoot in the error countermeasure window, and the error countermeasure window should be 
displayed. Follow the instruction in the window to remove the cause of the error.

Click Troubleshoot. 

When there are several causes, the window as shown in 
the figure on the left should be shown.
Select the applicable cause from these causes and click 
Count.m. 

* This window should not appear when there is no 
several causes.

As a countermeasure should be shown, follow the 
instruction in the window to remove the cause of the 
error.
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17. Appendix

17.1 Error Level Control
The PC alarm levels are as shown below depending on the content of the error.
• Message Level: Error No. 300 to 3FF
• Cold Start Level: Error No. 700 to 7FF

17.2 X-SEL PC Software Error Table
(Errors specific to the PC Software are listed below. See the [RSEL Controller Operation Manual] for controller errors.)

Error No. Error name Special note

304 Undefined symbol usage for operand 
error

An undefined symbol is used in Operand 1, 2 and output 
part (Operand 3) in a SEL command.

306 Running program editing error
An edit operation such as write, copy, move or clear was 
conducted to a program in process. Finish the process of 
the program applicable for edit and try again.

307 Symbol error

1) A character not permitted is used at the top of a symbol.
2) An inappropriate character is included in a character 

string for a symbol.
3)The same symbol is defined duplicated.
4) The input exceeds the available number for symbol 

definition. Delete other symbols in advance to secure 
open area and try again.

5) Edit of a symbol in a data number that a controller does 
not support or transferring to a controller is not available.

308 Input condition undefined symbol 
usage error

An undefined symbol is used in the input condition of a SEL 
command.

30D Data edit error during non-manual 
mode

Data edit operation (write, copy, move, clear, etc.) was 
attempted in a non-manual mode.

30E Input data error There is an error in the input data. Check the input data.

30F Input value too small A value that is below the range available for input was 
input.

310 Input value too large A value that is above the range available for input was 
input.

311 Protected data error

1) An operation should not be attempted to read out, copy 
or move to data prohibited to read out.

2) An operation should not be attempted to write in, copy, 
move or clear to data prohibited to write in.

3) An inappropriate value is set in a protection setting 
parameter (Other Parameter No. 55, 56 or Axes Group 
Parameters from No. 11 to 15).

313 Password error There is an error in the input password. Input the correct 
password.

314 Homing incomplete error (TP/PC)

1) Movement or continuous movement operation was 
attempted to an axis with the home-return operation 
incomplete. Finish the home-return operation in advance.

2) Teaching (reading in current position) operation was 
attempted to an axis with the home-return operation 
incomplete. Finish the home-return operation in advance.
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Error No. Error name Special note

315 Motion command during servo OFF A movement command was executed to an axis with the 
servo off. Have the servo turned on in advance.

31A Execution condition unsatisfied error

The conditions to execute a feature is not yet established. 
(When an actuator operation or a SEL program was 
attempted to be executed under condition that the 
operation system commands are prohibited)

31B # of break point setting excess error
The number of breakpoint setting has exceeded the 
available number for setting. Cancel other breakpoints in 
advance and try again.

326 Unsupported function error It is an unsupported feature.

329 Insufficient blank steps error There is no enough number of open steps in a controller.

32F Execution prohibited error without 
safety circuit

The conditions to execute a feature is not yet established. 
(When an actuator operation or a SEL program was 
attempted to be executed under condition that the 
operation system commands are prohibited)

380 Can not change data being edited 
on-line

Data change operation was conducted while the online edit 
window is open. Close the edit window in advance.

381 Can not initialize memory being 
edited on-line

Memory initialization was conducted while the online edit 
windows for the program, symbol and position data are 
open. Close the edit windows in advance.

382 Acceleration/deceleration 
specification error

A number indicated in the acceleration or deceleration for 
jog, movement or continuous movement is out of the range, 
or an inappropriate value is input. Check the values 
indicated in the acceleration and deceleration.

383 The number of file read/write data 
over

1) The number of data saved in a file (number of steps, 
number of positions, etc.) exceeds the allowable.

2) The number of data to be written in a file (number of 
steps, number of positions, etc.) exceeds the allowable.

384 Invalid baudrate specified An inappropriate baud rate was indicated. 
(At connection check, baud rate change, etc.)

385 Can not transmit the data file while 
sending data

It is not available to transfer data read in from a file to a 
controller during the sending and receiving (read-out and 
write-in) of the data.

386 Invalid Ethernet port number There is an error in the Ethernet port number indication.

388 Decimal point/digit separator string 
error (PC)

The character string of the decimal point is set to 
something other than [ . ] or the character string to divide 
numbers is set to something other than [ . ].

389 File error

1) The format of a file could differ or abnormal data could 
be included.

2) The file cannot be open. Check if the file is used in 
another application.

3) The indicted file cannot be found. Check the file name.

38A Data editing prohibition error 
(manual operation type)

Data edit operation, memory initializing operation, flash 
ROM writing operation or error list clear operation was 
conducted during an operation mode. Check the manual 
operation type (in Other Parameter No. 21 and manual 
operation type in PC software that is currently selected).
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Error No. Error name Special note

315 Motion command during servo OFF A movement command was executed to an axis with the 
servo off. Have the servo turned on in advance.

31A Execution condition unsatisfied error

The conditions to execute a feature is not yet established. 
(When an actuator operation or a SEL program was 
attempted to be executed under condition that the 
operation system commands are prohibited)

31B # of break point setting excess error
The number of breakpoint setting has exceeded the 
available number for setting. Cancel other breakpoints in 
advance and try again.

326 Unsupported function error It is an unsupported feature.

329 Insufficient blank steps error There is no enough number of open steps in a controller.

32F Execution prohibited error without 
safety circuit

The conditions to execute a feature is not yet established. 
(When an actuator operation or a SEL program was 
attempted to be executed under condition that the 
operation system commands are prohibited)

380 Can not change data being edited 
on-line

Data change operation was conducted while the online edit 
window is open. Close the edit window in advance.

381 Can not initialize memory being 
edited on-line

Memory initialization was conducted while the online edit 
windows for the program, symbol and position data are 
open. Close the edit windows in advance.

382 Acceleration/deceleration 
specification error

A number indicated in the acceleration or deceleration for 
jog, movement or continuous movement is out of the range, 
or an inappropriate value is input. Check the values 
indicated in the acceleration and deceleration.

383 The number of file read/write data 
over

1) The number of data saved in a file (number of steps, 
number of positions, etc.) exceeds the allowable.

2) The number of data to be written in a file (number of 
steps, number of positions, etc.) exceeds the allowable.

384 Invalid baudrate specified An inappropriate baud rate was indicated. 
(At connection check, baud rate change, etc.)

385 Can not transmit the data file while 
sending data

It is not available to transfer data read in from a file to a 
controller during the sending and receiving (read-out and 
write-in) of the data.

386 Invalid Ethernet port number There is an error in the Ethernet port number indication.

388 Decimal point/digit separator string 
error (PC)

The character string of the decimal point is set to 
something other than [ . ] or the character string to divide 
numbers is set to something other than [ . ].

389 File error

1) The format of a file could differ or abnormal data could 
be included.

2) The file cannot be open. Check if the file is used in 
another application.

3) The indicted file cannot be found. Check the file name.

38A Data editing prohibition error 
(manual operation type)

Data edit operation, memory initializing operation, flash 
ROM writing operation or error list clear operation was 
conducted during an operation mode. Check the manual 
operation type (in Other Parameter No. 21 and manual 
operation type in PC software that is currently selected).
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Error No. Error name Special note

38B Can not write data while Flash ROM 
being written

Data writing operation was conducted during the flash 
ROM writing process. It is not available to have a data edit 
operation during the flash ROM writing.

38C Speed specification error

A number indicated in the velocity for jog, movement or 
continuous movement exceeds the range, or an 
inappropriate value is indicated. Check the values indicated 
in the velocity.

38D Can not transmit data when not 
connected

Data cannot be sent or received as the communication to a 
controller is cut off. Start up the application in the online 
mode and try again.

390 File type error There is an error in the file type. 
Check the file type (extension).

391 No data inputted There is no data input in items with data input mandatory.
Input data.

392 The input date or time is invalied There is an inappropriate data input in the date and time.

393 Too long distance for Inching The inching distance indication exceeds the range. Check 
the inching distance indication.

394 Can not close a window while 
sending data

It is not available to close the edit window during sending or 
receiving data. Finish the data transfer before closing the 
window.

700 Communication error

1) There is an error in the received message. In case that 
the error is not solved even after connecting again, 
contact a manufacturer.

2) It is a communication error. Check on the cable 
connection, short-circuit, noise and so on.

3) There is a concern that the communication is not 
completed to establish. Check the physical connection to 
a controller and try to “reconnect”.

4) A controller not supported is connected.

780 Com port open error The communication port cannot be open. 
Check that the communication port is ready to be used.

781 Sum check error (PC) It is a communication error. Check on the cable connection, 
short-circuit, noise and so on.

782 Communication error (PC) (OS) A communication error has occurred. Try to “reconnect”.

783 Ethernet (receive) time out error 
(PC)

784 Connection disconnection error (PC)

785 Socket error (PC)

786 Service port number in use (PC)

787 Mismatch I/F register address
There is an error in the received message. In case that the 
error is not solved even after connecting again, contact a 
manufacturer.
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17.3 EC teaching tool error list

Error No. Error name Content

103 File writing error Indicates that a data file (position data file, parameter file, 
complete data backup file, etc.) could not be written.

104 Input value too small error
The value that was entered is below the setting range.
Refer to the actuator specifications and parameter list, and 
enter an appropriate value.

105 Input value too large error
The value that was entered is above the setting range.
Refer to the actuator specifications and parameter list, and 
enter an appropriate value.

10B File opening error
(reading)

Indicates that the specified file could not be opened. This 
could be caused by the following.
 The specified file does not exist.
 The file has been opened and is being used by another 

application.

10C File opening error
(writing)

Indicates that an attempt was made to save to a file, but 
that the file could not be opened.
This could be caused by the following.
 The file has been opened and is being used by another 

application.

10D File reading error
Indicates that a file could not be read. This could be caused 
by the following.
 Unable to reserve memory required to read the file.

10E File format error
Indicates that an attempt was made to transfer a parameter 
file or complete data backup file to a model different from 
the file source.

111 File data error
Indicates that a file could not be read. This could be caused 
by the following.
 The specified file contains invalid data.

122 Input data error

Indicates that inappropriate data was entered.
This could be caused by the following.
 A value exceeding the operation range adjustment value 

was set.

123 Data version
mismatch error

Indicates that an attempt was made to transfer saved data 
using an incompatible version of controller.
Check the versions of the source and destination 
controllers.

124 I/O directive permission,
data editing prohibition

Indicates that a position data or parameter write operation 
was performed to the controller when in "AUTO" mode or in 
the "EC I/O directive permission" state.
This could be caused by the following.
 The mode switch on the controller is set to "AUTO."
 The XSEL PC software is set to "EC I/O directive 

permission."

125 I/O directive permission,
axis operation prohibition

Indicates that an axis operation (jog, axis operation, home 
return, continuous movement, etc.) was performed in 
"AUTO" mode or in the "EC I/O directive permission" state.
This could be caused by the following.
 The mode switch on the controller is set to "AUTO."
 The XSEL PC software is set to "EC I/O directive 

permission."
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17.3 EC teaching tool error list

Error No. Error name Content

103 File writing error Indicates that a data file (position data file, parameter file, 
complete data backup file, etc.) could not be written.

104 Input value too small error
The value that was entered is below the setting range.
Refer to the actuator specifications and parameter list, and 
enter an appropriate value.

105 Input value too large error
The value that was entered is above the setting range.
Refer to the actuator specifications and parameter list, and 
enter an appropriate value.

10B File opening error
(reading)

Indicates that the specified file could not be opened. This 
could be caused by the following.
 The specified file does not exist.
 The file has been opened and is being used by another 

application.

10C File opening error
(writing)

Indicates that an attempt was made to save to a file, but 
that the file could not be opened.
This could be caused by the following.
 The file has been opened and is being used by another 

application.

10D File reading error
Indicates that a file could not be read. This could be caused 
by the following.
 Unable to reserve memory required to read the file.

10E File format error
Indicates that an attempt was made to transfer a parameter 
file or complete data backup file to a model different from 
the file source.

111 File data error
Indicates that a file could not be read. This could be caused 
by the following.
 The specified file contains invalid data.

122 Input data error

Indicates that inappropriate data was entered.
This could be caused by the following.
 A value exceeding the operation range adjustment value 

was set.

123 Data version
mismatch error

Indicates that an attempt was made to transfer saved data 
using an incompatible version of controller.
Check the versions of the source and destination 
controllers.

124 I/O directive permission,
data editing prohibition

Indicates that a position data or parameter write operation 
was performed to the controller when in "AUTO" mode or in 
the "EC I/O directive permission" state.
This could be caused by the following.
 The mode switch on the controller is set to "AUTO."
 The XSEL PC software is set to "EC I/O directive 

permission."

125 I/O directive permission,
axis operation prohibition

Indicates that an axis operation (jog, axis operation, home 
return, continuous movement, etc.) was performed in 
"AUTO" mode or in the "EC I/O directive permission" state.
This could be caused by the following.
 The mode switch on the controller is set to "AUTO."
 The XSEL PC software is set to "EC I/O directive 

permission."
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300 Communication port
opening error

Indicates that the communication port could not be opened. 
This could be caused by the following.
 Unable to communicate with the EC axis recognized when 

the XSEL PC software was started.

301 Reception timeout error
Indicates that a reception timeout occurred during 
communication between this application and the connected 
controller. (*)

302 Reception buffer
overflow

Indicates that a reception buffer overflow occurred when 
receiving a response statement from the controller. (*)

305 Communication error
Indicates that some other type of communication error 
occurred when receiving a response statement from the 
controller. (*)

306 Checksum error Indicates that a checksum error occurred when receiving a 
response statement from the controller. (*)

307 CRC error Indicates that a CRC error occurred when receiving a 
response statement from the controller. (*)

308 Response statement error Indicates that error data is included in the response 
statement from the controller. (*)

310 Unsupported model
connection error

Indicates that a connection with an unsupported model was 
detected.
Check the version of this application and its supported 
models.

* The cause of this error and possible solutions are listed below.

Contact IAI if you are unable to resolve an error.
Cause Possible solution

Communication error due to a connection defect 
between the PC and controller

Confirm that the connectors on the cable connecting the PC and 
controller are firmly inserted.

Communication error due to noise (corrupt data, etc.) Review wiring and device placement to ensure that noise has no 
effect.

Controller power cutoff Confirm that the controller power is ON.
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Change History
Revision Date Description of Revision
February 2020 First Edition

March 2020 Edition 1B
Pg. 73, 75 Note deleted in figures
Pg. 82 Parameters for acceleration/deceleration deleted
Pg. 99 Details for advanced setting deleted
Pg. 99, 102, 146

Figure changed
Pg. 109 Encoder parameters → Driver unit parameters

April 2020 Edition 1C
Pg. 3, 13, 14 IA-101-X-USBS deleted

June 2020 Second Edition
Contents related to 6-axis cartesian robot to each chapter added
10.Coordinate System Definition Data Edit Window added
14.CR (6-axis Cartesian Robot) Simulator added

October 2020 Edition 2B
Terms unified, correction made

July 2021 Edition 3A
Pg. 46, 50, 51, 52, 53

Added content on the operation menu
Pg. 107 Added content on parameter easy setup descriptions
Pg. 121, 123, 125, 140, 141

Added content on I/O output settings
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Added content on the monitor

August 2021 Edition 4A
Added "15. EC teaching tool"
Added "16.3 EC teaching tool error list"

April 2022 Edition 5A
Pg. 15, 16, 17, 18, 19

Changed how to install the PC software
Pg.20 Changed the installed data selection screen
Pg.34, 35 Added "1.7 Optional Unit Parameter Initial Setting"
Pg.45 Added "[4] Driver unit parameters" to "Parameter (P)" for 

the explanation of the commands
Pg. 149, 150, 151

Added "8.8 Driver Unit Parameters"
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Revision Date Description of Revision
August 2022 Edition 6A

3.2 (15) Error countermeasure search added
13.Tool Enable display of error countermeasure added
14.2.2 Change made to installation tool window
16.  Error countermeasures added

November 2022 Edition 6B 
12.3 (2) Supplementary comments added in operation explanation 

in logical axes area
General Expressions integrated in process manual explanation

June 2023 Edition 6C
8.8.2 Added SCON2 support version
11.Monitor Added description of "Alarm Information" button in "Error 

Detail Information".
15.4.5 Added Automatic servo OFF function

April 2024 Edition 6D
Pg. 3, 12 Change made to applicable OS
Pg. 12 Correction made to open capacity in hard disk to 200MB or 

more
Pg. 18 Procedures in old OS deleted in “1.3.2 How to Install Driver 

Software for USB Connection to RSEL” 
Pg. 35 Online window swapped
Pg. 53 Description added regarding “3.5 Controller Monitoring” 
Pg. 60 Description added to popup menu in “4.1 Explanation for 

Items in Program Edit Window” 
Popup menu window swapped

Pg. 176 Description added regarding “(5) Global Flag Window 
Global Integer Variable Window Global Real Variable 
Window Global String Window” in “11. Monitoring” 

September 2024 Edition 6E
General Added content for XSEL2-T/TX 
Pg.11, 12 Added and change of supported OS
Pg.13 Added of model of supported OS, 

.NET Framework version change
Pg.48 Details for (15) Help (H) changed  
Pg.211 .NET Framework version change
Pg.240 Added [Test run] to (2) position
Pg.243 Added [Test run] to (2) position data
Pg.255 Added information on CCM connection to (1) axis status
Pg.263 Added content for 15.8 Trial Run Window Dedicated for 

CCM
Pg.268 Error No.: 32F Content added
Correction made
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